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Welcome 
Welcome to Synel Americas TA100 Pro User’s Guide. This manual is shipped with each new 
TA100 Pro software package and is intended solely for use by the licensee. This User 
Guide describes the installation and operation of the TA100 Pro system. 

Accuracy of Information 
The content of this manual is subject to change without notice. Before using this manual, verify that 
the information contained in it is current. Proper installation, configuration, and operation of the 
software are contingent upon reading and following the procedures contained in the latest revision of 
the manual. 

Additional Copies 
Additional copies of this manual may be obtained from our website at www.synel-americas.com or 
from your local Synel Americas dealer. 

User Comments 
Every effort is made to ensure that the information contained in this manual is accurate at the time of 
publication. If you find an error or omission while reading this manual, direct your comments to:  

Synel Americas, Inc. Attn: 
Technical Publications 
8665 E. Hartford Drive Suite #100 
Scottsdale, AZ 85255 

Software Release Version 

Or you can send emails to: 
techsupport@synel-americas.com 

We welcome your comments and suggestions. 

Read This First
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• The version and serial number of your TA100 Pro software.

• The name and version of the Operating System. The type of network being used (if applicable).

• The model number and EPROM revision of the data collection terminal(s) used with the TA100 
Pro software.

• The name of all software options and/or modules installed.

• The make and model of the host computer (PC).

• The operations being performed when the problem occurred.

• A printout of any error message that was displayed.

About This Manual

This section describes how to use this manual. In addition to providing you with step-by- step 
knowledge for performing various procedures, this manual will help you get the most out of 
TA100 Pro.

Disclaimer 
Every attempt is made to keep this manual up-to-date. However, software enhancements do occur, 
and the content of this manual is subject to change without notice. Before using this manual, verify 
that the information contained in it is current. Proper installation, configuration, and operation of the 
software are contingent upon reading and following the procedures contained in the latest version 
of the manual. 

Technical Support 
If you encounter a problem or need technical support after reading this manual, please contact your 
local Sales and Service Representative. Your local representative has received training in the areas 
of software installation, configuration, operation, and advanced troubleshooting. They are qualified 
to provide you with the highest level of technical support. 

When Calling Technical Support for  Assistance 
If possible, contact your authorized local Sales and Service Representative while at the computer 
experiencing the problem so you can quickly answer questions and implement the solutions 
suggested by your representative.  
Before calling, gather the following information. Your local Sales and Service Representative will 
need this information to assist you. 
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• Windows 7/8/8.1/10 and server equivalents.

• CPU Core i3 or better.

• 2GB of total memory.

• A mouse, trackball, or other pointing device.
Additional Requirements
• 500MB of available disk space either on a workstation or accessible on a network drive.

• NOTE: A dedicated database server is not required.

• Additional disk space and an enhanced wide-area network connection may be required based on 
the number of employees, network distance, communication method, and the amount of live data 
contained in the system.

Polling PC 

• Network connection.

• Available USB ports.

Installing the System 
NOTE: Do not launch or run any other applications during the installation process. 

Insert the TA100 Pro Installation CD into the CD ROM drive of the computer on which you wish to 
install the software. The InstallShield Wizard should automatically appear.  

Installation
This section describes how to install the TA100 Pro software, the Sentinel System Driver, and 
attach the hardware key.

System Requirements 
To use the TA100 Pro system, the following are the recommended minimum system requirements must 
be present. 
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Installation

If the InstallShield does not automatically run, you may start the installation by navigating to My 
Computer and double-clicking the icon for TA100 PRO. 

The TA100 Pro Setup window will appear. 
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Click the Next button to advance to the next screen. The License Agreement screen will appear. 

Click Yes to accept the License Agreement. The Choose Destination Location screen will appear. 

Installation
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se the type of installation you wish to perform.

a)

“F will install both the software and the database files on this computer. (Typical)
b) “Workstation” will install only what is needed to run the software.

Click the Next button to continue with the installation. The Select Program Folder screen will appear. 

TA100 Pro will be installed in the C:\TA100PRO directory by default. If you wish to install to a different 
directory, click the Browse and select the directory to which you wish to install. Click the Next button 
when you are ready  to proceed. The Setup Type screen will appear. 

Installation

Choose the type of installation you wish to perform.
a) “Full” will install both the software and the database files on this computer. (Typical)
b) “Workstation” will install only what is needed to run the software.
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Installation

Click the Next button to continue with the installation. The Select Program Folder screen will appear.
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Installation
The TA100 Pro folder will be created automatically. You may type a new folder name if you wish. Click 
Next to continue. The installation will begin. 

When the installation is finished, the InstallShield Wizard Complete screen will appear. 
Click the Finish button to proceed. 
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Installation

If you selected "Full" in the Setup Type screen, the Sentinel System Driver installation will begin 
automatically. 
If you selected "Workstation," the installation will end at this point. 

The Sentinel System Driver—InstallShield Wizard will appear. The Sentinel System Driver is necessary 
for TA100 Pro to be able to access the database files. 
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Installation
Click the Next button to begin the Sentinel System Drive Installation. The Setup Type screen will appear. 
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Verify that Complete is selected and click Next to continue. The Ready to Install screen will appear. 

Installation
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Installation

When the installation is finished, the InstallShield Wizard Complete screen will appear. Click the Finish 
button to proceed. 

Click Install to begin the installation. 
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This concludes the installation. The Installation Complete message will appear. 

The FoxPro LIB—InstallShield Wizard will appear. The FoxPro LIB is for the TA100 Pro database files. 

Installation

21



Installation

Click the Next button to begin the FoxPro LIB installation.  The Ready to Install screen will appear. 

When the installation is finished, the Install Shield Wizard Complete screen will appear.  
Click the Finish button to proceed. 
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Installation

Click OK. TA100 Pro will now appear in your Start Menu and on your desktop. 

Plug the hardware key into an available USB port or bridge.  The computer with the key is required to 
access the program at minimum, every seven day. When the system is first launched, 
TA100 Pro searches for and verifies the presence of a hardware key. If a key is not found, the system 
will not start.  

Main System Key 
The Main System Key is shipped with each new software package. One key per system is required. 
The Main System Key allows you to start and operate the software as well as poll your time clock(s). 
The Main System Key is identified as it is a yellow key.  

Polling Key 
The Polling Key allows TA100 Pro to communicate with time clocks from a workstation other than 
where the Main System Key resides.  

On local or wide-area networks, a remote workstation can launch and operate the software as long as 
the Main System Key is detected somewhere on the network. However, the workstation cannot poll 
time clocks unless it has an Additional Polling Key attached.  

• Main System Key

• Polling Key

You must attach a hardware key to the computer's parallel port prior to being able to start and 
operated TA100 Pro. See Hardware Keys. 

Hardware Keys 
The provided USB key should be plugged into the computer that will be polling the timeclocks.  
There are two types of hardware keys—each designed for a specific purpose. 

23



Getting Started
This section explains how  to launch  the TA100 Pro system, including logging on and off, using 
Help, using  the keyboard instead of  the mouse and customizing the TA100 Pro environment.

Starting TA100 Pro  and  Logging In 
Note  on  User Accounts 
When starting TA100 Pro, you will be prompted for a User ID and password. The User ID and 
password are used to determine who is able to login and what areas of the program are 
accessible. These "User Accounts" are defined in the Security Access portion of TA100 Pro, which 
will be covered later in this manual.

SYSOP 
There is a built-in administrator account that grants full access to all parts of the application. The 
User ID for this account is SYSOP and the initial password is "password." (This password can and 
should be changed.) This account will be referred to as SYSOP throughout this manual. 

The first time you login, you must use the SYSOP account, as no other accounts exist. You will 
also use this account to perform system maintenance, etc. The SYSOP account can perform all 
functions within TA100 Pro, including certain database management functions that no other 
account can access. 

Launching and Logging In to   TA100 Pro 
The instructions in this section assume that you already know the User ID and password to be 
used. Check with your system administrator if you are unsure of which User ID to use. 

Click the Start, Programs, TA100   Pro, or double-click the TA100 Pro Icon on the Desktop.

TA100 Pro will open and display the Login screen.
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Exiting the System 

You can use any of the following methods to close or exit out of TA100 
Pro. Click File, Exit on the menu bar.
Click the Exit button on the toolbar.
Click the Windows Close button (the X at the far right of the menu bar. 
Press  ALT+ F4 on the keyboard.

Maintenance

Poll Terminals 

Status Board 
Reports and Listings 

Automated Processes 
Help 

Approval Editor 

Task Organizer 

Exit 

Getting Started

Type your User ID in the User ID field, then press either ENTER or the TAB key to advance to the 
Password field. 
Type your password in the Password field and press either ENTER or the TAB key to access 
TA100 Pro. The Main Window will open. 

25



Tips and Techniques 
TA100 Pro is designed to be user-friendly, and as such there are common techniques to making 
working in TA100 Pro easier. Some of these tips are listed below. 

Using the Keyboard 
NOTE:  The Employee Maintenance and Status Board sections will resize themselves according 
to the monitor resolution. 
TA100 Pro system is designed so you can perform all operations from your keyboard as well as 
with the mouse.  

 Underlined Letter 

Hot Key 

Getting Started

Setting Definition

Apply You may click the Apply button in any screen to commit the 
changes you have made without exiting the current screen. 
This allows you to 
"save as you go" and is a good practice. 

You will notice that most of the configuration dialog boxes 
provide a list of the existing items at the side of the screen. (For 
example, the Divisions dialog box gives you a list of Divisions.) 
These lists can be sorted according to Name or Number, 
depending upon your preference. 

Name vs 
Number
Listing

Check this button to show inactive items in the list at the side of 
any dialog box. 

Show

You may click the Print button in any dialog to print the report 
associated with the current screen. For example, clicking the 
Print button in the Configure Category dialog box prints the 
Category Listing report. 

Inactive
Print

You may click the Cancel button in any dialog box to close the 
screen without saving changes.

Cancel
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Getting Started

To: Do This:

Select an item from 
the Main Window. 

Press ALT and the underlined letter. For example, 
press ALT+F to open the File menu. 

Select a menu 
command.

Press the underlined letter only. This is true for sub-
menus too. For example, type S to select Security.

Select a button. Press CTRL plus the underlined letter. For example, 
press CTRL+E to choose the Edit button. 

Hot  Keys 
Some menus, such as the Help menu, are accessible using Hot Keys. These keys or key 
combinations correspond to a menu item. Instead of typing the underlined letter in the command, 
you can simply press the Hot Key. For example, to view your system configuration, press F11.  Also, 
all date fields have a calendar dropdown, to access right click on the date. 

Underlined Letters 
All menus, menu items, and buttons have an underlined letter, which allows keyboard access to that 
item.  

To access a menu, press the ALT key in conjunction with the letter that is underlined.
To access an item on the menu, first open the menu and then press the letter that is underlined. To 
select a button, press the CTRL key in conjunction with the letter that is underlined 

Keyboard Usage Examples
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Getting Started

Press:To:

Display the Help topic associated with the current window. 
Exit the current function or window without saving the data.

Display the Calculator.
Display the Calendar/Diary.
Display the Help > About menu window.
Display Conversion Table
Activate the menu bar in the Main Window.
Exit the TA100 Pro system.
Display Rounded Start and Stop times in the Online Timecard. 

ESC

F2
F1

F3
F9

F10 or ALT
F12

ALT+F4
R

Additional        Keyboard         Access 
Other keys and key combinations are available in the system. They are explained below 

Help 
TA100 Pro incorporates an Online Help system to answer questions about functions, procedures, 
and commands. 

You can access context-sensitive Help from anywhere in the application by pressing the F1 function 
key. You will automatically be taken to the Help topic appropriate for the screen that you are in 
currently. 

You may also access the Online Help feature through the Help menu, from which you can perform 
searches and browse the Help topics. There are three ways you can look for information: Browse 
the Contents, Search the Index, or do a text Find. There are three tabs across the top of the Help 
Topics window to access each of these methods.
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Use Help Contents 
In the Help Topics window, click the Contents tab.
Double-click the topic you wish to browse. This will expand the sub-topics below 
it. If necessary, double-click the sub-topic you wish to browse.
When you find the article you are interested in, double-click it to open the article.

Use the Help Index 
In the Help Topics window, click the Index tab.
Type in the topic you are looking for.
When you find the article you are interested in, double-click it to open the article.

Getting Started

Access the Online Help Window 
Click the Help menu, Help. The Help Topics window will open
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Use Help Search 

In the Help Topics window, click the Search tab.
Type in the topic you are looking for.
If necessary, select a word from the list of suggestions.
When you find the article you are interested in, double-click it to open the article.

Return to the Help Topics Window 

After reading an article, you may return to the Help Topics window by clicking the Help Topics 
button on the toolbar. 

Getting Started
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Getting Started
Print a Help Topic 
You can print any help topic by clicking the Print button on the toolbar. 

Click the Print button on the TA100 Pro Help toolbar. The Print window will open.

Select the printer to which you wish to print and click the Print button. The topic will print.
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Configuring the System Environment 
Environmental settings control various display and functional characteristics of your system. The 
default settings can be modified. 

Getting Started

Play Bell Tones 
You can customize TA100 Pro to play a tone at the end of a field when entering data. 

Click the File menu, Environment, Bell. This will cause a bell tone to play whenever you come to the 
end of a field when entering data.
A check mark () in front of the option means that the option is activated. 
NOTE:  Repeat the instructions to disable. 

Change Screen Background 
You have the option of changing the background image, gradient coloring on forms, the display 
language or showing pictures on the buttons.

To access these settings,

Click the File menu, Environment, Background. The Select Background window will open.
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Getting Started

To choose the graphics file you wish to use for your background click the directory or file to select it.  
Click the […] icon to go to a previous directory.  
Click OK to accept the selected file.  
The graphic must be in bitmap (.bmp) format.  
Your graphic will appear on the background of TA100 Pro. 
NOTE: To reset the background settings to the defaults: 
Click the File menu, Environment, Background. The Select Background window will open.
Click the Defaults button.

Gradient Background Option
You can disable the gradient back ground for all forms in TA100Pro by selecting no.  You can change 
the color of the gradient by selecting User Defined... and choosing a color.

Show Pictures Option
You can uncheck this option to remove the pictures on all buttons.  For example the green 
checkmark next to the OK button would not be shown when unchecked.

Language Option
You can choose your preferred language of English, Spanish or French.

NOTE: When the Default button is clicked the background, gradient, show buttons and language are 
all returned to their default settings.
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Getting Started

34

Navigation Selection 
You can customize the main toolbar to display a small button toolbar, large button toolbar, show center 
screen shortcut, side bar or zoom bar. 
Click the File menu, Environment, Navigation Selection. 
Then select from the list of options.



This section explains how to configure and customize TA100 Pro for your company's 
requirements. To make this chapter easier to follow, the topics in this section are arranged in the 
sequence that Synel Americas recommends completing them. This also happens to be the order 
in which they appear on the Configure menu in the TA100 Pro Main Window. This order is: 

• Main Company

• Divisions (optional)

• Categories

• Policies

• Shifts

• Holidays

• Groups (optional)

• Department

• Job

• Security

• Bell Schedules

• Benefit Accruals

Configuration
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Main Company 
The Main Company window is where you identify your company, define the overall configuration 
of the system, and specify the payroll service to which time and attendance data will be exported. 

Click the System Setup menu, Company, Main Company. The Main Company window will open and 
the General tab will be selected by default.

Configuration
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Configuration
Fill in the settings as appropriate:

Name Enter your company's name. This field is required and can contain up to 30 
characters. 

Address

Setting Description

Address

Enter your company's name. This field is required and can contain up to 30 
characters. 

NOTE: Divisions can be used to allow for additional branch addresses

Enter the second line of your company's primary address (such as suite number.) 
This field can accept up to 30 characters and may be left blank

City Enter your company's primary address City. This field can accept up to 30 
characters. 

State Enter the two-character code for your company's State. TA100 Pro automatically 
capitalizes your entry. 

Zip Code Enter your company's zip code. You may enter the 5 or 9 digit zip code. 

Phone Number Enter your company's primary phone number.  
Fax Number Enter your company's primary fax number. 

When all settings are complete, click the Configure tab. The Configure screen will appear. 
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Fill in the settings as appropriate: 

Configuration

Daylight  
Savings

Divisions

Setting Defintion

Lunches

Breaks

Check this box to enable this option if your employees will punch for lunch 
or lunch will be deducted automatically.

Check this box to enable this option if your employees will punch for break or 
break will be deducted automatically. 

Departments 

Check this box if your company is in a state that observes daylight savings 
time. Typically you will check this box. 

Check this box to enable the Divisions feature. A Division is a "subset" of the 
main company, such as a branch, different location, or subsidiary company.  
TIP: Companies who submit multiple company codes to their payroll service 
may want to use Divisions. 

Check this box to enable the Departments feature. Departments reflect the 
business units within your company and are the top level of Job Costing.  
NOTE: You will have the opportunity to customize this nomenclature in the 
next screen. 

Check this box to enable the Job level.  Jobs are the second level of Job 
Costing. 
NOTE: You will have the opportunity to customize this nomenclature in the 
next screen. 

Jobs

This option allows an SMTP server to be specified in security instead of an 
Outlook profile.

Tip Reporting Check this box to enable tip reporting. 

Paid Lunches and 
Breaks Do Not 
Accrue Toward 
Overtime  

"Level Wage" refers to the hourly rate associated with a department and job. 
The "default assignment wage" refers to the wage associated with an 
individual employee. 
Check this box if you wish the wage assigned to the labor level to be used 
instead of the wage assigned to the employee.  With the box unchecked, the 
wage assigned to the employee overrides the level wage. 

Use SMTP for Email

Use Level Wage 
before Default 
Assignment Wage

Check this box if paid lunches and breaks are not considered in calculating 
hours for overtime. 

Wages Check this box to enable the wages features throughout TA100 Pro. This 
makes it possible to enter wage information in the Employee Maintenance 
screen. 
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Configuration
Setting Defintion

Use Swipe and Go 

Use (am-pm) Format 

Overtime Level 2 

Overtime Level 3 

Do Not Use Floater 
for Shift Selection  

Up to three levels of overtime may be defined in TA100 Pro. One overtime 
level 
(OT1) is always available. To use a second overtime level (OT2), click the 
Overtime Level 2 check box. 

To use a third overtime level (OT3) in the system, click the Overtime Level 3 
check box. This level is not available unless Overtime Level 2 is selected. 

Check this option to allow employees to punch without specifying the 
function they are using. The system then determines whether the individual 
punch was an In, Out, Out for Lunch, In from Lunch, etc., based on the 
employee’s last punch and the employee's schedule.  This feature can 
remove the employees ability to transfer labor levels depending on what 
clock is being used.  

Check this option to have reports and the online timecard use an AM/PM 
format instead of 24-hour format (military time.) 

Check this option to suppress all floaters from each shift group. Floaters 
allow employees to possibly work different shifts within the same shift 
group based on their clock in time. 

This option controls the number of pay periods and days in which it is 
possible to edit transactions in the TA100 Pro system. For instance, Figure 26 
specifies that two pay periods of transactions can be modified, the current 
pay period and the previous pay period. 

Editable Pay 
Periods, Plus Days

Auto Logout-Time 

Currency Name

Approval Editor Pay 
Periods Back 

Auto Logout-
Minutes

This option controls the number of displayed pay periods in the approval 
editor. Setting to 0 means it will use the editable pay periods setting instead.  

This option will define the number of minutes a user can be idle in TA100 Pro 
before it automatically logs them out. 

This option will define a specific time all users will automatically be logged 
out of TA100 Pro. 

Enter the type of currency TA100 Pro should use. The default is "Dollars." 

Select the manner in which dates should be displayed. The options are 
American (MM/DD/YYYY) and European (DD/MM/YYYY). 

Enter the character with which to delimit dates. The default is a slash (/). 

Date Format 

Date Delimiter
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Configuration
When all settings are complete, click the Defaults tab to select it. The Defaults screen will appear. 

Setting Defintion

Department 

Length

Length

Type

Employee

Fill in the settings as appropriate: 

Enter the term you would like to use to refer to employees. (i.e., Employees, 
Associates, Members, etc.) The default is "Employees."

Enter the maximum number of digits for the  Employee ID.

Choose the data type for the Employee ID. The options are Numeric and 
Alphanumeric.

Enter the term you would like to use to refer to the business units within 
your organization. (i.e., Departments, Business Unit, Cost Center, etc.) The 
default is "Department."

Enter the maximum number of digits for the Department ID.
WARNING: Changing this setting after using the program could cause data 
loss.
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Configuration

Setting Defintion

User Defined Fields 

Badges Length

Type 

Job 

Length

Type 

Fill in the settings as appropriate: 

Choose the data type for the Department ID. The options are Numeric and 
Alphanumeric.

Enter the term you would like to use to refer to the second level of job 
costing in your organization. (i.e., Job, Project, Client, etc.) The default is 
"Job."
Enter the maximum number of digits for the Job ID. 
WARNING: Changing this setting after using the program could cause data 
loss.

Choose the data type for the Job ID. The options are Numeric and 
Alphanumeric.

Maximum

Type 

Automatic Badge 
Assignment

TA100 Pro allows you to define up to 18 user-defined fields. Enter the names 
of the fields you would like to define (if any). If you do not need any custom 
fields, you may leave these blank. The default values are License, Spouse, 
and License 2, but you may modify or delete these as desired.

Enter the number of characters (from 2 to 10) that will be read from the 
employee badge. For example, if the badge number is 10 characters long but 
you want to read only the last five characters, enter a 5 in this field. The 
number of digits here must match the actual number of digits on the 
physical badges given to employees, and must also match the settings 
programmed into the badge reader clocks.

Type the maximum number of characters (from 2 to 64) on an employee’s 
badge. Any badge longer than this number will be rejected by the time clock. 
WARNING: Changing this value after using the program can require all 
employees to be issued new badges.

Choose the data type for the Badge number The options are Numeric and 
Alphanumeric. 

TA100 Pro can assign badge numbers automatically when adding a new 
employee. You can manually change automatic assignments later if 
necessary.
Choose No Automatic Assignment to bypass the automatic assignment and 
be allowed to enter the badge number manually.
Choose Next Numeric Available to have TA100 Pro assign the next sequential 
available badge number.
Choose Same as Employee Number to have TA100 Pro assign a badge 
number that is identical to the employee's ID number.
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Configuration
When all settings are complete, click the Exports tab to select it. The Exports screen will appear. 

Select the payroll provider to which you wish to export data. You may be prompted for additional 
information specific to the payroll application selected. For example, when ADP is selected, you 
are asked for the Company  Code of your main company.  Click Display  only  this  export  to have this 
payroll company listed as the only export available via reports. 

NOTE: If the payroll provider you will be using does not appear in the list, simply choose either 
“Generic Numeric” or “Generic Alpha” depending on the Pay Code type your provider requires 
(contact your payroll provider to obtain this information.  

When all settings are complete, click OK to save the changes and exit the Main Company 
configuration dialog box.  

Divisions 
Divisions are subsets of the main company. For example, a division can be a remote office or 
separate business unit. Divisions are not required and will only be available if the Divisions option is 
selected in Main Company Configure screen.

Configure  Divisions 
From the divisions dialog box, you may add, edit and delete Divisions. 
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The Divisions window includes the following information: 

Configuration

Name This is a required field. Type the division name (up to 30 characters) as you want it 
to appear in the system and on reports. 

Address

Setting Description

Address

Enter the first line address of the division. Up to 30 characters may be entered in 
each line.

City Type the name of the city (up to 30 characters) for the division.  

State Type the two-character state abbreviation. 
Zip Code Enter the five or nine-digit postal zip code of the division. 
Phone Number Enter the telephone number for this division.
Fax Number Enter the fax number for this division. 

Number This is a required field. Enter a 4-digit number to identify the division.  NOTE: Do 
not use 0000 since this number is assigned to the main company and cannot be 
used for divisions. 

Active Click the Active check box to indicate that the division is currently in use. Uncheck 
this box if the division is not being used at this time. 

Additional 
Information 

You may be prompted for additional information based upon the payroll application 
selected in the Export screen of the Main Company configuration. For example, if 
ADP is selected in the Export screen, you will be prompted for the company 
number of this division.

Enter the second line address of the division (if applicable). Up to 30 characters 
may be entered in each line. 

Click the System Setup menu, Company, Divisions. The Configure Divisions dialog box will
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Configuration

Click OK to confirm the deletion. 
Click Close to exit the Configure Divisions window. 

Add a Division 
Click the System Setup menu, Company, Divisions. The Configure Divisions dialog box will open. Click 
the Add button. The General screen will become available for you to add the new Division. Fill in the 
settings as described in the Configure Divisions section. 
Click OK to commit the changes and return to the Configure Divisions screen. 
Click Close to exit the Configure Divisions window. 

Edit a Division 

Click the System Setup menu, Company, Divisions. The Configure Divisions dialog box will open. 
Highlight the Division you wish to edit from the list at the side of the screen. 
Click the Edit button. The General screen will become available for you to edit the selected division. 

Edit the settings as described in the Configure Divisions section. 
The Division number cannot be changed. 
Click OK to commit the changes and return to the Configure Divisions screen. 
Click Close to exit the Configure Divisions window. 

Delete a Division 
Divisions assigned to employees, both active and inactive, cannot be deleted. 

Click the System Setup menu, Company, Divisions. The Configure Divisions dialog box will open. 
Highlight the division you wish to delete from the list at the side of the screen. 
Click the Delete button. 
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Categories 
Categories are used to track and report types of time or money. The built-in categories are: 

• Absent
• Adjustment
• Break
• Bereavement
• Holiday
• Jury  Duty
• Lunch
• Military Leave
• Sick – NonPaid
• Other Paid Time
• Personal Day
• Per Diem #1
• Per Diem #2
• Sick – Paid
• Cash Tips
• Charge Tips
• Vacation
• Worked  Time

You may edit and delete built-in categories (other than Work), as well as add custom categories 
specific to your organization, such as Floating Holidays, Family Leave, etc. Categories are used in 
entering time and monetary adjustments for employees. 

Configuration
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The Configure Categories screen displays the following information: 

Configuration

Setting Defintion

Equals Category 
Number from 
Hand Reader. 

This is a required field. Enter a code (up to 4 alphanumeric characters) to 
identify the category. Once saved, this code cannot be changed. 

Code 

Name 

Active 

When entering a Category into a Hand Reader, only a numerical value can 
be entered. Use this field to assign a number representing the Category 
Code. 

This is a required field. Enter the category name, as it will appear in the 
system and on reports. The category name can be up to 30 characters long. 

Click the Active check box to indicate that the category is currently in use. 
Clear this check box if the category is not being used at this time. 

Configure Categories 
Click the System Setup menu, Categories. The Configure Categories dialog box will open.
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Setting Defintion

Configuration

Can This Category 
be Overtime?

Post to Benefit 
Entitlement?

Are Miscellaneous 
Entries Paid?   

The Configure Categories screen displays the following information: 

Miscellaneous Entry 
Overrides Holiday 
Minimum Hours? 

Miscellaneous Entry 
Overrides Absence? 

Do You Wish to 
Export this 
Category? 

Hours/Dollars

This indicates whether this category will be included in the export 
information created for your payroll service.  
If this option is selected, the Export tab will become available. You must 
configure the Export tab settings to specify field mappings for your payroll 
export. (See Step 0.) 

This is a required field. Select either Hours or Dollars to indicate the 
category type. For example, the category VACATION collects hour amounts, 
while the categories TIP1 and TIP2 collect dollar amounts.  
If Hours is selected, complete the remaining fields that apply. If Dollars is 
selected, the remaining fields in this dialog box are unavailable. 

Select this option to allow a Miscellaneous entry of this category to 
override an absence. (Miscellaneous refers to an entry other than Work.) 

Allows time in this category to count toward the minimum hours worked 
requirement for allocating paid holiday time. (Miscellaneous refers to an 
entry other than Work.) 

Allows time in this category to be treated as “paid time.” Select this option if 
employees will be paid when receiving a miscellaneous entry using this 
category. (Miscellaneous refers to an entry other than Work.) 

This option will only be available if miscellaneous entries are paid. Select 
this option to accrue time in this category towards overtime. Clearing this 
option causes the system to prohibit overtime calculation on this category.  

Select this option to post accrued time in this category to company benefits. 
Checking this option makes it possible to configure benefit entitlement and/
or accrual rules for this pay type. Also, any time posted to this category will 
be deducted from the available entitlement for this category.  
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Configuration
The Export Codes tab will be available only if the Do you wish you to export this category option is 
checked.  

NOTE: These settings will be used to map data collected by TA100 Pro to the appropriate fields in 
your payroll application, and it is critical that they be configured fully and accurately. The 
information in these fields must be obtained from the payroll service specified in Company Setup. 
Contact your payroll service representative or software manual for the information requested, if 
necessary.ne
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The Export Codes tab includes the following information: 

Configuration

Differential: 
D1-D3

These lines of information will specify the codes used by hours allocated to each 
Shift Differential.

OT1

Setting Description

OT2

OT3

Differential: 
None

This line of information will specify the codes for hours that do not have differential 
adjustments.

REG Regular Hours are hours paid at "straight time." Enter the code your payroll 
application uses to refer to Regular hours.

OT3 hours are hours paid at the factor defined for OT3 in the Payroll Policy. Enter 
the code your payroll application uses to refer to hours paid at the OT3 factor. 
NOTE: This option will only appear if OT3 has been selected on the Configure tab of 
the Main Company configuration dialog box.

Enter the code that indicates which field of your payroll software this category will 
be mapped to. This code differentiates between categories of time that use the 
same field number. For example, regular (REG) hours for VACATION and HOLIDAY 
may both use field number 16. By assigning a field code V to the VACATION 
category and H to the HOLIDAY category, vacation hours are reported in field 16V, 
while holiday hours are reported in 16H. If no field code was assigned, you could 
not differentiate between vacation and holiday hours. 

Field Code 

OT1 hours are hours paid at the factor defined for OT1 in the Payroll Policy. Enter 
the code your payroll application uses to refer to hours paid at the OT1 factor.

OT2 hours are hours paid at the factor defined for OT2 in the Payroll Policy. Enter 
the code your payroll application uses to refer to hours paid at the OT2 factor.
NOTE: This option will only appear if OT2 has been selected on the Configure tab 
of the Main Company configuration dialog box.
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Add a Category 

Click the System Setup menu, Categories. The Configure Categories dialog box will open.
Click the Add button to add a new Category. The General tab will become available. 

Fill in the settings as described in the Configure Categories section. Click OK to commit the 
changes and close the Categories dialog box. Click Close to exit the Configure Categories window. 

Edit a Category 
Click the System Setup menu, Categories. The Configure Categories dialog box will open. 
Highlight the Category you wish to edit from the list at the side of the screen. 
Click the Edit button. The General screen will become available for you to edit the selected 
category. Edit the settings as described in the Configure Categories section. 
Click OK to commit the changes and return to the Configure Categories screen. 
Click Close to exit the Configure Categories window.

Configuration
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Delete a Category 
Categories that are in use cannot be deleted. 

Click the System Setup menu, Categories. The Configure Categories dialog box will open. 
Highlight the category you wish to delete from the list at the side of the screen. 
Click the Delete button. You will be prompted: 

Click OK to confirm the deletion. 
Click Close to exit the Configure Categories window. 

Configuration
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Configuration
Policies 
Policies are used to store and apply the business or payroll rules governing overtime, holidays, etc. 
It is possible to have more than one set of rules within an organization, so TA100 Pro makes it 
possible to create many Policies. Each employee is assigned to the Policy that applies for him or her. 

Configure Policies 

Click the System Setup menu, Policies. The Configure Policies dialog box will open.
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Configuration

Setting Defintion

Pay Period 

Weekly

Name

Active

Code

Bi-weekly 

Semimonthly 

Monthly

Start Date 

This field is required. Enter a code (up to 3 alphanumeric characters) to 
identify the policy. Once saved, this code cannot be changed. 

This field is required. Type the company policy name, as it will appear in the 
system and on reports. The policy name can be up to 30 characters long. 

Click the Active check box to indicate that the policy is currently in use. 
Clear this check box if the policy is not being used at this time. 

Select the appropriate pay period information for your company. 

Check this option if wages are paid weekly. 

Check this option if wages are paid every other week.

Check this option if wages are paid once a month. 

Check this option if wages are paid twice a month. 

Enter the starting date of the pay period (using MM/DD/YYYY format). This 
is used for calculations and represents the starting date of an entire payroll 
period. The day of the week (Sunday, Monday, etc.) that corresponds to the 
starting date is used to determine when the cycle begins. The overtime 
cycle will also use START DATE. 
NOTE: This date should be the first of a month in the past that corresponds 
to the day of the week that the pay period starts on. 

There are several tabs in the Configure Policies dialog box, each with its own settings. The first tab, 
General tab defines general payroll policy parameters and contains the following information: 
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Setting Defintion

Will default the 
Work total to 

First First Change Punch 
Accrues to In Punch 

Reset Swipe 
and Go at 
Midnight 

Maximum Out 
Punch Link Back to 
In Punch  

Missing Out
Punch Limit

Number of Days in 
Semimonthly Period 

Punch Defaults The settings in this section define how punches are processed. 

Ignore Use of 
Duplicate Function 
Key Punches Within

Ignore Use of 
Duplicate Function 
Key Punches Within

Enter the number of minutes (up to 59) during which duplicate punches on 
the time clock are ignored. When duplicate punches are made within this 
time frame, only the last punch is used for calculations. 

Enter the number of minutes (up to 59) in which opposing (i.e. sequential In/
Out) punches on the time clock are ignored. For example, if 3 minutes is 
entered here and an employee accidentally punches Out instead of In, the 
employee can enter the In punch within 3 minutes to correct the error and 
TA100 Pro will ignore the Out punch entirely.

Enter the number of hours (in HH.MM format) that can pass after the In 
punch before the system assumes the employee has forgotten to punch out 
and flags it as a missing punch. For example, if 10.00 is entered in this field, 
the system expects an Out punch to be recorded no later than 10 hours after 
the shift’s In punch. The default for this field is 18.00 or 18 hours. . 
Enter the time (in HH.MM format) to be recorded when the employee is 
flagged with a Missing Out Punch.  For example, assume an employee is 
scheduled to work 8 hours and forgets to punch Out. If 8.00 is entered in this 
field, the system recognizes the missing Out punch yet totals 8 hours for the 
employee. The default for this field is 00.00 (indicating that no time will be 
totaled for a Missing Out Punch). 

Enter the maximum time an employee who has punched Out can punch 
back In and still have the new time included in the previous total when 
calculating daily overtime. For example, assume that the Maximum Out 
Punch Link-Back is defined as 2.00 and overtime is paid after working 8 
hours in a single day. If an employee punches In at 8:00 A.M. and Out at 5:00 
P.M. (with a one hour unpaid lunch) then punches back In at 6:30 P.M.
(within the 2-hour link-back) and Out again at 9:30 P.M., the daily total
shows 8 hours of regular time and 3 hours of overtime.

Check this option if the first department and/or job transfer after the In 
punch should be retroactive to the In punch. 

This option will make the first swipe and go transaction after midnight a 
clock in type.  For example, if an employee punches at 6pm, then punches 
again at 2:00 A.M. that 2:00 A.M. would become a clock in and the 6:00 P.M. 
would show as a missed punch. 

If the pay period is semimonthly, specify the number of days in the first half 
of the policy’s semi-monthly period. Click the down arrow next to the entry 
field to select a number from 1 to 28.
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The Holidays tab defines the rules for paying Holidays and contains the following information: 

Configuration

Setting Defintion

Holiday Eligibility

Pay Holidays 

Minimum Before 

Minimum After 

Required to Work 
the Scheduled Day 

Check this option if you wish the program to pay holidays. You will specify 
the dates of the holidays in a separate dialog box. (See Holidays, page 66.) 

Holiday Parameters 

These settings define the prerequisites for being paid for the holiday. 

Enter the minimum number of days (up to 3 digits) from the hire date for an 
employee to qualify for non-worked holiday pay. The default is 90 meaning 
90 qualifying days are required. 

Select an option to indicate which days the employee must work to qualify 
for holiday pay. 
Before and After. Employee must work the scheduled day before and after 
the holiday to receive holiday pay. 
Before or After. Employee must work the scheduled day before or after the 
holiday to receive holiday pay. 
None. There are no requirements for the employee to qualify for holiday pay. 

Enter the number of hours that must be worked on the day prior to the 
holiday in order for that day to qualify as having been worked.  

Enter the number of hours that must be worked on the day after the holiday 
in order for that day to qualify as having been worked.  

These settings define how the Holiday pay will be allocated. 

Minimum Days of   
Employment to 
Qualify 

Apply Holiday When 
Not Schedules to 
Work

Check this option if the holiday hours can be given to an employee who is 
not scheduled to work on the holiday. 
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Configuration
Setting Defintion

Holiday Hours can 
Accrue Toward 
Overtime 

Hours to Add for
Each Unworked
Holiday

Given Minimum

Hours to Add for 
Each Worked 
Holiday 

Check this option if holiday hours and added holiday time count toward 
overtime. For example, assume an employee works 44 hours during a week 
and one 8-hour holiday occurs. If this option is checked, and overtime is paid 
after 40 hours, the employee receives 40 hours regular pay and 12 hours 
overtime. If this option is not checked, the employee receives 48 hours 
regular pay and 4 hours overtime. 
Enter the number of hours (in HH.MM format) to be added to the employee’s 
time for each worked holiday. These hours are in addition to actual time 
worked. For example, if 8.00 hours are entered in this field, and an employee 
works 8 holiday hours, 8 more hours are added to the employee’s time. The 
default is 8.00. 

Enter the number of hours (in HH.MM format) added to the employee’s time 
for each non-worked holiday. This entry is usually equal to the number of 
regular hours worked. The default is 8.00.

Enter the minimum number of hours that an employee is guaranteed to 
receive for holiday pay regardless of the number of hours worked.

Given Maximum Enter the maximum number of hours that an employee is guaranteed to 
receive for holiday pay regardless of the number of hours worked.

Multiply Worked 
Holiday Hours to Apply 
to HOL

Click this check box to multiply any worked holiday hours by a specified
 rate.

Beginning Pay 
Rate if Holiday is 
Worked 

Select a level to indicate the employee’s wage multiplier for a worked holiday. 
Reg. Regular wages are paid for a worked holiday. 
OT1. The overtime rate specified in OT1 on the Overtime dialog box is paid for 
a worked holiday. 
OT2. The overtime rate specified in OT2 on the Overtime dialog box is paid for 
a worked holiday. 
OT3. The overtime rate specified in OT3 on the Overtime dialog box is paid for 
a worked holiday. 

Hours to Add for
Each Unworked
Holiday

Select a level to indicate the employee’s wage multiplier for a secondary 
worked holiday. 
Reg. Regular wages are paid for a worked holiday. 
OT1. The overtime rate specified in OT1 on the Overtime dialog box is paid 
for a worked holiday. 
OT2. The overtime rate specified in OT2 on the Overtime dialog box is paid 
for a worked holiday. 
OT3. The overtime rate specified in OT3 on the Overtime dialog box is paid 
for a worked holiday. 

Reset at End 
of Day 

Check this option to disable the holiday pay rate at midnight. Clear this check 
box to continue using the holiday pay rate specified until the employee 
punches Out. 
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Configuration
The Overtime tab defines the rules for calculating overtime and contains the following information: 

Setting Defintion

Pay OT 

Overtime Definition

Overtime Cycle 

Check this option to pay overtime to employees using this Policy. 

Check this option to pay overtime to employees using this Policy. 
This field is required. Enter the pay period that you use to calculate 
overtime. For example, if overtime is paid after 40 hours of work per week, 
select the Weekly option. This Overtime Cycle is independent of the Pay 
Period specified in Policy Maintenance but must not be greater than the 
policy pay period. For example, if the policy Pay Period is Biweekly, you may 
select an Overtime Cycle of Weekly or Biweekly, but not Semimonthly or 
Monthly since these cycles are longer than the policy pay period. 
Weekly. Overtime is calculated weekly. 
Biweekly. Overtime is calculated every two weeks. 
Semimonthly. Overtime is calculated twice a month. 
Monthly. Overtime is calculated once a month. 

These settings define when and how overtime is calculated. 
TIP: Begin by entering your first level of overtime in OT1.If after 40 hours of 
work per week, you pay time-and-a-half, enter 40.00 in the Period Limit field 
and 1.5000 in the Multiplier field.  
If double-time is paid after 60 hours, enter 60.00 in the Period Limit field and 
2.0000 in the Multiplier field for OT2.  
On Sundays and holidays, you may want to pay double-time and one-half 
regardless of hours worked. In this case, enter 99.99 in the Period Limit field 
and 2.5000 in the Multiplier field for OT3
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Configuration

Setting Defintion

OT Level 

Multiplier

Period Limit

Reset at Day End

Daily Overtime 

Day of the Week 

Start at OT Level 

Daily Qualifier

Consecutive Days

Number of Days

Up to three levels of overtime (OT1, OT2 and OT3) may be defined per policy.  

Enter the number of hours (in HH.MM format) that an employee must work 
to be eligible for overtime. For example, in a weekly pay period, the Period 
Limit is typically defined as 40.00; in a biweekly period, it is normally defined 
as 80.00. 

Enter the multiplication factor used to compute overtime pay. The normal 
pay rate is multiplied by this number. For example, to pay time-and-a-half, 
enter 1.50; to pay double-time, enter 2.00. 

These settings allow paying daily overtime. For example, many companies 
pay daily overtime over eight hours per day. Another example is paying 
double overtime on Sundays, regardless of how many hours are worked in 
the overtime cycle. 

Select the day(s) of the week that are paid daily overtime by checking the 
appropriate checkbox. 

Select the applicable overtime level to be paid (if any) at the start of the 
day. Choose Regular if no overtime is paid (regular wages), or OT1, OT2 or 
OT3 to pay the overtime wages defined above. 

Under OT1, OT2 and OT3, enter the number of daily hours (in HH.MM 
format) that must be worked before that overtime level will be 
acknowledged by the system. For example, if Sunday hours start at OT1, 
and OT2 begins after 8 hours, enter 8.00 in Sunday’s OT2 Daily Qualifier. 
Only overtime levels above the entry in Start at OT Level are available. 

Check this box to force any overtime hours that roll into the next day (after 
midnight) to be processed using the next day’s rules. Clear the check box to 
process hours accumulated past midnight using the OT rate from the 
previous day.

Check this box if overtime is paid automatically after working a certain 
number of consecutive days.
NOTE: Additional options appear when this box is checked.

Enter the number of consecutive days that must be worked before overtime 
starts.
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Setting Defintion

Minimum Daily 

OT Level

Hours Total 

On Days that 
Qualify  

After (hrs) 

OT Level

Reset Overtime at 
Cycle End 

Enter the minimum number of daily hours that must be worked on each 
consecutive day to qualify for overtime. 

Enter the minimum number of total hours that must be worked for all of the 
consecutive days to qualify for overtime. 

Select the overtime level that applies when the consecutive days criteria is 
met. 

Check this box to pay a second Overtime Level if an employee works more 
than the specified amount in the After field. TA100 Pro will apply the 
settings in the After and Overtime Level fields once the employee qualifies 
for consecutive day overtime.  

Enter the number of hours after which the second OT level will apply on 
days qualifying for consecutive day overtime.  
For example, if the employee gets OT1 for the first eight hours, and OT2 after 
eight hours worked on the seventh consecutive day, you would enter 8 in 
this field, and OT2 in the next field. 

Select the second OT level TA100 Pro will pay when an employee meets the 
qualification for the After field under "On days that qualify". This setting 
works in conjunction with the After column and indicates what overtime 
level will be paid when the number of hours in the After field has been met. 

If checked, this option tells TA100 Pro to reset the Consecutive Days count 
after the Overtime Cycle ends. This is used for Pay Periods with more days 
than the Overtime Cycle. 
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The Differential tab defines the codes and rates for up to three levels of Shift Differentials. A Shift 
Differential is a premium amount or factor paid in addition to the employee's regular wage for certain 
hours worked during the day. Shift Differentials work in conjunction with Shifts. The Differential tab 
contains the following information: 

Configuration

Setting Defintion

Use Differential  

Type

Differential

Check this option to enable the shift differentials. 

There are three differential codes available, along with a NONE option

Select the type of differential. 
Addition. Select this option to add a specific dollar amount to the 
employee’s regular wage. 
Multiplier. Select this option to multiply the employee’s regular wage by a 
multiplication factor. 

On Days that 
Qualify  

Check this box to pay a second Overtime Level if an employee works more 
than the specified amount in the After field. TA100 Pro will apply the 

Amount Enter the amount of the differential. If the type is Addition, enter the amount 
in dollars and cents that should be paid above the employee's regular wage 
for differential hours (i.e. .30 for 30 cents per hour). If the type is Multiplier, 
enter the percentage or factor to multiply the employee's regular wage for 
differential hours (i.e. 1.5 for time and a half). 

Differential 
Fixed to In 

Check this option to pay an employee a differential premium only when he/
she punches In within the time frame(s) specified in Shift Maintenance. 
Clear this check box to pay an employee a differential premium if any part 
of the hours falls within the time frame(s) in Shift Maintenance. 
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The Exceptions tab defines rules for flagging hours worked exceptions and contains the following 
information: 

Configuration

Setting Defintion

Report Exceptions 

Consecutive 
Hours Worked 

Check this box for TA100 Pro to report employees that work above or below 
the specified parameters. 

Enter the number of consecutive hours worked (HH.MM) that, if exceeded 
by an employee, will be reported on the Consecutive Hours Exception 
report. For example, if 14.00 is entered, employees working over 14 
consecutive hours are flagged for the report. 

Overtime 
Hours Worked 

Enter the number of overtime hours (HH.MM) that, if exceeded by an 
employee, will be reported on the Overtime Hours Exception report. For 
example, if 20.00 is entered, any employees working over 20 hours of 
overtime are flagged for the report. 

Daily Hours 
Worked

An employee who works under or over this number of hours (HH.MM) per 
day is reported on the Daily Hours Exception report. For example, if 6.00 is 
entered in the Under or Over fields, an employee working under or over 12 
hours a day is flagged for the report

Period Hours 
Worked 

An employee who works under or over this number of hours (HH.MM) in the 
period is reported on the Period Hours Exception report. For example, if 
30.00 is entered in the Under or Over fields, an employee working under or 
over 60.00 hours in a pay period is flagged for the report. 
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Add a Policy 
Click the System Setup menu, Policies. The Configure Policies dialog box will open.
Click the Add button to add a new Policy. The Default Policy Add dialog box will become available.

Enter a unique code for this policy. 
Enter a unique name for this policy. 
Click Yes to copy the existing policy, or click No to start from scratch. 
Fill in the settings as described in the Configure Policies section. 
Click OK to commit the changes and close the General dialog box. Click Close to exit the Configure 
Policies dialog box. 

Edit a Policy 
Click the System Setup menu, Policies. The Configure Policies dialog boxwill open.
Highlight the Policy you wish to edit from the list at the side of the screen. 
Click the Edit button. The General screen will become available for you to edit the selected Policy. 
Edit the settings as described in the Configure Policies section. 
Click OK to commit the changes and return to the Configure Policies screen. 
Click Close to exit the Configure Policies dialog box. 

Configuration
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Click OK to confirm the deletion. 
Click Close to exit the Configure Policies dialog box. 

Configuration

Delete a Policy 
Click the System Setup menu, Policy. The Configure Policies dialog box will open.
Highlight the Policy you wish to delete from the list at the side of the screen. 
Click the Delete button. You will be prompted: 
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Configuration
Shifts 

Shifts define the work schedule for your employees. Shifts are created in Shift Groups, which can 
include multiple Shifts. For example, you may have a Shift Group for the Day-Shift workers, in which 
unique Shifts may start at 7am, 8am, and 9am. Rounding rules are applied to the Shift Group to 
determine employee tardiness and rounding. 

An employee assigned to a Shift Group can be assigned to any of the individual shifts within it. The 
employee may also "float" between Shifts, which causes TA100 Pro to determine tardiness and 
rounding according to the Shift the employee punched in closest to. For example, an employee that 
clocks in at 7:45am would be considered to be on the 8am Shift that day, simply because he/she 
clocked in closer to 8am than to 7am. The parameters for this "cut off" are defined as part of the 
Shift. 

You will first create the Shift Group (Days, Swing, Graveyard, etc.) and then will create the unique 
Shifts within it.

Configure a Shift Group 
A Shift Group is made up of individual Shifts that are unique but are related in some way. For 
example, the Day Shift Group has Shifts that all take place during daylight hours, but has unique 
starting & stopping times (7am-4pm, 8am-5pm, 9am-6pm, etc.) 

Click the System Setup menu, Shifts. The Configure Shifts dialog box will open. The Configure Shifts 
dialog box contains three tabs, which are described below.
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The Shift Groups tab defines the settings that apply to the Shift Group as a whole and contains the 
following information: 

Setting Defintion

Code

Name

Active

This field is required. Enter a unique shift code up to 3 characters in length. 
Once saved, this code cannot be changed. 

This field is required. Type the shift group name, as you want it to appear in 
the system and on reports. The shift group name can be up to 30 characters 
long. 

Click the Active check box to indicate an active shift group. Clear this 
check box if the group is inactive. Rather than deleting a shift group from 
the system, simply mark it inactive in the event you wish to use it again at a 
later date. 

Configuration
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Setting Defintion

Shift Details 

Add/Edit/Delete 
Buttons 

Hours to Add for
Each Unworked
Holiday

Add/Edit Lunch 
Rounding 

Reset at End of Day 

Rounding

In/Out Rounding

Add/Edit In/Out 
Rounding 

Displays the individual shifts that comprise the shift group. Each row in the 
box is an individual shift. If the Shift Details box is blank, no individual 
shifts have been created for this group. 

These buttons allow you to maintain the Shifts within this Shift Group. 

These settings determine which Rounding Rules will apply to all the Shifts 
within this Shift Group. 

Click the arrow to select time rounding rules for In and Out punches used 
by the shift group.  
NOTE:  These rules apply to the entire group and not to the individual shifts. 

Click this button to Add or Edit the In/Out Rounding Rules. 

Click the arrow to select time rounding rules for Lunch punches used by 
the shift group. 
NOTE:  These rules apply to the entire group and not to the individual shifts. 

Click this button to Add or Edit the Lunch Rounding Rules.

Click the arrow to select time rounding rules for Break punches used by 
the shift group. 
NOTE:  These rules apply to the entire group and not to the individual shifts. 

Click this button to Add or Edit the Break Rounding Rules. 

Lunch 
Rounding

Configuration

Flex/Open 

Forecasted Hours 
for Floaters 

Click the Flex/Open check box if the shift group consists of flexible shifts. A 
flexible shift does not have a designated start and stop time. It only specifies 
the number of hours that an employee must work to complete the shift. 
When Flex/Open is selected, you cannot set the start and stop times for any 
individual shift created in this group. You can only specify the total duration 
of the shift. Also, the Forecasted hours for floaters is unavailable. 
Enter the number of hours that a floating employee must work within a pay 
period. This allows the system to forecast a number of hours for floating 
employees when doing forecast reporting. Unlike an employee assigned to 
a fixed shift, a floating employee may work varied shifts as long as he/she 
works the total number of hours required for the pay period. 
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The Add/Edit Rounding buttons are only available when you are adding or editing a Shift Group.  
When you click on the Rounding buttons the Rounding Details dialog boxes contain the following 
information: 

Configuration

Setting Defintion

Code

Name

Outside Round 

Start

Round In 

Grace In

This field is required. Enter a unique rounding code up to 5 characters in 
length. Once saved, this code cannot be changed. 

This field is required. Type the time rounding code name as you want it to 
appear in the system and on reports. The rounding code name can be up to 
30 characters long. 

These settings define the rounding rules for the period's start time. 
Depending upon the type of transaction selected, this may be the In, Start 
Lunch or Start Break punch. 

Identifies the number of minutes before the scheduled Start time that will 
round forward to the scheduled In time. 

Identifies the number of minutes that are rounded back after the scheduled 
start time. 

Identifies the number of minutes after the scheduled Start time that will be 
rounded forward before TA100 Pro will use the Outside Round. 

The Outside Round box is for additional rounding rules not covered in the 
ranges above. Both the Start and Stop category has its own set of outside 
rounding parameters. 

Dock In
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Configuration

Setting Defintion

Every XX Mins

With A XX 
Minute Split 

Stop

Dock Out 

Grace Out

Round Out

Every XX Mins

With A XX 
Minute Split 

Rounding may be minute to minute (0) or in set increments of 3, 6, 15, 30 or 
60 minutes. Click the arrow to display valid entries then select the 
increment desired. For example, entering 15 in this field means that for 
punches occurring outside the Scheduled Start time, round to the nearest 
15 minutes using the Round Back and Round Forward rules specified below. 

Punches occurring through the minute specified will round back to the last 
defined rounding increment.  Punches occurring from the minute indicated 
will round forward to the next defined rounding increment.    

Fields in the Stop column allow the rounding of Out punches, based on the 
scheduled stop times.  These settings define rounding rules to round the 
duration of the work period (as opposed to the start time.)   

Identifies the number of minutes before the scheduled Stop time that will 
round back prior to the scheduled Stop time. 

Identifies the number of minutes that are rounded forward to the scheduled 
Stop time. 

Identifies the number of minutes after the scheduled Stop time that will 
round back to the scheduled Stop time. 

Rounding may be minute to minute (0) or in set increments of 3, 6, 15, 30 or 
60 minutes. Click the arrow to display valid entries then select the 
increment desired. For example, entering 15 in this field means that for 
punches occurring outside the Scheduled Start time, round to the nearest 
15 minutes using the Round Back and Round Forward rules specified below. 

Punches occurring through the minute specified will round back to the last 
defined rounding increment.  Punches occurring from the minute indicated 
will round forward to the next defined rounding increment.   
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The Details tab is only available when you are adding or editing a Shift (as opposed to the Shift 
Group). It defines the settings for a selected Shift within the Shift Group, and contains the following 
information: 

Configuration

Setting Defintion

Graphic

Cutoff

Process On

Gross

Lunch/Breaks 

Totals

Use the graphic timeline to define the individual start and stop time of a shift. 

Shift Number Enter a unique number (up to 3 digits) to identify the individual shift. 

Start

Stop

Type the individual shift’s starting time in HH:MM. Times must be entered in 
military format.  

Type the individual shift’s latest starting time (cutoff) in HH:MM, before the 
individual would “float” into the next schedule. Times must be entered in 
military format. 

Type the individual shift’s ending time in HH:MM. Times must be 
entered in military format. 

If the shift’s stop time rolls over to a new day, do you want to process the 
hours on the day the employee punched In or punched Out? Select the In or 
Out option by clicking the desired field. 

This field automatically displays the total duration of the shift from clock in 
to clock out.

This field automatically displays the total number duration of lunches and 
breaks (combined). 

This field automatically displays the total paid hours for the day. It takes into 
account whether or not breaks and lunches are paid. 
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Configuration
Setting Defintion

Lunches

None

SG Max

Breaks 

Punched

These settings define how lunches are treated during this shift. 

With A XX 

Punched

Elapsed

None

Check this box to indicate that employees should clock out for and in from 
lunch. 

Select this option if the shift’s lunch period is automatically deducted after a 
number of elapsed hours. If the Punched check box is also selected, the 
punched time overrides the elapsed time. In other words, if the employee 
does not punch Out for and In from lunch, the shift’s lunch period is 
automatically deducted after the elapsed time. Define the elapsed time in 
the Elapsed Deduct box below. 
If no restrictions apply to the shifts lunch period, select this option. Typically, 
if the employee has a paid lunch, clear the Punched check box and select 
None. This prohibits the employee’s lunch period from being deducted from 
the shift’s total hours.
If Swipe and Go is in use, this tells TA100 Pro what the maximum amount of 
time a lunch or break can be. Enter time in military format. TA100 Pro will 
then take all the punches and measure the duration between transactions. If 
the duration is longer than the SG Max, it will move to the next option. 

These settings define how breaks are treated during this shift. 

Check this box to indicate that employees should clock to and from break

SG Max

With A XX 

Select this option if the shift’s break period is automatically deducted after a 
number of elapsed hours. If the Punched check box is also selected, the 
punched time overrides the elapsed time. In other words, if the employee 
does not punch Out for and In from break, the shift’s break period is 
automatically deducted after the elapsed time. Define the elapsed time in 
the Elapsed Deduct box below. 

If no restrictions apply to the shift’s break, select this option. Typically, if the 
employee has a paid break, clear the Punched check box and select None. 
This prohibits the employee’s break from being deducted from the shift’s 
total hours. 

If Swipe and Go is in use, this tells TA100 Pro what the maximum amount of 
time a lunch or break can be. Enter time in military format. TA100 Pro will 
then take all the punches and measure the duration between transactions. If 
the duration is longer than the SG Max, it will move to the next option.

Enter the time frames for exception transactions in this box. These are the 
time frames in which employees are not supposed to be punching. If a 
punch falls within these time frames, it is reported on the Punch Interval 
Exceptions report and to the Approval Editor as an exception or violation 
that needs supervisor approval. 
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Setting Defintion

Start

Punched

Duration

Elapsed 
Deduct 

Elapsed 

From

Deduct

Stop

Type

Punch Type

Paid

Pay 
Outside

Type the starting time of the exception in HH:MM. Time must be entered in 
military format. 

Type the ending time of the exception in HH:MM. Time must be entered in 
military format. 

Select In or Out to indicate that the exception applies to an In or Out punch. 

Click the down arrow to the right of the Type field and select the type of 
period 
(Lunch, Break or None) to be defined in this row. For example, to define a 
windowed lunch period, select Lunch as the Type. 

If the lunch or break is paid, select the Paid check box. Otherwise, clear this 
box to indicate an unpaid lunch or break. 

These settings define the parameters for Elapsed Lunches and Breaks. If 
Elapsed is selected in either the Lunch or Breaks sections, you must 
configure this section. 

Enter the number of hours that need to elapse before a Lunch or Break is 
automatically deducted. For example, if three hours must elapse, enter 03:00 
in this field. 

Click the button to the left of the From field and select whether the elapsed 
time starts from the Actual In Punch or Shift Start Time. The word Punch or 
Shift displays in this field to indicate your selection. 

Enter the time to be automatically deducted for the Lunch or Break. For 
example, to deduct one hour, enter 01:00. 

These settings define how long the employee is allowed for lunch, and how 
payment should be handled if the employee takes more time than is 
allowed. 

If the employee punches Out for and In from lunches or breaks, enter the 
duration of the lunch or break in this field. For example, to specify a one-
hour lunch period, enter 01:00.

If the employee punches for a lunch or break that is paid, define if it 
continues to be paid after the defined duration, and it so, for how much 
longer.  Checking this box and putting 00:30 would mean an additional 30 
minutes longer than the defined duration would be paid, then all time after 
that would be unpaid.
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The Differential tab defines a Shift Differential for this Shift Group (not for the individual Shift) and 
contains the following information: 

Configuration

Setting Defintion

Differential List Displays the Start, Stop, and daily status of an existing differential. 

From 

Day of the Week

Select the starting time for the pay differential. 

Select the differential premium code (D1-D3) assigned to the shift each day 
of the week. For example, a 10:00 P.M. to 6:00 A.M. shift may receive a $5.00 
per hour premium on weekends, but only $2.50 per hour premium Monday 
through Friday. If no differential premium code applies to a particular day, 
select "No Differential". 

Stop Select the ending time for the pay differential.
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Add a Shift Group 

Click the System Setup menu, Shift. The Configure Shift dialog box will open.
Click the Add button to add a new Shift Group. The Groups tab will become available.

Fill in the Code, Name, Flex/Open, Forecasted hours for Floaters and select the Rounding as 
describe in the Configure Shift Group section.    

NOTE:  If the Rounding Rules are not defined see Add/Edit Rounding for more information.

Click OK to commit the changes and close the Configure Shift Group dialog box. 
Click the Add button next to the Shift Details window to add a new Shift. The Details tab will 
become available. 
Fill in the settings as described in the Configure Shift section. 
Click OK to commit the changes and close the Shift dialog box. 
Click on the Differential tab to add a shift differential. 
Click the Add button. 
Enter the From and To in HH:MM. 
Select the Day and Differential number that will apply to this shift. 
Click Close to exit the Configure Shift Group dialog box. 

NOTE:  See Add A Shift to enter the specific shifts within this shift group. 

Configuration
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Edit a Shift Group 

Click the System Setup menu, Shift. The Configure Shift Group dialog box will open.
Highlight the Shift Group you wish to edit from the list at the side of the screen. 
Click the Edit button. The Groups screen will become available for you to edit the selected Shift Group. 
Edit the Name, Flex/Open, Forecasted hours for Floaters and select the Rounding as describe in the 
Configure Shift Group section. 
Click OK to commit the changes and return to the Configure Shift Group screen. 
Click Close to exit the Configure Shift Group dialog box.

NOTE:  See Edit a Shift to edit shift within this shift group. 

Delete a Shift Group 

Click the System Setup menu, Shift. The Configure Shift Group dialog box will open.
Highlight the Shift Group you wish to delete from the list at the side of the screen. 
Click the Delete button. You will be prompted: 

Configuration

Click OK to confirm the deletion. 
Click Close to exit the Configure Shift Group dialog box.
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Add a Shift 

Click the System Setup menu, Shift. The Configure Shift dialog box will open.
Click the Add button next to the Shift Details window to add a new Shift. The Details tab will become 
available. 
Fill in the settings as described in the Configure Shift section. 
Click OK to commit the changes and close the Shift dialog box. 
Click on the Differential tab to add a shift differential. 
Click the Add button. 
Enter the From and To in HH:MM. 
Select the Day and Differential number that will apply to this shift. 
Click Close to exit the Configure Shift dialog box. 

Edit a Shift 

Click the System Setup menu, Shift. The Configure Shift dialog box will open.
Highlight the Shift you wish to edit from the list in the center of the Groups screen. 
Click the Edit button next to the Shift Details  window. The Details screen will become available for 
you to edit the selected Shift. 
Edit the settings as described in the Configure Shift section. 
Click OK to commit the changes and return to the Configure Shift screen. 
Click on the Differential tab to edit a shift differential. 
Click the Edit button. 
Edit the From, To, Day and Differential number. 
Click OK to commit the changes and close the Shift Differential dialog box. 
Click Close to exit the Configure Shift dialog box.

Delete a Shift 

Click the System Setup menu, Shift. The Configure Shift dialog box will open. 
Highlight the Shift you wish to from the list in the Center of the Groups screen. 
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Click OK to confirm the deletion. 
Click Close to exit the Configure Shift dialog box. 

Add a Rounding Rule 

Click the System Setup menu, Shift. The Configure Shift Group dialog box will open.. 
Click the Edit button to edit the Shift Group.  Use the drop down arrow to change the rounding rule 
to NONE DEFINED for the rule you wish to add. 
Click the Add In/Out Rounding, Lunch Rounding, or Break Rounding button.  The Rounding Details 
dialog box will open.
Fill in the settings as described in the Configure Shift Group section. 
Click OK to commit the changes and close the Rounding dialog box. 
Click Close to exit the Configure Rounding dialog box. 

Edit a Rounding Rule 

Click the System Setup menu, Shifts. The Configure Shift Groups dialog box will open.
Click the Edit button to edit the Shift Group.
Using the drop down arrow select the Rounding Rule you wish to edit.
Click the Edit In/Out Rounding, Edit Lunch Rounding, or Edit Break Rounding button. The Rounding 
Details dialog box will open for you to edit the selected Rounding Rule. 
Edit the settings as described in the Configure Shift Group section. 
Click OK to commit the changes and return to the Rounding Details dialog box. 
Click Close to exit the Configure Shift Group dialog box. 

Click the Delete button next to the Shift Details window. You will be prompted: 
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Holidays 
The Holiday feature specifies which dates are considered company holidays. (How employees are 
paid for the holidays is defined within Policies section.) Holidays must be defined in order to post 
employee time toward a paid holiday rather than time worked, as well as to generate time and 
attendance reports that reflect holidays. 

It is necessary to define the holidays each year, as certain holidays fall on or are observed on 
different dates each year. 

Holiday Tips: 
• It is not necessary to define all annual holidays: only enter those holidays that your company

recognizes.

• If a holiday falls on a Sunday, but your employees get Monday off, enter the holiday using
Monday’s date.

• If a holiday falls on a weekend, and your employees do not receive holiday hours for that day,
then don’t enter the holiday in the system.

• If your employees get two consecutive days off for a holiday, you must enter both dates. For
example, if Tuesday is the holiday and you wish to give both Monday and Tuesday off with pay;
enter the date for both days.

NOTE: No more than two consecutive holidays may be entered if employees must work the day 
before and the day after the holiday. 

Configure Holidays 
Click the System Setup menu, Holidays. The Configure Holidays window will open.

Configuration
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Add a Holiday 

Click the System Setup menu, Holiday. The Configure Holiday dialog box will open.
Click the Add button to add a new Holiday. The General tab will become available.

The Configure Holidays dialog box contains the following information: 

Configuration

Setting Defintion

Date

Name

Active 

Override Absent 
Allowed  

Holiday Groups 

Enter the date on which the holiday will be observed. This is the date on 
which the Holiday Policies (set in Policies) will apply. 

Enter the name of the holiday. 

Check the Active box to indicate that this holiday will be observed. 

Apply Work Time on 
this Holiday to 
(Secondary) OT 
Level 

Check this box if paid time for this Holiday should supersede a system-
generated absence. 

Check this box if the holiday is paid at the secondary rate, as defined in 
the payroll policy ‘Holiday’ section. 

Click the Include box for each group the Holiday will be observed.  Holiday 
Groups allow each group to have different holidays.  Employees can only 
be assigned one Holiday Group. 
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Edit a Holiday 

Click the System Setup menu, Holidays. The Configure Holidays dialog box will open.
Highlight the Holiday you wish to edit from the list at the side of the screen. 
Click the Edit button. The General screen will become available for you to edit the selected Holiday. 
Edit the settings as described in the Configure Holiday section. NOTE: The date cannot be modified. 
Click OK to commit the changes and return to the Configure Holiday screen. 
Click Close to exit the Configure Holiday dialog box. 

Delete a Holiday 

Click the System Setup menu, Holidays. The Configure Holidays dialog box will open.
Highlight the Holiday you wish to delete from the list at the side of the screen. 
Click the Delete button. You will be prompted: 

Click OK to confirm the deletion. 
Click Close to exit the Configure Holidays dialog box.

Fill in the settings as described in the Configure Holidays section. 
Click OK to commit the changes and close the Holiday dialog box. 
Click Close to exit the Configure Holiday dialog box. 
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Groups 
User-defined groups are optional but very useful. Groups are used to organize and sort employees 
throughout TA100 Pro. They may be used to sort employees when generating reports, and are also 
used with Security to control which employees managers are allowed to edit. Some examples of 
employee groups are: 

• Managers

• Union Employees

• Part-time Employees

Employees are assigned to a group in the Employee Maintenance dialog box.

Configure Groups 

Click the System Setup menu, Groups. The Configure Groups window will open.

Configuration
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Add a Group 

Click the System Setup menu, Groups. The Configure Groups dialog box will open.
Click the Add button to add a new Group. The General tab will become available.

Fill in the settings as described in the Configure Groups section. 
Click OK to commit the changes and close the Group dialog box. 
Click Close to exit the Configure Groups dialog box. 

Configuration

The Configure Groups dialog box contains the following information: 

Setting Defintion

Code

Name

Active

This is a required field. Enter a unique code (up to 10 characters) to identify 
the employee group. Once saved, this code cannot be changed.

This is a required field. Enter the group name, as you want it to appear in the 
system and on reports. The group name can be up to 30 characters long. 

Click the Active check box to indicate that the employee group is currently 
in use. Clear this check box if the group is not being used at this time. 
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Click OK to confirm the deletion. 
Click Close to exit the Configure Groups dialog box. 

Configuration

Edit a Group 

Click the System Setup menu, Groups. The Configure Groups dialog box will open. 
Highlight the Group you wish to edit from the list at the side of the screen. 
Click the Edit button. The General screen will become available for you to edit the 
selected Group. Edit the settings as described in the Configure Groups section.  
NOTE: The Group Code cannot be changed. 
Click OK to commit the changes and return to the Configure Groups screen. 
Click Close to exit the Configure Groups dialog box. 

Delete a Group 

Click the System Setup menu, Groups. The Configure Groups dialog box will open. 
Highlight the Group you wish to delete from the list at the side of the screen. 
Click the Delete button. You will be prompted: 
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Departments 
Departments are the top level in Job Costing. Departments indicate the business unit or section of the 
company that employees work for, and are used to track where employees spend their time. 
Departments serve many purposes in TA100 Pro. Employees can track their time to a department by 
clocking into and/or transferring to the department. Wages can be associated with the department 
and employee, enabling accurate department costing. Hours and wage budgets can be set for the 
department, enabling accurate budget vs. actual reporting. Reports can be filtered and grouped by 
department. 

Departments are optional and only available when the Department Use Flag is checked on the 
Configure tab of the Main Company dialog box. Also, if you changed the name used to refer to 
Departments (on the Defaults tab of the Main Company dialog box), that name will be used in lieu of 
"Department". For more information, see Main Company. 

Some examples of departments are: 

• Accounting
• Administration
• Customer Service
• Research and

Development
• Sales and

Marketing
• Shipping

Configure Departments 
Click the System Setup menu, Department. The Configure Department window will open.

Configuration
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The Configure Department dialog box contains the following information: 

Setting Defintion

Code

Name

Budgeted 
Total Hours 

Budgeted 
Total Dollars 

Hourly Wage 

Use Hourly Wage 

Active

This is a required field. Enter a code to identify the department. The code’s 
length and type (numeric or alphanumeric is determined in the Defaults 
dialog box in the Main Company dialog box (see Main Company, page 26.. 
Once saved, this code cannot be changed. 

This is a required field. Enter the department name, as it will appear in the 
system and on reports. The department name can be up to 30 characters 
long. 

Check this box to indicate that the department is currently in use. Clear 
this check box if the department is not being used at this time. . 

Check this box to pay all employees assigned to this department a standard 
hourly wage whenever they work in this department. Checking this box will 
enable the Hourly Wage field, in which you define the amount of the wage. 

NOTE: This Hourly Wage is also known as the Level Wage. If this wage is 
different than the employee's individual wage, the employee's individual 
wage takes precedence. To cause the Hourly Wage 
(Level Wage) to take precedence, check the Use Level Wage before default 
assignment wage option on the Configure tab of the Configure Main 
Company dialog box. 

The ‘budgeted total hours’ has no timeframe associated to it.  It is based on 
however the user wishes to run the reports.  If they want a daily report, put 
the daily hours expected to be worked into the field.  If the report will be ran 
by pay period, put the expected number of hours for the pay period in.  Use 
the Actual vs Budgeted report.

The ‘budgeted total dollars’ has no timeframe associated to it.  It is based on 
however the user wishes to run the reports.  If they want a daily report, put 
the daily dollars expected to be earned into the field.  If the report will be 
ran by pay period, put the expected number of dollars earned for the pay 
period in.  Use the Actual vs Budgeted report. 

Enter the hourly wage paid to employees working in this department.  The 
Use Hourly Wage check box must be selected for this field to be available. 
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Add a Department 

Click the System Setup menu, Department. The Configure Department dialog box will open. 
Click the Add button to add a new Department. The General tab will become available.

Fill in the settings as described in the Configure Departments section. 
Click OK to commit the changes and close the Department dialog box. 
Click Close to exit the Configure Department dialog box. 

Edit a Department 

Click the System Setup menu, Department. The Configure Department dialog box will open.
Highlight the Department you wish to edit from the list at the side of the screen. 
Click the Edit button. The General screen will become available for you to edit the selected Department.  
NOTE: The Code field cannot be edited. 
Edit the settings as described in the Configure Departments section. 
Click OK to commit the changes and return to the Configure Department screen. 
Click Close to exit the Configure Department dialog box. 

Configuration
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Delete a Department 
Departments that are in use cannot be deleted.  If an employee has clocked into or transferred into 
a department that is deleted, the time will still be associated with the department code used, but 
the description will be replaced with NOT DEFINED on reports. 

Click the System Setup menu, Department. The Configure Department dialog box will open. 
Highlight the Department you wish to delete from the list at the side of the screen. 
Click the Delete button. You will be prompted: 

Click OK to confirm the deletion. 
Click Close to exit the Configure Department dialog box.
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Jobs 
Jobs are the second level in Job Costing. Jobs are used to track employee’s time and labor cost in 
terms of hours and dollars. Jobs serve many purposes in TA100 Pro.  Wages can be associated 
with the job and employee.  Hours and wage budgets can be set for the job, enabling accurate 
budget vs. actual reporting. 

Jobs are optional and only available when the Department and Job Use Flags are checked on the 
Configure tab of the Main Company dialog box. Also, if you changed the name used to refer to Jobs 
(on the Defaults tab of the Main Company dialog box), that name will be used in lieu of "Jobs". For 
more information, see Main Company.  

Some examples of Jobs might be: 
• Welding
• Shipping
• Product Development
• Work Orders

Configure Jobs 
Jobs are the second level of the Job Costing feature (Departments are the top level.) 

Click the System Setup menu, then Job. The Configure Job window will open.

Configuration
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The Configure Job dialog box contains the following information: 

Configuration

Setting Defintion

Code

Name

Budgeted 
Total Hours 

Budgeted 
Total Dollars 

Hourly Wage 

Use Hourly Wage 

The ‘budgeted total dollars’ has no timeframe associated to it. It is based on 
however the user wishes to run the reports. If they want a
daily report, put the daily dollars expected to be earned into the field. If the 
report will be ran by pay period, put the expected number of dollars earned 
for the pay period in. Use the Actual vs Budgeted report.

Active

This is a required field. Enter a code to identify the Job. The code’s length 
and type (numeric or alphanumeric) is determined in the Defaults dialog box 
in the Main Company dialog box (see page 26). Once saved, this
code cannot be changed.

Check this box to pay all employees assigned to this Job a standard hourly 
wage whenever they work in this Job. Checking this box will enable the 
Hourly Wage field, in which you define the amount of the wage.

NOTE: This Hourly Wage is also known as the Level Wage. If this wage is 
different than the employee's individual wage, the employee's individual 
wage takes precedence. To cause the Hourly Wage (Level Wage) to take 
precedence, check the Use Level Wage before default assignment wage 
option on the Configure tab of the Configure Main Company dialog box.

This is a required field. Enter the Job name, as it will appear in the system 
and on reports. The Job name can be up to 30 characters long.

Check this box to indicate that the Job is currently in use. Clear this check 
box if the Job is not being used at this time.

The ‘budgeted total hours’ has no timeframe associated to it. It is based on 
however the user wishes to run the reports. If they want a daily report, put 
the daily hours expected to be worked into the field. If the report will be
ran by pay period, put the expected number of hours for the pay period in. 
Use the Actual vs Budgeted report.

Enter the hourly wage paid to employees working in this Job.
The Use Hourly Wage check box must be selected for this field to be 
available. 
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Add a Job 

Click the System Setup menu, then Job. The Configure Job dialog box will open.
Click the Add button to add a new Job. The General tab will become available. 

Fill in the settings as described in the Configure Jobs section. 
Click OK to commit the changes and close the Job dialog box. 
Click Close to exit the Configure Job dialog box. 

Edit a Job 

Click the System Setup menu, then Job. The Configure Job dialog box will open.
Highlight the Job you wish to edit from the list at the side of the screen. 
Click the Edit button. The General screen will become available for you to edit the selected Job.  
NOTE: The Code field cannot be edited. 
Edit the settings as described in the Configure Jobs section. 
Click OK to commit the changes and return to the Configure Job screen. 
Click Close to exit the Configure Job dialog box. 

Configuration
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Click OK to confirm the deletion. 
Click Close to exit the Configure Job dialog box. 

Delete a Job 

Jobs that are in use cannot be deleted.  If an employee has clocked into or transferred into a job 
that is deleted, the time will still be associated with the job code used, but the description will be 
replaced with NOT DEFINED on reports. 

Click the System Setup menu, then Job. The Configure Job dialog box will open.
Highlight the Job you wish to delete from the list at the side of the screen. 
Click the Delete button. You will be prompted: 

Configuration
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Bell Schedules 
The Bell Schedules is an optional module that allows your Time clock to activate a bell at specified 
times of day. For example, you might have a bell ring to announce the start of a shift, break or lunch, 
and the end of the day. The bell schedule is defined by the day of the week, the time of day, and the 
duration of the bell. The Bell Schedules module can ring up to 336 bells per Time clock per week. 

Each Bell Schedule template can contain multiple bell details. Once the Bell Schedule 
has been created, you will add the individual dates and times the bells will ring. The Bell 
Schedule is then downloaded to the appropriate Time clocks. 

Configure Bell Schedules 
Click the System  Setup  menu, Bell Schedules. The Configure Bells window will open.
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The Configure Bells dialog box contains  the following information: 

Setting Defintion

Number

Name

Active

This is a required field. Enter a 4-digit number to identify the bell schedule. 
Once saved, this number cannot be changed. 

This is a required field. The bell schedule name can be up to 30 characters 
long. 

Click the Active check box to indicate that the Bell Schedule is currently in 
use. Uncheck this box if the Schedule is not being used at this time. 

Schedules Lists the individual bell days and times entered. 

Number Indicates the order the bells will ring. 

Day of Week 

Time

Indicates the day(s) of the week the bell selected in the Schedules list will 
ring. 

Indicates the time at which the bell selected in the Schedules list will ring. 

Time Indicates the time at which the bell will ring.

Duration Indicates how long the bell will ring. 

SMTWTFS Indicates the day(s) of the week the bell will ring. 
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Enter in the Number, Name and Active status.
NOTE:  As soon as the Number is  entered, the Add button in the center of the screen will become 
available. 
Click the Add button in the center of the screen to add the individual bell details. The Bell Details 
window will open.

Configuration

Add a Bell Schedule

Click the System  Setup menu, Bell Schedules. The Configure Bell Schedule dialog box will 
open. Click the Add button to add a new Bell Schedule. The General tab will become available.
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Select the days of the week you want the bell to ring. 
Enter the time (HH:MM) at which you want the bell to ring. This must be entered in military time. 
Enter the duration for the bell (how long the bell should ring). The default value is 2.0 seconds. 
Click OK to commit the changes and close the Bell Details dialog box. 

Configuration

Click OK to commit the changes and return to the Configure Bells screen. 
Click Close to exit the Configure Bells dialog box. 

Edit a Bell Schedule 

Click the System Setup menu, Bell Schedules. The Configure Bells dialog box will open. 
Highlight the Bell Schedule you wish to edit from the list at the side of the screen. 
Click the Edit button. The General screen will become available for you to edit the selected Bell 
Schedule. 
Edit the settings as described in the Configure Bell Schedule section. 
Click OK to commit the changes and return to the Configure Bells screen. 
Click Close to exit the Configure Bells dialog box
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Delete a Bell Schedule 
Bell Schedules that are in use cannot be deleted. 

Click the System Setup menu, Bell Schedules. The Configure Bells dialog box will open. 
Highlight the Bell Schedule you wish to delete using the list at the side of the screen. 
Click the Delete button. You will be prompted: 

Click OK to confirm the deletion. 
Click Close to exit the Configure Bell Schedules dialog box.
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Security 
Security access determines who can log in to the TA100 Pro, which employees they are allowed to 
manage and which areas of the program they are permitted to access. 

Security is established in two steps. 

1. Create the Security Levels that specify which program features are accessible.

2. Add User accounts.

Users are given a login id and password, are assigned to a Security Level, and are granted access to 
select groups of employees. 

You may define an unlimited number of Security Levels and Users. The number of users logged in at 
one time is limited by the number of User Licenses installed. 

There are four commands within the Security menu, all of which are described in the following 
sections. 

Configure Security Levels 

Security Levels define which areas of the program are accessible and what can be done in them. 
Security Levels should be configured prior to adding Users. Examples of Security Levels are: 

• Branch Managers
• Line Supervisors
• Payroll/HR
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Click the File menu, Security, Define Levels. The Configure Security Levels window will open.

Configuration

Up to four options are available for each feature. As the function of these options is the same 
for each feature, they are described once here for ease of use: 

Option Defintion

View

Add

Delete

Edit Allows the user to edit existing items. 

Grants read-only access to items.

Allows the user to delete existing items. 

Allows the user to add new items.
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The File tab grants access to features under the File menu and contains the following information: 

Print Lists

Check All This option will activate all available features in the File window.

Uncheck All This option will inactivate all available features in the File window. 

Configuration
The Configure Security Levels dialog box contains some general settings and several tabs, all 
of which are described below. 

Setting Defintion

Code

Name

Set Date and Time

Active 

This field is required. Enter a unique code (up to 10 characters) to identify 
the security level. Once saved, this Code cannot be changed. 

Enter a description of the security level in this field. The description can be 
up to 30 characters long. 

Click the Active check box to indicate that the level is currently in use. 
Uncheck this box if the level is not being used at this time. 

Check this box to allow the user to update the date and time of the PC.

Click the Print Lists check box to allow the user to print all available listings 
reports  
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Setting Defintion

Security

Users

Repost from R-files 

Other 

Set Reprocess 
Date 

Purge R-files 

Set Date and Time

Who is in 

Utilities 

Reindex, Repair, 
Update  

Fix Unassigned 
Badges 

System Backup 

System Restore

This section defines the user's access rights to the File, Security menu's 
features. 

Defines the user's access rights to User Maintenance settings. The options 
are View, Add, Edit and/or Delete.  
For more information on User Maintenance, see Security. 

Defines the user's access rights to Security Levels settings. The option is 
View.  

Defines the user’s access rights to the Who’s In screen.  The option is View. 

This section defines the user's access rights to the File, Utilities menu's 
features. 
NOTE: Typically these are reserved for the system administrator. 

Allows the user to Repair, Reindex and Update the TA100 Pro databases. For 
more information on these features, see Chapter XIII—Repairing, 
Reindexing and Updating. 

Allows the user to Set employees' Reprocess Date. 
For more information on this feature, see Chapter XIII—Set Reprocess Date.

Allows the user to use the Fix Unassigned Badges utility. 
For more information on this feature, see Fix Unassigned Badges.  

Allows the employee to repost R-files (polled clock data) to the TA100 Pro 
database. 
For more information on this feature, see Repost R-Files.  

Allows the employee to delete old R-files (polled clock data) from the TA100 
Pro directory. 
For more information on this feature, see Purge R-Files. 

Allows the employee to Backup the TA100 Pro database. 
For more information on these features, see System Backup. 

Allows the employee to Restore the TA100 Pro database from the backup. 

This section defines the user's access rights to the other items in the File 
menu'. 

Import Allows the employee to import data from external files. 

Export Allows the employee to export data from TA100 Pro to an external file. 

Print Setup Allows the employee access to the print setup information from the File menu. 
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The Daily Operations tab grants access to features under the Daily Operations menu and contains 
the following information: 

Configuration

Setting Defintion

Approval Editor

Employee

Details (w/o Add, 
Edit, Delete) 

Timecard

Approve 
Timecard 

Defines the user's access rights to the Approval Editor. The options are View 
and Edit.  
For more information on this feature, see Approval Editor. 

Defines the user's access rights to the Configure Employee section. The 
options are View, Add, Edit and/or Delete and will allow the user access to 
employee records.  If Add, Edit and Delete are turned off the Detail Tab is 
also off. 
For more information on this feature, see Employee Maintenance. 

Defines the user’s access to the Details tab of the Configure Employee 
section.  This is a view only feature, unless Add, Edit and Delete have been 
activated in the above 
(Employee) section. 

Defines the user's access rights to the Timecard tab of the Configure 
Employee section. The options are View, Add, Edit and/or Delete and will 
allow the user access to employee time sheet data.  
For more information on this feature, see Employee Timecard

Defines the user’s access to approve timecards in the Timecard tab of the 
Configure Employee section. 
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Setting Defintion

Approval Editor

Allow Schedule 
Override 

Messages 

Wages 

Transactions 

Status

Benefits

Badges 

Clocks

Status Board

Task Organizer 

Defines the user's access rights to the Schedule tab of the Configure 
Employee section. The options are View, Edit, and Delete and will allow the 
user access to the employee's schedule.  
For more information on this feature, see Employee Schedule. 

Defines the user’s access to create new shifts as a shift override on the 
Schedule tab of the Configure Employee section. 

Defines the user's access rights to the Transactions tab of the Configure 
Employee section. The options are View, Add, Edit and/or Delete and will 
allow the user access to employee transaction (punch) data.  
For more information on this feature, see Employee Transactions. 

Defines the user's access rights to the Status tab of the Configure Employee 
section. The options are View, Add, Edit and/or Delete.  
For more information on this feature, see Employee Status. 

Defines the user's access rights to the Benefits tab of the Configure 
Employee section. The options are View and Edit and allow the user access 
to the employee's benefits entitlement information.  
For more information on this feature, see Employee Benefits. 

Defines the user's access rights to the Messages tab of the Configure 
Employee section. The options are View, Add, Edit and/or Delete.  
For more information on this feature, see Employee Messages. 

Defines the user's access rights to the Wages tab of the Configure 
Employee section. The options are View and Edit and will allow the user 
access to employee pay rate information.  
For more information on this feature, see Employee Wages. 

Defines the user's access rights to the Badges tab of the Configure 
Employee section. The options are View, Add, Edit and/or Delete.  
For more information on this feature, see Employee Badges. 

Defines the user’s access rights to the Clocks tab of the Configure 
Employee section.  The options are View, Add, Edit and/or Delete. 
For more information on this feature, see Employee Clocks.  

Allows the user to view the Status Board screen. 
For more information on this feature, see Status Board. 

Allows the user to view the Task Organizer screen. 
For more information on this feature, see Task Organizer. 
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The Reports tab grants access to features under the Reports menu and contains the following 
information: 

Configuration
Setting Defintion

Global

Benefits Accruals

Allows the user access to the File, Global menu, from which he/she can 
perform global functions. 
For more information on this feature, see Global Commands.  

Allows the user to access the File, Benefits Accruals menu. (Benefits 
Accruals are an optional feature and therefore may not be available here.)  
The options are View, Add, Edit and/or Delete.  
For more information on this feature, see Benefits Accruals.

Setting Defintion

Period Reports 

Weekly Reports

Daily Reports

Payroll Export Grants access to run the Payroll Export. 

Listings Grants access to the reports in the Listings category. 
For more information see Listings.

Grants access to the reports such as Timecards, Who’s Scheduled, 
Coverage, etc.

Grants access to the reports such as Weekly Hours, Attendance, 
Approaching Overtime, etc. 

Grants access to the reports such as Who’s in, Who’s not in, Daily Hours, etc.  
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The System Setup tab grants access to features under the System Setup menu and contains the 
following information: 

Configuration

Setting Defintion

Main Company 

Divisions

Holidays

Categories

Policies

Shifts

Defines the user's access rights to the Main Company settings. The only 
option is Edit.  
For more information on this feature, see Main Company
Defines the user's access rights to Divisions settings. The options are 
View, Add, Edit and Delete.  
For more information on this feature, see Divisions. 
Defines the user's access rights to Categories settings. The options are 
View, Add, Edit and Delete.  
For more information on this feature, see Categories.  
Defines the user's access rights to Policies settings. The options are View, 
Add, Edit and Delete.  
For more information on this feature, see Policies. 
Defines the user's access rights to Shifts settings. The options are View, 
Add, Edit and Delete.  
For more information on this feature, see Shifts. 
Defines the user's access rights to Holidays settings. The options are View, 
Add, Edit and Delete.  
For more information on this feature, see Holidays. 
Defines the user's access rights to Groups settings. The options are View, 
Add, Edit and Delete.  
For more information on this feature, see Group

Groups
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Setting Defintion

Department 

Job

Bell Schedules

Defines the user's access rights to Department settings. The options are 
View, Add, Edit and Delete. 
For more information on this feature, see Departments. 
Defines the user's access rights to Job settings. The options are View, 
Add, Edit and Delete.  
For more information on this feature, see Configure Jobs.
Defines the user's access rights to Bell Schedule settings. The options are 
View, Add, Edit and Delete.  
For more information on this feature, see Bell Schedules. 

The Communication tab grants access to features under the Communications  menu and contains the 
following information: 

Setting Defintion

Poll 

Change Selections

Options

This section defines the user's access rights to Poll hardware clocks. 

Allows the user to start the process of polling clocks. 
For more information on this feature, see Polling.

Start 

Allows the user to manually change the times at which the clocks poll. 
For more information on this feature, see Polling.

Allows the user to change the settings in the Poll Clock Selection dialog 
box. For more information on this feature, see Polling. 
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Setting Defintion

Schedule

Start

Configure

Set Date and Time

AutoProcess This section defines the user's access rights to configure Auto Processes. 
For more information on this feature, see Chapter XII—Configure an 
AutoProcess. 
Defines the user's access rights to Schedule AutoProcess settings. The 
options are View, Add, Edit and Delete.  
For more information on this feature, see Chapter XII—Configure an 
AutoProcess. 
Allows the user to start a pre-defined AutoProcess. 
For more information on this feature, see Chapter XII—Configure an 
AutoProcess.
Defines the user's access rights to clock configuration settings. The options 
are View, Add, Edit and Delete.  
For more information on this feature, see Chapter XI—Terminal 
Configuration. 

Allows the user to set the date and time of the clocks. 

Add a Security Level 

Click the File menu, Security, Define Levels. The Configure Security Level dialog box will open. 
Click the Add button to add a new Security Level. The tabs will become available. 
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Click OK to confirm the deletion. 
Click Close to exit the Configure Security Levels dialog box. 

Fill in the settings as described in the Configuring Security Levels section. 
Click OK to commit the changes and close the Security Level dialog box. 
Click Close to exit the Configure Security Level dialog box. 

Edit a Security Level 

Click the File menu, Security, Define Levels. The Configure Security Levels dialog box will open. 
Highlight the Security Level you wish to edit from the list at the side of the screen.
Click the Edit button. The tabs will become available for you to edit the selected Security Level.

NOTE: You cannot edit the Code field.

Edit the settings as described in the Configure Security Level section. 
Click OK to commit the changes and return to the Configure Security Level screen. 
Click Close to exit the Configure Security Level dialog box. 

Delete a Security Level 

Click the File menu, Security, Define Levels. The Configure Security Levels dialog box will open. 
Highlight the Security Level you wish to delete from the list at the side of the screen. 
Click the Delete button. You will be prompted: 
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User Maintenance 

User Maintenance defines the users that can log in to TA100 Pro, which employees they can 
manage, and which areas of the program they can use. The user is given a login Id and password, is 
assigned a Security Level, and granted permission to select groups of employees. 

NOTE:  Define Levels must be completed before adding any users. 

Configure Users 
Click the File menu, Security, User Maintenance. The Configure Users window will open.

The Configure Users dialog box contains several tabs, each of which is described below. The Users 
tab contains the following information: 

Configuration
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Setting Defintion

Supervisor Badge

Security Level

Start In 

Password

Active

Last

Color Quality

Email 

Display Name

E-mail Address

Enter the display name. 

Startup

This field is required. Enter a unique Login ID for this user, up to 9 
alphanumeric characters. This code will be entered into the User ID field in 
the login window when this user logs in. Once saved, the Login name cannot 
be changed. 
When you press Tab or Enter after entering this field, the Password entry 
dialog box will appear automatically. 

Enter the badge number assigned to this user. For audit purposes, this badge 
number is recorded when this user adds or edits transactions. 

Login 

This field is required. Enter a password, up to 9 alphanumeric characters, to 
be used with the User ID above. Type the password again to confirm it. 

Click the Active check box to indicate that the Login ID is active. Uncheck 
this box if the Login is not being used at this time. 

Enter the last name of this User. 

First Enter the first name of this User. 

Select the pre-defined Security Level for this user. 
For more information on setting up Security Levels, see Configure Security 
Levels, page 86. 

This section determines the settings that apply when TA100 Pro starts up. 

Select the screen that should open automatically when TA100 Pro starts. 
The options are Main Menu, Approval Editor, Employee (Configure 
Employee, Task Organizer and Status Board. 

Select the set of icons you want displayed in TA100 Pro.  The options are 
High Quality and Low Quality.  High Quality displays the newest icons and 
Low Quality keeps the old icons. 

Enter this user's email address. This can be used to send Auto Processed 
reports to the user whenever they're ready. 
NOTE:  This option will only be available if you have activated the SMTP 
feature. 

SMTP Server Enter the SMTP server name. 

Enter the e-mail address. 

Outgoing Security Enter this information for email authentication. 

User Name Enter the user name. 

Password Enter the password. 

108



The Divisions tab specifies the Divisions to which this user can view and contains the following 
information: 

Configuration

Setting Defintion

Add/Add All

List

Remove/Remove All 

Select Determines what options are available in the bottom part of the screen. The 
options are All, Range, and List. 
All automatically grants access to all Divisions. 
Range allows you to choose a range of Divisions for access. 
List allows you to choose individual Divisions for access. 

When List is selected, a list of all the Divisions in your company will appear 
based on what was selected above.  The list option is a ‘from – to’ selection, 
the ones in between are also selected. 

Add adds the currently selected Division to the Selected list. Add All adds all 
of the Divisions to the Selected list.

Remove removes the currently selected Division from the Selected list. 
Remove All removes all of the Divisions from the Selected list.  
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The Groups tab specifies the Groups which this user can view and contains the following information: 

Configuration

Setting Defintion

Add/Add All

List

Remove/Remove All 

Select Determines what options are available in the bottom part of the screen. The 
options are All, Range, and List. 
All automatically grants access to all Divisions. 
Range allows you to choose a range of Divisions for access. 
List allows you to choose individual Divisions for access. 

When List is selected, a list of all the Divisions in your company will appear 
based on what was selected above.  The list option is a ‘from – to’ selection, 
the ones in between are also selected. 

Add adds the currently selected Division to the Selected list. Add All adds all 
of the Divisions to the Selected list.

Remove removes the currently selected Division from the Selected list. 
Remove All removes all of the Divisions from the Selected list.  
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Add a User 

Click the File menu, Security, User Maintenance. The Configure Users dialog box will open.
Click the Add button to add a new User. The User tab will become available.

Fill in the settings as described in the Configure Users section. 
Click Apply to commit the changes.  
Click on the Divisions tab. 
Click Apply to commit the changes. 
Click on the Groups tab. 
Click OK. 
Click Close to exit the Configure Users dialog box. 

Edit a User 

Click the File menu, Security, User Maintenance. The Configure Users dialog box will open.  
Highlight the User you wish to edit from the list. 
Click the Edit button. The tabs will become available for you to edit. 

NOTE: The Login field cannot be edited. 

Edit the settings as described in the Configure User section. 
Click OK to commit the changes and return to the Configure User screen. 
Click Close to exit the Configure User dialog box. 

Configuration
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Delete a User 

Click the File menu, Security, User Maintenance. The Configure Users dialog box will open. 
Highlight the User you wish to delete from the list. 
Click the Delete button. You will be prompted:

Click OK to confirm the deletion. 
Click Close to exit the Configure Users dialog box. 

Who's Logged In 
The Who's Logged In screen displays the Login and name of all the users currently logged in to 
TA100 Pro.  Refresh button is also available to update the screen. 

Click the File menu, Security, Who's Logged In. The Who's Logged In screen will open.  
You may also print login activity by clicking Print.

Configuration
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Change Password 
The Change Password function changes the password of the user currently logged in. 

Click the File menu, Security, Change Password. The Change Password input box will open.
Enter your old password. 
Enter your new password. Type the password again to confirm it.

Benefit Accruals 
Using Benefit Accruals, TA100 Pro can automatically calculate the available benefit time for your 
employees. These calculations are based upon rules that can account for different benefit types 
(vacation, sick, personal, etc., different accrual methods, seniority rules and other factors. Benefit 
time taken is automatically subtracted from the available benefits so that balances are always 
accurate. 

TA100 Pro allows for an unlimited number of policies so that you can accommodate different 
situations within your company. Each policy contains accumulators that specify the category 
amounts and rules for earning benefits. 

After the policies are created, they are assigned to the appropriate employees within the company. 

NOTE: Benefit Accruals is an additional module added into TA100 Pro. If you did not purchase 
Benefit Accruals, you will have Benefit Entitlement instead. See Benefit Entitlement: Configure.

There are two commands within the Benefit Accruals menu. Both are described below. 
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Configure Benefit Accruals 

Click the Daily Operations menu, Benefit Accruals, Configure. The Configure Benefit Accrual window 
will open.

Configuration
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The Configure Benefit Accrual dialog box contains the following information: 

Setting Defintion

Code

Reference Date

Name 

Active

Start Date 

Overtime 1

Overtime 2 

Code

Code 

Indicates the date on which this policy became effective. 

Indicates the date on which the yearly benefits reset (previous balance zero 
out or roll forward, and the employee starts earning a new year's benefits.)  

Indicates the categories that will be considered when calculating benefits 
based on hours worked and/or paid. Click the category to select it. A 
checkmark displays next to categories when they are selected. 

This is a required field. Enter the code or number you wish to use to refer to 
this Benefit Accrual policy. You may enter up to 3 characters. 

This is a required field. Enter the name you wish to use to refer to this 
Benefit Accrual policy. You may enter up to 30 characters. 

Click the Active check box to indicate that the policy is currently in use. 
Uncheck this box if the policy is not being used at this time. 

Name 

Accumulators Lists the accumulators that make up this Benefit Accrual policy.   

Posting Basis

Indicates the unique number assigned to the selected accumulator. 

Indicates the frequency with which benefits are posted in this accumulator. 

Categories to Sum

Displays the code for the Category. 

Displays the name of the Category.

Regular Check this box to indicate that regular hours of the selected category(s) 
should be considered when calculating benefits. 

Check this box to indicate that overtime hours of the selected category(s) 
should be considered when calculating benefits. 

Check this box to indicate that overtime 2 hours of the selected category(s) 
should be considered when calculating benefits. 

Overtime 3 Check this box to indicate that overtime 3 hours of the selected category(s) 
should be considered when calculating benefits.  
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Configure Benefit Accumulators 

Accumulators specify the categories that will be granted by the policy, as well as the amounts 
granted and method of accrual. You can have multiple accumulators within one policy. 

While adding or editing a Benefit Accrual, click the Add or Edit button in the center of the screen to 
display the Accumulators dialog box.

Configuration
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Configuration

The Accumulators dialog box contains the following information: 

Setting Defintion

Do Not Give Hours if 
Employee Status is 
Inactive  

Start Date

Accumulator 
Details

Month 

Accumulator 

This setting enables you to grant a lump sum benefit a certain number of 
months from the employees hire date. For example, "Give 40 hours after 6 
months from hire date" to automatically give an employee a week's vacation 
on his/her six-month anniversary. 

This is a required field. Enter the number of months of service after which 
this rule takes effect. To have the rule start immediately, select 0.  Works in 
conjunction with the years.  

Posting Basis 

categories that have been selected for benefit entitlement will display in 
this drop-down box. 

Reference Date Pick the date for the policy to take effect. Pick a date in the past so that the 
defined rules can be met for all current employees. This date indicates the 
rollover or reset date for employee benefits. The options are:    
Hire: this benefit resets on the employee's individual hire date (set in 
Employee Maintenance).
Fiscal: this benefit resets on the employee's individual fiscal date (set in 
Employee Maintenance).
Other: this benefit resets on this date for all employees. For example, 
January 1.

Give XX after X 
Months From Hire

This setting will not grant employee hours if the employee status is 
inactive. 

Year

This section displays the details for accumulating or accruing the category 
selected. There can be multiple accumulator details for one category.  
The Accumulator section displays the rules for details already added. To 
display the entry screen for an Accumulator, click the Add button. 

Select how often you want benefits to be posted. 
The options are;
 Weekly, Biweekly, Semimonthly, Monthly, Annually and Daily

The benefits are posted at the end of the posting period. 

This is a required field. Enter the number of years of service after which this 
rule takes effect. To have the rule start immediately, select 0.  Works in 
conjunction with the months.
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Configuration

Setting Defintion

Maximum Hours 
Allowed  

Hours from 
Categories to 
Sum X 

Maximum 
Annual Carry 
Over  

One Time 

Enter the minimum hours required to be worked in the Posting Basis period 
for the employee to be eligible for any benefits accrual. 
For example, this could be used to pay benefits only if the employee works 
more than 30 hours per week. 

Straight Given 
Hours (At End)

This setting allows you to grant a one-time benefit of this category. This field 
is optional. 
For example, you might want to give a 
"length of service" bonus of 40 hours on the employee's anniversary, in 
addition to their regular accruals. This benefit occurs only once: it does not 
recur each year.  

This setting allows you to enter a set number of hours granted at the end of 
the Posting Basis period (weekly, biweekly, etc.) This field is optional. 
For example, to grant 8 hours of time per month, you would choose Monthly 
for the Posting Basis and enter 8 in this box. 

Minimum Hours 
Needed 

Enter the maximum hours that can be accumulated for this category during 
the Posting Basis period. This is used to keep employees who work lots of 
hours from accruing more benefits than they are entitled to. 

Maximum Total 
Benefit Hours 

This setting allows you to enter the fraction of benefits earned for hours 
worked and/or paid. TA100 Pro will calculate the number of hours paid of 
the categories selected in the Categories to Sum section of the Benefit 
Accrual dialog box. It will multiply the number of hours paid by the number 
entered here to calculate the available benefits, as follows: 
Category Hours X Factor = Accrued Benefit 

Enter the number of hours the employee can carry forward into the next 
benefit year (on the Reference Date). For no carry over ("use it or lose it"), 
enter 0. 

Enter the maximum number of hours the employee is allowed to accrue 
during the benefit year. 
For example, this could be used to "cap" accruals at a maximum amount.
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Add a Benefit Accruals Policy 

Click the Daily Operations menu, Benefit Accruals, Configure. The Configure Benefit Accrual dialog box 
will open.
Click the Add button to add a new Benefit Accruals policy. The General tab will become available.

Fill in the Code and Name fields as described in the Configuring Benefit Accruals section. 
Click the Add button to display the Accumulator dialog box. 

Configuration
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Fill in the settings as described in the Configure Benefit Accumulators section. 
Click the Add button to display the Accumulator Details dialog box. 
Fill in the Accumulator Detail settings as described in the Configure Benefit Accumulators section. 
Click OK to accept the details and return to the Accumulator screen. 
Repeat steps 0 through 0 for each unique accumulator details needed. 
Click OK to accept the Accumulator and return to the Benefit Accruals screen. 
Repeat steps 0 through 0 for each unique Accumulator (Category) needed. 
Click OK to commit the changes and close the Configure Benefit Accruals dialog box. 
Click Close to exit the Configure Benefit Accruals dialog box. 

Configuration

Edit a Benefit Accruals Policy 
Click the Daily Operations menu, Benefit Accruals, Configure. The Configure Benefit Accrual 
dialog box will open.
Highlight the Benefit Accrual policy you wish to edit from the list at the side of the screen. 
Click the Edit button. The General screen will become available for you to edit the selected 
Benefit Accrual policy. 
Edit the settings as described in the Configure Benefit Accruals section. 
Once you are editing the Benefit Accrual, you can further edit the Accumulator and Accumulator 
Details. 
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Configuration

To edit the Accumulator, click the Edit button in the Accumulator section in the center of the screen. 
To edit the Accumulator Details, first click the Edit button on the Benefit Accrual screen, then click 
the Edit button in the Accumulator screen. 
Click OK as many times as necessary to commit the changes and return to the Configure Benefit 
Accrual screen. 
Click Close to exit the Configure Benefit Accrual dialog box. 

To edit the Accumulator, click the Edit button in the Accumulator section in the center of the screen. 
To edit the Accumulator Details, first click the Edit button on the Benefit Accrual screen, then click 
the Edit button in the Accumulator screen. 
Click OK as many times as necessary to commit the changes and return to the Configure Benefit 
Accrual screen. 
Click Close to exit the Configure Benefit Accrual dialog box. 

Delete a Benefit  Accruals Policy 
Benefit Accruals that are in use cannot be deleted. 

Click the Daily Operations menu, Benefit Accruals. The Configure Benefit Accruals dialog box will 
open. Highlight the Benefit Accruals policy you wish to delete from the list at the side of the 
screen. 
Click the Delete  button. You will be prompted: 

Click OK to confirm the deletion. 
Click Close to exit the Configure Benefit Accruals dialog box. 
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Configuration

Update to Current 
This command causes TA100 Pro to calculate all employees' benefit accruals up to the current date. 

Click the Daily Operations menu, Benefit Accruals, Update to Current.
TA100 Pro will automatically update employee benefits.
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This section reviews the optional modules that are available with TA100 Pro. This section 
includes the following: 

• Bell Schedules

• Benefits Accruals

• PC Clock

• Third Party Terminals

Optional Modules
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PC Clock 
PC Clock is an optional module that may be installed on anyone’s workstation and allows employees 
to clock in and out for the day, to and from lunch, and to and from breaks from their workstation. 
Employees may also use PC Clock to transfer departments and change their own passwords.  PC 
Clock makes it easy to gather time from thousands of users in every corner of your enterprise, either 
across the building or across the country. PC Time Clock is perfect in situations where hardware 
data collection systems can't be cost-justified, or where hardware time clocks don't match into 
your organization's environment.  For more information, see PC Clock. 

Third Party Terminals 
Third Party Terminals is an optional module that allows the use of Biometric Hand Readers, 
ATS series clocks, and biometric fingerprint readers.  For more information see, Hand Readers, 
and see ATS. 



Additional Employee Features 

This  section  reviews  how  to use the  additional  Employee  Feature  of  the  PC Clock,  which 
is available  with the TA100 Pro.  

PC Clock 
PC Clock is an application that allows employees to punch In and Out, punch for Lunches and 
Breaks, and Transfer Departments from their PC.  PC Clock offers employees access to several 
useful tools in an easy to use environment.  Each task employees can perform with PC Clock is 
one or two mouse clicks away.   
NOTE:  It is recommended that a facilitator go over the information available in this chapter with 
employees.

Accessing PC Clock 
Click the Start menu, Programs, TA100 Pro, and PC Clock

Default Settings to Use PC Clock 
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The PC Clock window contains the following information:

Additional Employee Features 

Default Clock In 

Navigate to PC Clock. 
Enter Badge number. 
Click the Enter key. 
Click the In key. 
Click OK to confirm transaction. 

Function Keys

PC Clock Screen Displays the date and time, and what information PC Clock is prompting you 
for.

Displays the number keys and the prompts that they will ask for.

“1” Key Click this key to enter the Job transfer.

“2” Key This key is undefined. 

“3” Key This key is undefined.

“5” Key

“6” Key

Click this key to report Cash Tips.

“4” Key Click this key to punch Out for Lunch.

Click this key to punch In from Lunch.

“7” Key Click this key to punch Out for Break. 

“8” Key This key is undefined.

“9” Key Click this key to punch In from Break.

Setting Defintion

In Key Click this key to punch In.

“0” Key

Out Key

Click this key to enter the Department transfer.

Click this key to punch Out.

Clear Key Click this key to Clear the transaction. 

Back Key Click this key to backspace one character.

Enter Key Confirms an entry.

Close Button Click this button Close PC Clock.
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Default Clock Out 

Navigate to PC Clock.
Enter Badge number. Click the 
Enter key. Click the Out key. 
Click OK to confirm transaction.

Default Clock Out for Lunch 
Navigate to PC Clock. 
Enter Badge number. 
Click the Enter key. 
Click the “4” key. 
Click the Enter key. 
Click OK to confirm transaction. 

Default Clock In from Lunch 

Navigate to PC Clock. 
Enter Badge number. 
Click the Enter key. 
Click the “6” key. 
Click OK to confirm transaction. 

Default Transfer Department 
Navigate to PC Clock. 
Enter Badge number. 
Click the Enter key. 
Click the “0” key. 
Enter the Department number 
Click the Enter key. 
Click OK to confirm transaction. 

Additional Employee Features 
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This section covers  the concepts and  tasks for managing employee information. It 
includes information on adding employees, editing employee information,  and managing 
employee schedules and assignments.  It also contains links to the Timecard editing 
sections of  this manual. 

Configure Employee 
The Configure Employee window contains all information relating to your employees, including 
contact, schedule, and time sheet data. All of the tabs in the window are described in this 
chapter, however, some of the tabs (such as the Timecard and Transactions have additional 
tasks associated with them and have been given their own sections in this manual.  

There are two ways to access the Configure Employee window: by menu or by tool button. Both 
methods are described below.  

           on the toolbar. Click the Daily Operations menu, Employee or click the Maintenance button 
The Configure Employee window will open.

Employee Maintenance
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Employee List 
The Employee List window contains a list of the employees in the database.   
Sorting options are also available as described below:  

Employee Maintenance

Setting Defintion

Show Inactives

Selected Employee 

Find button

Next button

Displays the employee name and number of the selected employee. 

Filters Show Division Selection:  Select a Division to only view employees assigned 
to that Division 
Show Group Selection:  Select a Group to only view employees assigned to 
that Group. 
Show Salary Selection:  Select ALL, YES or NO to view employees assigned 
to that option. 
Show Fulltime Selection:  Select ALL, YES or NO to view employees assigned 
to that option. 
Show Permanent Selection:  Select ALL, YES or NO to view employees 
assigned to that option. 

Previous button Press this button to go to an individual who is previous on the list. 
Press this button to search for a name by code, last name or badge number. 
Enter in the appropriate name, code or badge number when the dialog box 
appears. 

Number

Press this button to go to an individual who is next on the list. 

Select this option to have the employees sort by employee number. 

Name Select this option to have the employees sort by employee name. 

Select this option to have inactive employees viewable in the Employee List 
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Employee Timecard (Description) Tab 
The Timecard tab displays the employee's timesheet information. 
NOTE: Tasks associated with the Timecard, such as editing and adding punches, are covered in 
their own chapter. See Timecard and Transaction Maintenance 

Navigate to the Configure Employee window.
When you first enter the Configure Employee window, the Timecard tab is selected automatically 
and contains the following information: 

Employee Maintenance
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Employee Maintenance
Setting Defintion

Department

Reg.

Attendance Code 

Date

Cat

This field is not labeled. It displays a code to indicate an exception regarding 
the entry. The options are: 
A: Indicates a system-generated absence. This entry will display in Red.
M: Indicates a missing punch. This entry will display in purple.
I: Indicates a work period In Progress. This entry will display in green.
D: Indicates a default work entry was added when the employee missed a 
punch (as defined in the Policy associated with this employee.)
F: Indicates that the entry was created when TA100 Pro forecasted the 
employee's hours. Time forecasting will display future time transactions 
(based on the employee’s current schedule) on screen and in reports.
S: Indicates TA100 Pro has automatically created a Holiday entry. This entry 
will display in black.

Day

Displays the date of the entry.  

Stop

Start

OT1 

Displays a three-character code for the day of the week of the entry. 

Displays the category associated with the entry (i.e., Work, Lunch, Break, 
Vacation, Sick, Absent, etc.)

Displays the start time of the entry (i.e., the time at which the employee 
clocked in for the day, started lunch, etc.). If you double click on the start 
header text timecard will display rounded times.

Displays the stop time of the entry (i.e., the time at which the employee 
clocked out for the day, ended lunch, etc.).  If you double click on the stop 
header text timecard will display rounded times.   

By default, this field displays the Department the employee worked in. By 
clicking the Department button in the field header, you can choose to 
display the Job (if applicable). Each time you click the button; it will toggle 
back and forth between the Department and Job.  

Displays the number of hours at straight time the employee will be paid for 
this entry. This number is calculated using the Start and Stop times, adjusted 
according to the Rounding, Lunch and Break policies defined in the Shift 
Group assigned to this employee.

Displays the number of hours at OT1 the employee will be paid for this entry, 
if any. This number is calculated using the Start and Stop times, adjusted 
according to the Rounding, Lunch and Break rules defined in the Shift Group 
assigned to this employee, as well as the Overtime rules defined in the Policy 
assigned to this employee.  
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Employee Maintenance

Setting Defintion

Show Schedule 

Forecasting 

Pay Periods 
Back 

OT2 

Unpaid

S

Dollars

Approve / 
Unapprove Button

Auto Processing 

Displays the amount earned for this entry. 

OT3

Displays the number of hours at OT2 the employee will be paid for this entry, 
if any. This number is calculated using the Start and Stop times, adjusted 
according to the Rounding, Lunch and Break rules defined in the Shift Group 
assigned to this employee, as well as the Overtime rules defined in the 
Policy assigned to this employee. 

Displays the number of hours at OT3 the employee will be paid for this entry, 
if any. This number is calculated using the Start and Stop times, adjusted 
according to the Rounding, Lunch and Break rules defined in the Shift Group 
assigned to this employee, as well as the Overtime rules defined in the 
Policy assigned to this employee. 

Displays the number of unpaid hours for this entry, if any. Unpaid lunches 
and breaks will be reflected in this column, if appropriate.   

Displays a dot if a Supervisor has gone in to edit the punch. 

Check this box to automatically process time transactions whenever they 
are added or edited. Processing posts new and changed transactions to the 
database and allows them to be displayed on all reports. If this box is clear, 
you must click the Reprocess button each time you want to update employee 
transactions.

Depress this button to approve or unapprove the selected pay period for the 
selected employee. 

Check this box to display the employee’s scheduled start and stop times on 
screen. This can be used to help with editing when there is an absence or 
missing punch. 

Check this box to generate projected time transactions. Time forecasting 
will display future time transactions (based on the employee’s current 
schedule) on screen and in reports.

Click the scroll arrow and choose the number of pay periods prior to the 
current one you wish to view. 
NOTE: Although you may view prior pay periods, only editable pay periods 
may be changed. This is determined by the Number of Editable Pay Periods 
in Configure Main Company dialog box, and the Block Prior Pay Periods 
setting for the current user.  
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Employee Maintenance

Setting Defintion

Delete 

Pay Period

Reprocess

From Schedule

Displays the starting date and the ending date of the currently selected pay 
period. 

Add Trans

Multiple Misc.

Edit/Add Start 

Totals The Totals column displays the totals for the currently selected pay period.

Click this button to update employee transactions. Processing posts new 
and changed transactions to the database and allows them to be displayed 
on all reports.  
NOTE: If Auto Processing is checked, you will not need to use this button 
each time a transaction is changed. 

Click this button to add a transaction (punch) for the employee. For more 
information on this feature, see Adding and Editing Transactions 

Click this button to add or edit a Starting transaction (such as a Clock In for 
day or Start Lunch) for the employee. For more information on this feature, 
see Edit/Add Start. 

Click this button to add or edit an Ending transaction (such as a Clock Out for 
day or End Lunch) for the employee. For more information on this feature, 
see Edit/Add Stop.  

Click this button to add multiple or duplicated Miscellaneous transactions. 
This can be used to enter a vacation that lasts several days, etc. For more 
information on this feature, see Multiple Miscellaneous. 

Click this button to auto-fill a work day based on the employee's schedule. 
For more information on this feature, see From Schedule. 

Click this button to delete a transaction. For more information on this 
feature, see Delete a Transaction. 

Displays the attendance codes which show in the first column.Key

Displays totals for each day in the pay period. Displays Totals for 
Each Day in 
Selected Week

Edit/Add Stop 
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Employee Schedule Tab 
The Schedule tab displays and allows you to edit the employee's schedule. 

NOTE:  Employees are not required to have a specific schedule, but without a schedule the 
following items will not work in the system: 

• Rounding Rules
• Automatic Lunch and Break Deductions
• Exceptions

Configure Employee Schedules 

Navigate to the Configure Employee window. See Configure Employee. 
Click the Schedule tab to select. The tab contains the following information:

Employee Maintenance
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Employee Maintenance

Shift

Update Back

Override

Template

Date Displays the date. 

Displays the Shift selected for that particular day.  
NOTE:  Before a shift is assigned the system will default the shift assignment 
to a floater shift. 

Department Displays the Department number for that particular day.

Job Displays the Job number for that particular day. 

Work Check this box to indicates whether or not the employee is scheduled to 
work that day, and how many paid hours are forecasted.

Enter the start and stop schedule change time for rounding rule purposes 
only.

Check this box to make this employee's schedule a template. This will 
enable you to copy this employee's schedule for other employees. For more 
information on this feature, see Create an Employee Schedule Template.

Check this box to update previous weeks' schedule data. Also enter the date 
to which you wish to update. For more information on this feature, see 
Assign or Edit an Employee Schedule.  

Setting Defintion

Calendar The calendar will display three weeks at a time. The currently selected 
week will display in white, the previous and following week display in 
yellow. The current week will also have a field where you can edit the entire 
week.  For more information on this feature, see the Edit Entire Week 
section. 
The Schedule calendar can display either work Shift information, or Job 
Costing information (which Job, Step, Operation, and Task the employee is 
scheduled to work). You can switch back and forth easily. For more 
information on this feature, see the Schedule Details section. 
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Employee Maintenance

Update Forward 

Copy Button

Rotate Button 

Delete

Multiple 
Misc. Button 

Check this box to update following weeks' schedule data. Also enter the 
date to which you wish to update. For more information on this feature, 
see Assign or Edit an Employee Schedule. 

Check this box to update following weeks' schedule data. Also enter the 
date to which you wish to update. For more information on this feature, 
see Assign or Edit an Employee Schedule. 

Click this button define a rotating schedule for this employee. For more 
information on this feature, see Create a Rotating Schedule. 

Click this button to add multiple or duplicated Miscellaneous transactions.  
This can be used to enter a vacation that lasts several days, see Multiple 
Miscellaneous. 

This option opens the Delete Assignments screen. Here you can remove 
assignments, All Before a Date or All After a Date.  

Setting Defintion

Assign or Edit an Employee Schedule 
The processes for assigning a schedule for the first time and for editing the schedule assignment 
are the same. As part of this process, you will select a Shift, Department, Job, Step, Operation, and 
Task (as appropriate) for the employee. 

Navigate to the Schedule tab of the Configure Employee window. See Configure Employee 
Schedules.

Navigate to the week you wish the schedule to start by using the scroll bar on the right side of the 
screen. 
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If you clicked Edit Entire Week, the Schedules Detail for the Week dialog box will open. 
If you clicked in the Shift area, the Schedule Details dialog box will open. 

Employee Maintenance
Click Edit Entire Week and/or Shift area on Sunday of the selected week. 

Edit Entire Week 

Shift area 
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Click OK to commit the changes and return to the Schedule screen. The Shift and Department 
information selected will display. 

NOTE: TA100 Pro automatically keeps the schedule current for three months into the future, so you 
needn't update manually unless you are making a change that should apply to dates that have 
already been updated. 

Check the Work box of each day of the week the employee is scheduled to work. 

If you are editing the schedule and wish these changes to apply into the future, click the Update 
Forward box or Update Back box.   

Click Apply to save the changes and update Forward (if selected for editing). 

Employee Maintenance

Highlight from the settings as appropriate: 

Start/Stop 
Override

Shift

Enter the start and stop schedule change time for rounding rule purposes 
only. 

Graphic 
Override 

Use the graphic timeline to define the start and stop schedule change time 
for rounding rule purposes only.

Work Check this box to indicate whether or not the employee is scheduled to work 
that day, and how many paid hours are forecasted. 

Department 

Job

Select a pre-defined Department for this employee. (Optional) 

Select a pre-defined Job for this employee. (Optional)

Update Rest of 
Week

Check this box to update the rest of the current week with these settings. 
(Recommended)  

Setting Defintion

Select a pre-defined Shift for this employee. 
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Click OK to confirm the deletion. 

Employee Maintenance

Delete a Schedule 
Navigate to the Schedule tab of the Configure Employee window. See Configure Employee 
Schedules.
Click the Delete button. You will be prompted: 

Fill in the settings as appropriate: 

Click OK. You will be prompted again: 

All After Date

All Before Date

Select this option to delete schedules occurring after a certain date. 

Date Enter the date to consider when deleting the schedules. 

Setting Defintion

Select this option to delete schedules leading up to a certain date. 
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Employee Maintenance
Create a Rotating Schedule 

Rotating schedules allow you to accommodate employees who work schedules that have a 
pattern other than a weekly cycle. You can specify the number of days in the rotation and what 
time period the rotation begins. 

Rotating Schedule Example 

Jane Doe works every other Saturday. She happens to work this coming Saturday, and will be off 
the next Saturday.  

To configure this you would modify her schedule so that Work is checked for this Saturday, but not 
the next Saturday. The Start Date for the Rotation would be the beginning of the current week, and 
the number of days in the cycle would be 14. 

Navigate to the Schedule tab of the Configure Employee window. See Configure Employee 
Schedules.
Click the Rotate button. The Apply Rotating Schedule dialog box will open. 
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Employee Maintenance
Fill in the settings as appropriate: 

Setting Defintion

Activate a Rotating 
Schedule for This 
Employee

Days in Rotation

Check this box to enable a rotating schedule for the selected employee. 
TIP: You can "remove" a rotating schedule that has already been set simply 
by un-checking this box. 

Start Date  Enter the date TA100 Pro should start with to determine the rotation pattern. 

Apply Rotation

These settings define the pattern for rotation Define Rotation

 Enter the number of days in the rotation pattern. 

These settings determine when the rotating schedule will take effect. 

Start Date Enter the date on which the rotating schedule should take effect. 

Click OK to commit the changes and return to the Schedule screen.

Create an Employee Schedule Template 

An employee's schedule can be saved as template so that it can be copied to other employees. This 
is a convenient way of duplicating an unusual work pattern or rotation so that you don't have to 
reinvent the wheel each time.   

NOTE:  However, any changes that are made to the schedule that was copied will apply to all 
schedules that are base on that template. 

The Copy Schedule feature allows you to copy a previously defined Template. This step is the first 
step in copying a schedule. 

Navigate to the Schedule tab of the Configure Employee window. See Configure Employee 
Schedules.
Check the Template box. The Define Template dialog box will open. 
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Employee Maintenance

Check the Use  Employee  as    template box. 

Enter a name for this template. Try to make it as descriptive as possible and avoid using employee 
names, as it may be difficult to remember what type of schedule the employee has. 

Click OK to commit the changes and return to the Schedule screen. 

Copy an Employee Schedule Template 

The Copy Schedule feature allows you to copy a previously defined Employee Schedule Template. 
See Create an Employee Schedule Template. 

Navigate to the Schedule tab of the Configure Employee window. See Configure Employee 
Schedules.
Click the Copy button. The Schedule Copy Details dialog box will open. 
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Click OK to commit the changes and return to the Schedule screen. 

Employee Maintenance

Fill in the settings as appropriate: 

Template Name

Code

Displays the name of the available Template. 

Display Click this button to display the details of the selected Template. 

What to Copy These settings define what will be copied. 

Department 

Job

Check this box to copy the Department assignments. 

Check this box to copy the Job assignments. 

Define Copy These settings define when the template will be copied. 

Copy From These settings define the date range that will be copied from. 

Setting Defintion

Starting On Enter the date from which you wish to copy forward. 

Copy Forever

Stop On

Select this option to copy the selected template from the Starting on point 
forward forever. 

Select the option to copy only up to a certain date. Enter the date in the 
space provided.

Copy To These settings define the date range that will be copied to. 

Starting on 
Hire Date

Select this option to "paste" the copied schedule starting from the 
employee's hire date forward. 

Starting on 
Date

Select this option to "paste" the copied schedule from a user-defined date 
forward. Enter the date in the space provided. 

Displays the code of the available Template. 

Shift Info Check this box to copy scheduled starting and stopping times. 

Work Check this box to copy which days are selected for Work. 
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Employee Maintenance

Employee Transactions Tab 
The Transaction tab displays the individual punches for the employee  
NOTE: Tasks associated with the Transactions tab, such as editing and adding punches, are 
covered in their own section. See Timecard and Transaction Maintenance.

Description 

Navigate to the Configure Employee window. See Configure Employee.
Click the Transactions tab to display the following information:
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Employee Maintenance

Supervisor

Add/Edit/Delete

Input

Displays the function prompt for the transaction. Prompt

Displays any additional data entered with the transaction, such as a 
Department number, the number of pieces produced, etc.  

For more information on adding, editing and deleting transactions, see 
Adding and Editing Transactions, and Deleting Transactions. 

Clock 

Badge

Displays the number of the clock at which the transaction was recorded. 

Displays the employee's badge number used for this transaction. 
NOTE: No clock number will display if the transaction was entered by a 
supervisor through the TA100 Pro software. 

This field shows audit trail information, and displays the name and 
number of the supervisor who edited this transaction, if any. . 

Date

Day

Displays the date of the transaction. 

Time Displays the actual time of the transaction.  

Key Displays the time clock function key pressed to generate the transaction. 
(i.e., * for Clock In for day, etc.) 

Setting Defintion

Displays the day of the transaction. 

Prompt Displays the function prompt for the transaction. 

144



Employee Maintenance
Employee Status Tab 
The Status tab displays the employee's current work status with the company

Configure Employee Status 

Navigate to the Configure Employee window. See Configure Employee.
Click the Status tab to display the following information: 

Policies

Date

Select the Policy to be assigned to this employee. 

Active Select whether the employee is Active or Inactive as of the effective date. 

Fulltime Select whether the employee is Full Time or Part Time as of the effective 
date

Permanent Select whether the employee is a Permanent or Temporary employee as of 
the effective date.  

Setting Defintion

Enter the effective date of the status. 
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Add Employee Status 

When an employee changes Status, it is recommended that you add a new Status entry rather 
than editing the existing Status. This enables you to keep a history of Status changes throughout 
the employee's work history. 

Navigate to the Status tab of the Configure Employee window.
Click the Add button to add a new Status. The Status Maintenance dialog box will open: 

Fill in the settings as appropriate: 

Click OK to commit the changes and return to the Status screen. The new Status will be added to the 
list. 

Employee Maintenance

Setting Defintion

Active/Inactive

Policies

Date Enter the date that this Status change becomes effective.  

Full Time/Part 
Time

Permanent/
Temporary

Choose whether the employee is Active or Inactive as of the selected date.  
Active indicates that the employee is currently working for the company.  
Inactive indicates that the employee is not currently working for the 
company, perhaps because of a leave of absence or termination. 

Choose whether the employee is Full Time or Part Time as of the selected 
date.

Choose whether the employee is Permanent or Temporary as of the selected 
date. 

Select the Policy that will apply to this employee as of the effective date.
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Edit Employee Status 
If you choose to edit the Employee's Status, the changes will be retroactive to the effective date 
of the original status entry. Because of this, when an employee changes Status, it is 
recommended that you add a new Status entry rather than editing the existing Status. This 
enables you to keep a history of Status changes throughout the employee's work history. 

Navigate to the Status tab of the Configure Employee window. See Configure Employee Status.
Highlight the Status entry you wish to edit. 
Click the Edit button. The Status Maintenance screen will become available for you to edit. 
Edit the settings as described in the Add Employee Status section. 
Click OK to commit the changes and return to the Status screen. 

Delete Employee Status 

You may wish to delete a Status entry that has been added in error. One Status entry must 
always exist, thus you will not be able to delete if there is only one Status entry. 

Navigate to the Status tab of the Configure Employee window. See Configure Employee Status 
Highlight the Status you wish to delete. 
Click the Delete button. You will be prompted: 

Click OK to confirm the deletion and return to the Status screen. 

Employee Maintenance
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Employee Benefits Tab 
The Benefits tab reflects the selected employee's current benefit balances. The information and 
options on this tab will be slightly different if you have purchased Benefit Accruals than with 
Benefit Entitlement. Both options are described below: Benefit Entitlement is first, followed by 
Benefit Accruals. 

Benefit Entitlement: Configure
Navigate to the Configure Employee window. See Configure Employee.
Click the Benefits tab to display the following information:

Hire Date

Fiscal Date

Displays the employee's Hire Date (set on the Detail tab), for information 
purposes.  

Days of Service

Displays the category code of the benefit (i.e., VAC, SICK, etc.). Code 

Displays the number of Days of Service the employee has, for information 
purposes.   

Setting Defintion

Displays the employee's Fiscal Date (set on the Detail tab), for information 
purposes.  

Description Displays the category name of the benefit (i.e., Vacation, Sick, etc.) 
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Benefit Entitlement: Employee Benefit Details 

Navigate to the Benefits tab of the Configure Employee window. 
Highlight the benefit Category you wish to view. 
Click the Details button. The Benefit Details screen for the selected Category will open. 

Employee Maintenance

Taken Displays the number of hours of the benefit the employee has already taken. 
This number is calculated from the Miscellaneous entries on the employee's 
time card. 

Pending Displays the number of hours of the benefit the employee will take in the 
future (within the current pay period). 

Left Displays the number of hours left. This is calculated by subtracting the 
Taken and Pending amounts from the Allowed, as follows: 
Left = Given - (Taken + Pending) 

Count Displays the number of individual days on which the benefit time was taken 
or is pending. 

Details Click this button to display the individual entitlement transactions for this 
employee.  

Setting Defintion

Given Displays the number of hours the employee has been granted through 
Benefit Entitlement. 
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The Benefit Details dialog box contains the following information: 

Employee Maintenance

Benefit Entitlement: Grant Benefit Time 
With Benefit Entitlement, you manually enter the amount of hours given for each Benefit Category. 
This is a one-time entry. 

Navigate to the Benefits tab of the Configure Employee window. 
Highlight the benefit Category you wish to grant. 
Click the Details button. The Benefit Details screen for the selected Category will open. 

Enter the amount of time you wish to grant in the Amount Allowed box. 
Click OK to commit the change and return to the Benefits screen. 

Date

Day 

Displays the date on which the time was taken. 

Amount Displays the number of hours taken. 

Setting Defintion

Displays the day on which the time was taken. 

Displays the category of time taken. Category 

Time Displays the time at which the time was taken. 
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Benefit Entitlement: Delete a Detail 
Navigate to the Benefits tab of the Configure Employee window. 
Click the Details button. The Benefit Details screen will display. 
Highlight the item you wish to delete. 
Click the Delete button. You will be prompted: 

Click OK to confirm the deletion.  
Click OK to confirm the Archive message. 
Click Close to return to the Benefits screen. 

Benefit Accruals: Configure 

Navigate to the Configure Employee window. See Configure Employee. 
Click the Benefits tab to display the following information:

Employee Maintenance
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Setting Defintion

Hire Date

Left 

Pending

Given

Taken

Count 

Carry Date 

Details 

Fiscal Date Displays the employee's Fiscal Date (set on the Detail tab), for information 
purposes.  

Days of Service

Code

Description

Displays the employee's Hire Date (set on the Detail tab), for information 
purposes. 

Displays the number of Days of Service the employee has, for information 
purposes. 

Displays the category code of the benefit (i.e., VAC, SICK, etc.). 

Displays the category name of the benefit (i.e., Vacation, Sick, etc.) 

Update

Displays the number of hours the employee has either been granted or 
earned. This number is based on the Benefit Accrual settings (if applicable) 
or can be manually edited to grant Benefit Entitlement. 

Displays the number of hours of the benefit the employee has already taken. 
This number is calculated from the Miscellaneous entries on the employee's 
time card. 

Displays the number of hours of the benefit the employee will take in the 
future (within the current pay period). 

Displays the number of hours left. This is calculated by subtracting the 
Taken and Pending amounts from the Given, as follows: 
Left = Given - (Taken + Pending) 

Displays the number of individual days on which the benefit time was taken 
or is pending. 

Displays the date on which the benefits will roll over, also known as the 
Reference Date or Reset Date. 

Click this button to update the benefit calculations to the current day for this 
employee

Click this button to display the individual accrual or entitlement 
transactions for this employee. For more information, see Benefit Accruals. 
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Benefit Accruals: Update Employee Benefits 
TA100 Pro will automatically update employee benefit accruals to the current day. However, if you 
make a change the Benefit Accrual rule assigned to the employee, or change the settings of the 
rule, you may wish to "force" TA100 Pro to update. 

Navigate to the Benefits tab of the Configure Employee window. See Benefit Accruals: Configure. 
Click the Update button. This employee's benefits will update and the screen will refresh. 

Benefit Accruals: Employee Benefit Details 

It is possible to view a detailed schedule of how much benefit time the employee has earned and 
when it was posted. 

Navigate to the Benefits tab of the Configure Employee window. See Benefit Accruals: Configure,.
Click the Details button. The Benefit Details screen will display. 

Employee Maintenance
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The Benefit Details dialog box contains the following information: 

Employee Maintenance

Setting Defintion

Date

Manual Adj. 
Button 

Show Accrued 
Adjustments 

Archived

Day

Time

Category

Type

Displays the day on which the time was posted or taken. 

Displays the Category of the benefit time. 

Displays what type of benefit transaction it was.  
Bonus Hours indicates time earned or accrued. 
Misc. Entry Indicates time taken. 
Hours Adj. Indicates a manual adjustment. 
Balance Adj. Indicates a Balance Adjustment 

Displays the date on which the time was posted or taken. 

Displays the time at which the time was posted or taken. 

Amount

Balance

Displays the number of hours posted or taken. 

Displays the running balance after the transaction.

Indicates whether these transactions are in a data set that has already 
been archived. 

Check this box to display the adjustments that have been made to accrued 
Benefits. 

Click this button to make a manual adjustment.  For more information see 
Manual Benefit Adjustment. 

Click OK to close the Benefit Details screen. 

Benefit Accruals: Manual Benefit Adjustment 

It is possible to make manual adjustments to an employee's Benefit Entitlement. These adjustments 
can be additions or deductions to the employee's available benefits. You can also use this feature to 
zero out the employee's balance, called a balance adjustment. 

Navigate to the Benefits tab of the Configure Employee window. See Benefit Accruals: Configure.
Click the Details button. The Benefit Details screen will display. 
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Fill in the settings as appropriate: 

Click OK to commit the changes and return to the Benefit Details screen. 
Click Close to return to the Benefits screen. 

Employee Maintenance
Click the Manual Adj. Button. The Manual Adjustment dialog box will open. 

Setting Defintion

Time 

Date

Type

Enter the Date on which the adjustment should be posted. 

Enter the time at which the adjustment should be posted. 

Amount

Select the type of adjustment to be made. 
Given: Grants the employee the number of hours entered in the Amount 
field. Balance: Adjusts the employee's Given field value to cause the 
current Left balance to reflect the number of hours entered in the Amount 
field. For example, if the Employee had taken 40 hours already and you 
wanted their balance to reflect 40 hours left, TA100 Pro would adjust the 
Given to 80 (80 Given – 40 Taken = 40 Left). 

Enter the amount of the adjustment. This number can be positive (for an 
addition) or negative (for a deduction).
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Click OK to confirm the deletion. 
Click Close to return to the Benefits screen. 

Employee Maintenance

Benefits Accrual: Delete a Manual Adjustment 

Navigate to the Benefits tab of the Configure Employee window. See Benefit Accruals: Configure.
Click the Details button. The Benefit Details screen will display.
Highlight the Adjustment you wish to delete. 
Click the Delete button. You will be prompted:
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Setting Defintion

Message

Clock ID Displays the number of the clock at which this message will display. 

Displays the message. The message can be up to 20 characters and the 

Employee Messages Tab 
The Messages tab allows you to create a customized message that will display when this 
employee punches at the clock 

Configure 

Navigate to the Configure Employee window. See Configure Employee. 
Click the Messages tab to display the following information:
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Select the clock to which this message should be sent. 

Enter the message you wish to send. Up to 20 characters may be entered. Or check the Default 
message to   Employee  name to send the employee's First Initial and Last Name. 

Click OK to commit the changes and return to the Messages screen. 

To    All  Clocks 

Navigate to the Configure Employee window. See Configure  Employee.
Click the All  Clocks button to add a new message to all clocks this employee uses. The Message 
Assignment dialog box will open.

Employee Maintenance

Add       a  Message 
You can send a message to each clock individually, or to all clocks that the employee uses. 

To  a        Single    Clock 
Navigate to the Configure Employee window. See Configure   Employee.
Click the Add button to add a new message to send to an individual clock. The Message Assignment 
dialog box will open. 
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Click OK to confirm the deletion. 

Employee Maintenance

Enter the message you wish to send. Up to 20 characters may be entered. Or check the Default 
message to Employee name to send the employee's First Initial and Last Name. 
Click OK to commit the changes and return to the Messages screen. 

Edit a Message 
Navigate to the Configure Employee window. See Configure Employee. 
Highlight the Message you wish to edit. 
Click the Edit button. 
Edit the settings as described in the Add a Message section. 
Click OK to commit the changes and return to the Messages screen. 

Delete a Message 

Navigate to the Configure Employee window. See Configure  Employee. 
Highlight the Message you wish to delete. 
Click the Delete button. You will be prompted: 
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Employee Wages 
The Wages tab specifies the FLSA status (exempt or non-exempt) and pay rate(s) for the employee. 
For non-exempt employees, wages can either be Global or associated with the Department or Job 
on which the employee works. All options are described in the following sections. 

Configure Employee Wages 

Navigate to the Configure Employee window. See Configure Employee.
Click the Wages tab to display the following information: 

Setting Defintion

Hourly Check this option to indicate that the employee is Hourly. 
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Add a Global Wage 
Navigate to the Wages tab of the Configure Employee window. See Configure Employee Wages. 
Select the Hourly option. 
Check the Use Global Wage option. 
Click the Add button to add a new Global Wage. The Wage Details dialog box will open. 

Salary 

Pay Overtime 

Job

Report Hours From

Attendance
Clocking

Click this button to set a wage that applies whenever the employee works 
for a particular Job. This can be used to pay different rates when the 
employee performs different functions.

Check this option to indicate the employee is Salary.

TA100 Pro can report salaried employees' hours either from actual punches 
or from their schedule, regardless of their punches. 
Check Actual to have TA100 Pro report the hours as they are punched at 
the clock. 
Check Schedule to have TA100 Pro report hours from the employee's 
schedule. The Attendance Clocking settings will become available when 
this option is checked and need to be configured

These settings become available when the Report Hours From Schedule 
option is checked.
Check Paired Punching to indicate that the employee should punch In and 
Out, but TA100 Pro will ignore the actual times of the punches and report 
the scheduled times and duration.
Check In Only to indicate that the employee only needs to punch In each 
day and TA100 Pro will report the scheduled times and duration.
Check None to indicate that TA100 Pro should
automatically report the scheduled times and duration without the employee 
having to punch at all.

Check this option to make the employee eligible for overtime, based on the 
Policy to which the employee is assigned.

Employee Maintenance
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Use Global Wage 

Department 

Check this option to assign the employee a fixed standard wage regardless 
of which department or they work in.  If un-checked the employee will earn 
a different wage based on the department or job they work in.   For more 
information see the Department or Job buttons in this section. 

Click this button to set a wage that applies whenever the employee works 
for a particular Department. This can be used to pay different rates when 
the employee performs different functions.  

Setting Defintion



Click OK to confirm the deletion. 

Enter the date on which this wage takes effect. 
Enter the amount of the hourly wage. 
Click OK to commit the changes and return to the Wages screen. 

Edit a Global Wage 
Navigate to the Wages tab of the Configure Employee window. See Configure Employee Wages. 
Highlight the wage you wish to edit 
Click the Edit button. The Wage Details dialog box will open. 
Enter the amount of the hourly wage. 
Click OK to commit the changes and return to the Wages screen. 

Delete a Global Wage 
Navigate to the Wages tab of the Configure Employee window. See Configure Employee Wages.
Highlight the wage you wish to delete. 
Click the Delete button. You will be prompted: 

Employee Maintenance
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Add an Employee Level Wage 
Employee Level Wages specify the wage the employee makes when working for a specific 
Department or Job. In this section, Level refers to the Department or Job, as appropriate. The 
procedure is the same regardless of which level you are defining, thus they are all described 
together.  

Navigate to the Wages tab of the Configure Employee window. See Configure Employee Wages.

Select the Hourly option. 
Click the Department  or  Job button, depending upon choice. The Level Wage Details dialog box 
will open. 
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The Level Wage Details dialog box contains the following information: 

Wage Calendar 

Setting Defintion

Use Hourly
Wage 

Level This field will be pre-populated with the Departments and Jobs defined in the 
system. Select the item you wish to configure.

The value for this option is defined in the Configure Department or Job dialog 
box. It will be checked and will reflect the pre-defined wage if the Use Hourly 
Wage setting is checked in the Department or Job dialog box for this item.

The calendar is used both to enter the wage amount and to indicate the 
effective date of the wage. Wages will auto fill from the date entered 
forward. Always enter the wage on the date, which you wish it to take effect. 

Click Close to commit the changes and return to the Wages screen. 

Edit an Employee Level Wage 

Navigate to the Wages tab of the Configure Employee window. See Configure  Employee  Wages. 
Select the Hourly option. 
Click the Department   or    Job button, depending upon choice. The Level Wage Details dialog box will 
open. 
Edit the settings as described in the Add an Employee Level Wage section. 
Click Close to commit the changes and return to the Wages screen. 

Employee Badges Tab 
The Badges dialog box is used to assign the employee's badge number.
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Configure Employee Badges 

Navigate to the Configure Employee window. See Configure Employee.
Click the Badges tab to display the following information:

Hire Date

Number

Setting Defintion

Displays the badge number assigned to the employee. 

Indicates if a badge is valid.   
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Add a Badge 
Navigate to the Badges tab of the Configure Employee window. See Configure Employee Badges.
Click the Add button to add a new Badge. The Assign Badge dialog box will open. 

Enter the Badge number you wish to assign to this employee and press Tab. 
Check the Valid box to indicate this badge is in use. 
Click OK to commit the changes and return to the Badges screen. 

Edit a Badge 
It is possible to edit a Badge in order to make it Invalid for this employee (cannot be used by this 
employee to punch). The badge number cannot be changed. If you need to change a badge 
number, it is best to make the old badge number inactive or delete it, and add a new one. 

Navigate to the Badges tab of the Configure Employee window. See Configure Employee Badges. 
Click the Edit button. The Assign Badge dialog box will open. 
Uncheck the Valid box to make the Badge invalid. 
Click OK to commit the changes and return to the Badges screen. 
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Click OK to confirm the deletion and return to the Badges screen.

Employee Maintenance
Delete a Badge 
Navigate to the Badges tab of the Configure Employee window. See Configure Employee Badges. 
Highlight the Badge you wish to delete. 
Click the Delete button. You will be prompted: 
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Employee Clocks Tab 
The Clocks tab is used to assign employees to biometric timeclocks.  This is necessary as the 
clocks have to receive the employees templates before the employee is allowed to punch at that 
clock.  Each time they punch, their hand, finger, or face is compared against the existing template.  
Templates are stored in the clocks.  By assigning employees to specific clocks, we are defining 
which clocks they are allowed to use. 

Configure Hand Readers 

Navigate to the Configure Employee window. See Configure Employee.
Click the Clocks tab to display the following information:
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Authority

Edit

The Authority Level defines which clock menus employee can view or use at 
the clock.  0 is the lowest (employee) and default, 5 is the highest and allows 
complete at-the-clock setup (supervisor). 

All Clocks

Add

Edit the settings assigned to the employee.

Retrieve Templates 
From 

If an employee has more than one badge, they can have more than one 
template.  Pick which badge and template is being assigned to this clock.  If 
the employee does not have a template save, NONE ON FILE will be 
displayed.  

Templates on File 
for Badge Numbers 

Delete

This opens the All Clocks dialog box.  Here you can assign an employee to 
all hand readers.  

Only save templates from the specified clock.  ALL ASSIGNED means the 
last clock that templates are retrieved from is the one that will be save.  Best 
practice is to pick the clock the employee uses most.  

Click this button to select hand readers individually. 

Delete the employee hand reader assignment.

Badge

Clock ID 

Reject

Time Zone 

Setting Defintion

Displays the Clock ID assigned to each reader. 

Displays employee badge number. 

The reject threshold indicates how closely the hand has to match the 
original scanned hand template.  The lower the number, the more exact the 
match needs to be. 

Not used in TA100 Pro, will always be 0. 
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Configure TA7000 
Navigate to the Configure Employee window. See Configure Employee. 
Click the Clocks tab, then click the TA7000 tab to display the following information:

170



Employee Maintenance

Badge

Clock ID

Authority

Templates on File 
for Badge Numbers 

Verification

Retrieve Templates 
From 

Displays the verification level, which defines the false read threshold. 

Displays the Authority Level, which defines the clock menus employees 
can view or use at the clock.  The following options are available:  
Employee, Supervisor or Configuration. 

Add Click this button to select TA7000 clocks individually. 

Setting Defintion

Delete Delete the employee fingerprint assignment. 

Edit Edit the settings assigned to the employee. 

Displays the Clock ID of the clocks the employee has been assigned to. 

Displays the badge number assigned to the clock. 
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If an employee has more than one badge, they can have more than one 
template.  Pick which badge and template is being assigned to this clock.  If 
the employee does not have a template save, NONE ON FILE will be 
displayed. 

This opens the All Clocks dialog box.  Here you can assign an employee to all 
TA7000 clocks. 

All Clocks This opens the All Clocks dialog box.  Here you can assign an employee to 
all TA700 clocks. 
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Configure TA745\TA780\TA785 
Navigate to the Configure Employee window. See Configure Employee.
Click the Clocks tab, then click the TA745\TA780\TA785 tab to display the following information:
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Badge

Clock ID

Templates on File 
for Badge Numbers 

Special Enroll

All Clocks

Special enroll flags this employee as not having to use biometric validation. 

If an employee has more than one badge, they can have more than one 
template.  Pick which badge and template is being assigned to this clock.  
If the employee does not have a template save, NONE ON FILE will be 
displayed. 

This opens the All Clocks dialog box.  Here you can assign an employee to 
all TA7XX clocks. 

Add Click this button to select TA7XX clocks individually. 

Setting Defintion

Delete Delete the employee fingerprint assignment. 

Edit Edit the settings assigned to the employee. 

Displays the Clock ID of the clocks the employee has been assigned to.

Displays the badge number assigned to the clock.
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Configure TA800s\SY-Face 

Navigate to the Configure Employee window. See Configure Employee.
Click the Clocks tab, then click the TA800s\SY-Face tab to display the following information:
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Badge

Clock ID

Templates on File 
for Badge Numbers 

Special Enroll

All Clocks

Special enroll flags this employee as not having to use biometric validation. 

If an employee has more than one badge, they can have more than one 
template.  Pick which badge and template is being assigned to this clock.  If 
the employee does not have a template save, NONE ON FILE will be 
displayed. 

This opens the All Clocks dialog box.  Here you can assign an employee to 
all TA800s/SY-Face clocks. 

Add Click this button to select TA800s/SY-Face clocks individually. 

Setting Defintion

Delete Delete the employee fingerprint assignment. 

Edit Edit the settings assigned to the employee. 

Displays the Clock ID of the clocks the employee has been assigned to.

Displays the badge number assigned to the clock.
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Configure SYnergy

Navigate to the Configure Employee window. See Configure Employee.
Click the Clocks tab, then click the SYnergy tab to display the following information:
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Badge

Clock ID

Templates on File 
for Badge Numbers 

Special Enroll

All Clocks

Special enroll flags this employee as not having to use biometric validation. 

If an employee has more than one badge, they can have more than one 
template.  Pick which badge and template is being assigned to this clock.  If 
the employee does not have a template save, NONE ON FILE will be 
displayed. 

This opens the All Clocks dialog box.  Here you can assign an employee to 
all SYnergy clocks. 

Add Click this button to select SYnergy clocks individually. 

Setting Defintion

Delete Delete the employee hand reader assignment. 

Edit Edit the settings assigned to the employee. 

Displays the Clock ID assigned to each clock. 

Displays employee badge number. 
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Assignment Details    

Special Enroll             

Badge

Supervisor to 
Enroll Templates

Allows user to select the badge that will be sent down to the clock if an 
employee was assigned multiple badges. 

Setting Defintion

Displays a list of how many templates have been enrolled for the employee 
and allows all templates to be deleted.

When enabled this setting will allow the employee to bypass the fingerprint 
and only enter the badge number  when punching. Click this button to select 
employees based on.

When enabled this setting will allow the employee to enroll other employees 
at the clock.

Employee Details Tab 
The Details tab manages the employee's personnel settings. New employees are also added from 
this tab. 
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Configure Employee Details 

Navigate to the Configure Employee window. See Configure Employee.

Setting Defintion

Number 

Social Security

Birth Date

This is a required field. Enter a code (from 2 to 10 characters in length to 
identify the employee. The code’s maximum length and type (numeric or 
alphanumeric are defined in the System Defaults dialog box in Company 
Setup. Numeric fields are zero filled. 
NOTE: Once saved, the employee code cannot be modified, except through 
Utilities. 

Enter the employee’s social security number if desired. 

Enter the employee's birth date (if desired).

Click the Details tab to display the following information: 
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Setting Defintion

Last Name

Enter the employee’s middle initial.Middle Initial

First Name

City

Accrue this
Month 

Fiscal Date

Enter the employee's address. Two lines are available.

Enter the employee's City.

Address

Hire Date

Zip

Phone

Email Address

State

Enter the employee's Zip code.

Enter the employee's State.

Enter the employee's phone number.

Enter the employee’s email address.

Enter the employee's hire date.

Check this box if benefits should accrue during the first month of 
employment.

Enter the date on which this employee's or your company's fiscal year starts. 
This date can be used as the Reference Date on which benefits carry over.

User-Defined Fields

Use Alternative Hire 
Date for Benefits 

Use this date to override the Hire Date field as the date an employee’s 
benefits should begin.

There are eighteen user-defined fields. Enter information as desired.

Click the Details tab to display the following information: 

Enter the employee's first name.

Enter the employee's last name.

Division Select the pre-defined Division to which the employee belongs. 

Group

Holiday group 

Accrual Rule 

Select the pre-defined Holiday Group to which the employee belongs.  If 
Holiday Groups were not created you may leave at the default listing of All 
Holidays. 

Select the pre-defined Benefits Accrual rule that applies to this employee. 

Use PC Clock Check this block to allow permissions for the PC Clock 

Select the pre-defined Group to which the employee belongs. 
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When all settings are complete, click the Continue button to advance to the next screen.  The 
Schedule  dialog box will open. See Employee Schedule. 
When all settings are complete, click the OK  button to advance to the next screen. The Message 
Assignment dialog box will open. See Employee Messages. 
When all settings are complete, click the Close button to advance to the next screen. The Wage 
Assignment dialog box will open. See Employee Wages. 
When all settings are complete, click the OK  button to advance to the next screen. The Badge 
Assignment dialog box will open. See Employee Badges.  
When all settings are complete, click the Close button to advance to the next screen. The Clocks 
dialog box will open. See Employee Clocks. 
When all settings are complete, click the OK button to advance to the next screen. You will be 
returned to the Detail tab of the Configure Employee window. 
Click Close to exit the Configure Employee dialog box. 

Employee Maintenance

Add an Employee 

TA100 Pro uses an Add Employee wizard to walk you through the steps of adding a new employee. 
Once you have completed the Detail screen, additional screens will open, one after another, until all 
the settings for the employee are complete. 

Navigate to the Detail tab of the Configure Employee window. See Configure Employee Details.
Click the Add button to add a new Employee. The Detail tab will become available. 
Fill in the settings as described in the Configure Employees Details section. 
Click OK to commit the changes and continue to the next screen. 
The Status dialog box will open. See Employee Status. 
When all settings are complete, click Close to continue to the next screen. 
The Assignment Start Date dialog box will open. Choose the date on which you want the employee's 
schedule to start.  
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Click OK to confirm the deletion. 
Click Close to exit the Configure Employees dialog box. 

Employee Maintenance

Edit an Employee 

Navigate to the Detail tab of the Configure Employee window. 
Highlight the Employee you wish to edit from the list at the side of the screen. 
Click the Edit button. The Detail screen will become available for you to edit the selected Employee. 
Edit the settings as described in the Configure Employee section. 
Click OK to commit the changes and return to the Configure Employee screen. 
Click Close to exit the Configure Employee dialog box. 

Delete an Employee 
Deleting an employee deletes all of the data relating to that employee throughout the database, 
including time records.  

NOTE:  This can cause inaccurate reporting. You cannot undo a delete. 

Navigate to the Detail tab of the Configure Employee window. 
Highlight the Employee you wish to delete from the list at the side of the screen. 
Click the Delete button. You will be prompted: 
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Timecard and Transaction Maintenance
This  section    describes  the   concepts  and   tasks associated   with   managing   employee   time   records, 
including editing   and   adding   time   entries.

Online Timecard 
The Online Timecard allows you to view, add, edit and delete employee time entries. The Timecard 
can be accessed from two locations: the Configure Employee dialog box and the Approval Editor. 

Accessing the Online Timecard  from the Configure Employee Screen 

Click the Daily Operations  menu, Employee. The Configure Employee dialog box will open. The 
Timecard tab will be selected automatically. 
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A double click or right click on the job costing field of the timecard will display the job costing 
information for that slice of time.  The Online Timecard week view at bottom of page now indicates 
holidays (italics), current date (blue highlight) and days scheduled to work (underline date).  Blue 
backgrounds have been added in the employee screen for easier visibility of an active feature. 
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• Navigation buttons: Click the Navigation buttons to scroll to previous and next pay periods. The
navigation button at the top of the scroll bar takes you to the previous pay period; the button at
the bottom takes you to the next pay period.

• Pay Period selector: Use the spin button in the Pay Periods Back box to scroll to a pay period a
specified number of periods in the past.

Navigating in the  Online Timecard  Tab 
By default, the Online Timecard screen displays the current pay period's data. The Approval Editor 
timecard will open to the pay period of the exception or absence that was selected.  There are two 
easy techniques for navigating to other pay periods. 

NOTE: It may not be possible to edit data in previous pay periods, depending upon your security 
permissions and the number of editable pay periods settings. For more information, see Main 
Company and Configure Users. 
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• Navigation buttons: Click the Navigation buttons to scroll to previous and next months. The
navigation button at the top of the scroll bar takes you to the previous month; the button at the
bottom takes you to the next month.

Navigating  in  the  Transactions  Tab 
By default, the Transactions screen displays the current month's data. There is an easy technique 
for navigating to other months. 

NOTE: It may not be possible to edit data in previous months, depending upon your security 
permissions and the number of editable pay period settings. For more information, see Main 
Company and Configure Users. 
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Adding and Editing Transactions 
Adding a transaction enables you to record a time entry on behalf of an employee. For example, you 
might need to add a missed Clock Out, add a lunch or break, or enter a vacation day.  

Examples of transactions are: 

Timecard and Transaction Maintenance

Clocked Out

Clocked In

Out For Lunch

In From Lunch 

Swipe and Go

Enter Tips

Swipe and go transaction.

Miscellaneous Miscellaneous transactions are used to add or subtract dollars 
or hours, including vacation and other categories of time, as well 
as per diem, tips and other categories of dollars. 

Punching In for the day. 

Punching Out for the day. 

Punching Out for lunch.

Punching In from lunch.

Out On Break Punching Out for break. 

In From Break Punching In from break.  

Enter Department Transferring departments. 

Entering tips. 

There are several ways to add transactions. All accomplish the same end, but some are easier to 
use in certain instances. All are described below.

Add   Transaction 
Transactions can be added from the Online Timecard or from the Transactions tab of the Configure 
Employee dialog box. The method is the same in both locations. 

This option for adding a transaction works best when you are going to manually enter all elements 
of the transaction. 

NOTE:  A popup window is available to add/edit Start and Stop entries.  The popup window can be 
accessed by double clicking or a right click in the Start and Stop fields. 
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Navigate to the Online Timecard for the employee you wish to edit. See Online Timecard. Or 
navigate to the Transactions tab of the Configure Employee dialog box and select the employee for 
whom you wish to add a transaction. See Employee Transactions.

Click the Add Trans (Online Timecard) or Add (Transactions) button. The Transaction Detail dialog 
box will open. 

Timecard and Transaction Maintenance

Time

Date

Clock

Function

Setting Defintion

Enter the date for this transaction. 

Enter the time for the transaction. HH:MM:SS. Enter this in military time. 

Select the type for this transaction. The standard options are: 
Clocked In, Clocked Out, Out for Lunch, In from Lunch, Enter Department, 
Swipe & Go and Miscellaneous (used for entering absences, vacation, tips 
and other categories of time and dollars).  See Add Miscellaneous 
Transaction.
Additional options may appear, depending upon your company and clock 
configuration.

Select the clock to which the transaction should be attributed. 

The Transaction Detail dialog box contains the following information: 

Click OK to commit the changes and return to the Online Timecard. 
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Override Round 

Override Automatic 
Lunches and Breaks

Check this option to have TA100 Pro ignore the rounding rules for this 
transaction. 

Check this option to cancel all automatic lunches and breaks assigned to a 
specific day.  The edit must be initiated from the start time. 



Add Miscellaneous Transaction 
Transactions can be added from the Online Timecard or from the Transactions tab of the Configure 
Employee dialog box. The method is the same in both locations. 

This option for adding a transaction works best when you are going to manually enter all elements of 
the transaction. 

Navigate to the Online Timecard for the employee you wish to edit. See Online Timecard. Or 
navigate to the Transactions tab of the Configure Employee dialog box and select the employee for 
whom you wish to add a transaction. See Employee Transactions.

Click the Add Trans (Online Timecard) or Add (Transactions) button. The Transaction Detail dialog 
box will open. 
Select Miscellaneous from the function drop down menu, additional information will open. 

Timecard and Transaction Maintenance
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The Transaction Detail dialog box contains the following information: 

Setting Defintion

Category

REG/OT1/OT2/OT3

Level

Prompt

Differential

Date 

Clock 

Accrue Towards 
Overtime 

Enter the date for this transaction. 

Select the clock to which the transaction should be attributed. 

This section will only become available when the Miscellaneous function 
is selected. 

Select the category for this transaction. 

Miscellaneous 
Information 

Add/Subtract

Amount

HH:MM

Select Add to add the number of hours or dollars in the next field. Select 
Subtract to deduct the number of hours or dollars in the next field. 

If an Hours category was selected, this field will become available. Enter 
the number of hours for this transaction in decimal format. 

If a Dollars category was selected, this field will become available. Enter 
the amount of dollars for this transaction. 
If an Hours category was selected, this field will automatically fill in when 
enter the HH:MM in the previous field. 

Check this box to cause the Miscellaneous entry to count toward overtime 
(daily and weekly). 

Check this option to have TA100 Pro override the Job Costing level(s). 

This section will become available if a function requiring additional input 
is selected (for example, Enter a Department). 

Time 

Function 

Enter the time for the transaction. HH:MM:SS. Enter this in military time. 

Select Miscellaneous for this transaction. The Miscellaneous function is 
used for entering absences, vacation, tips and other categories of time and 
dollars. 

Select the rate at which the Miscellaneous time should be paid. 

Select the differential at which the Miscellaneous time should be paid. 

Input Enter the additional input (for example, the Department number). 

Timecard and Transaction Maintenance

Click OK to commit the changes and return to the Online Timecard.
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Edit a Transaction 

This section describes how to use the Edit button in the Transaction tab.  You can edit transactions 
from either the Online Timecard or the Transactions tab of the Configure Employee dialog box. The 
Online Timecard provides two buttons: Edit/Add Start and Edit/Add Stop, which are described in 
the next two sections.  

Navigate to the Transactions tab of the Configure Employee dialog box and select the employee 
whose time you wish to edit. See Employee Transactions.
Navigate to and select the transaction you wish to edit. 
Click the Edit button. The Transaction Detail dialog box will open.

Fill in the settings as described in the Add Transaction section. 
Click OK to commit the changes and return to the Transactions screen. 

Edit/Add Start 

Edit/Add Start is available from the Online Timecard. The Edit/Add Start button opens the 
Transaction Detail dialog box and automatically fills in certain fields. 

• The Date fills in with the date selected in the Timecard.
• The Time fills in with the employee's scheduled Clock In time for the selected date.
• The Function fills in with Clocked In.

This option is easiest when you are adding a Clock In for the day that matches or 
is close to the employee's scheduled In time.  

Navigate to the Online Timecard for the employee you wish to edit. See Online Timecard.
Click the Edit/Add Start button. The Transaction Detail dialog box will open. Fill in the settings as 
described in the Add Transaction section. 
Click OK to commit the changes and return to the Online Timecard. 

Timecard and Transaction Maintenance
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Edit/Add Stop 
Edit/Add Stop is available from the Online Timecard. The Edit/Add Stop button opens the 
Transaction Detail dialog box and automatically fills in certain fields. 

• The Date fills in with the date selected in the Timecard.
• The Time fills in with the employee's scheduled Clock Out time for the selected date.
• The Function fills in with Clocked Out.
• The Override Punch Link-Back Time is now an override feature, this option will ignore all

punch link-back time associated with a policy.  This edit must be initiated from the stop time.

This option is easiest when you are adding a Clock Out for the day that matches or is close to the 
employee's scheduled Out time.  

Navigate to the Online Timecard for the employee you wish to edit. See Online Timecard.
Click the Edit/Add Stop button. The Transaction Detail dialog box will open. 
Fill in the settings as described in the Add Transaction section. 
Click OK to commit the changes and return to the Online Timecard.

Timecard and Transaction Maintenance
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Multiple Miscellaneous 
The Multiple Miscellaneous button appears in the Online Timecard and allows you to add 
Miscellaneous transactions on multiple days. This option is easiest when you are adding several 
days of the same category, for example, for a weeklong vacation or per-diems for a business trip. 

Navigate to the Online Timecard for the employee you wish to edit. See    Online Timecard.
Click the Multiple Misc. button. The Multiple Miscellaneous Transaction dialog box will open. 
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Fill in the settings as appropriate: 

Setting Defintion

REG/OT1/OT2/OT3

Time 

Add/Subtract 

HH:MM 

Amount 

Enter the start time for this miscellaneous transaction.  If AM/PM has been 
activated from Main Company will require selection.  

Select the rate at which the Miscellaneous time should be paid. 

Differential 

Calendar

Job Cost Level 
Override 

Category Select the category for this transaction. 

Select Add to add the number of hours or dollars in the next field. Select 
Subtract to deduct the number of hours or dollars in the next field.  

If an Hours category was selected, this field will become available. Enter 
the number of hours for this transaction in decimal format. 

If a Dollars category was selected, this field will become available. Enter the 
amount of dollars for this transaction. 
If an Hours category was selected, this field will automatically fill in when 
enter the HH:MM in the previous field. 

Accrue Towards 
Overtime 

Check this box to cause the Miscellaneous entry to count toward overtime 
(daily and weekly). 

Select the differential at which the Miscellaneous time should be paid. 

Check this option to have TA100 Pro override the Job Costing level(s). 

Using the drop-down boxes at the top of the dialog box, select the Month and 
Year that contains the days for which you wish to add the Miscellaneous 
transactions. 
Click the dates on the calendar for which you wish to add the transactions. 
The dates selected will appear to be indented. 
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Click the Apply button. The Category code will appear on the days selected. 

Timecard and Transaction Maintenance

Click OK to commit the changes and return to the Online Timecard. 

From Schedule 
From Schedule adds a Clock In for the day and a Clock Out for the day punch, taking the times from 
the employee's schedule. This is useful when the employee did not punch in or out for the day, but 
worked the scheduled times. 

TIP: You can check the Show Schedule option at the bottom of the Online Timecard in order to 
verify the scheduled Start and Stop times prior to using this feature. 

Navigate to the Online Timecard for the employee you wish to edit. See Online Timecard. 
Click the From Schedule button. TA100 Pro will automatically fill in the Start and Stop fields with the 
employee's Scheduled Start and Stop times for the day. 

Delete a Transaction 
You may need to delete a transaction that has been made in error. Delete carefully, as there is no 
way to retrieve deleted data. 

Navigate to the Online Timecard (see Online Timecard) or the Transactions tab of the Configure 
Employee dialog box (see Employee Transactions) and select the employee you wish to edit.
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Navigate to the transaction you wish to delete. 
Click the Delete button. You will be prompted with one of the following, depending upon what you are 
deleting: 

This dialog box will appear if you are deleting a 
single Start or Stop, from either the Timecard or the 
Transactions. 

Audit Trails 
TA100 Pro keeps track of the changes that are made to time entries. This feature is known as an 
"Audit Trail." The Transactions tab of the Configure Employee dialog box displays the changes made 
to a transaction, the date the change was made, and the name and number of the person who made 
the change. This information can be printed for reporting purposes. 

Navigate to the Transactions tab of the Configure Employee window and select the employee you 
wish to view. Highlight the transaction for which you wish to see the Audit Trail. The Audit Trail 
section of the screen contains the following: 

Timecard and Transaction Maintenance

This dialog box will appear if you are deleting a line 
in the Timecard that has both a Start and a Stop. 

Setting Defintion

Supervisor 

Time  Displays the Time at which the edit was made. 

Supervisor Badge 

Date 

Displays the name and number of the supervisor who edited this transaction. 

Displays the badge number associated with the Supervisor who made the 
edit.

Displays the Date on which the edit was made.
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Print the Audit Trails 

TA100 Pro tracks all changes that are made to time entries. You may print this Audit Trail history.  

Navigate to the Transactions tab of the Configure Employee window and select the employee 
you wish to view.
Click the Print button. A drop-down list of Reports associated with this screen will appear. 

Select Transactions, By Employee or By Date. The Print Transaction Listing dialog box will open. 

Timecard and Transaction Maintenance
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Click OK to commit the changes and run the report. 
After previewing and/or printing, close the report (if necessary). 

NOTE:  The transaction report is color coded with red representing deleted items and blue 
representing changes. 

Click the Close button to exit the Report Settings dialog box and return to the Transactions screen. 

Timecard and Transaction Maintenance

Setting Defintion

Start 

At  

Output To

Enter the starting date for the report.

Displays the Time at which the edit was made. 

Options

Employees

At 

Stop

Enter the starting time for the report.

Enter the ending date for the report.

Select the type of report output you wish. 
Screen: The report will preview on screen. You are then able to print from 
the preview. 
Printer: The report will be sent directly to the printer. 
File: The report will be sent to a FoxPro report file. 
Email: The report will be sent via email. (See Emailing a Report). 

Select which Audit Trail items you wish to print along with the Transaction 
details. 
Deleted: The report will display deleted entries. 
Changed: The report will display the editing history of the transaction. 
Supervisor: The report will display transactions edited by supervisors at the 
clock

Select which employees for whom you wish to print Transactions. 
Add: Adds the selected employee to the list of employees for the report. 
Add All: Adds all employees to the list of employees for the report. 
Remove: Removes the selected employee from the list of employees for the 
report. 
Remove All: Removes all employees from the list of employees for the 
report. 

Fill in the settings as appropriate: 
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It is also possible to edit transactions directly from the Approval Editor. Double-clicking a 
transaction from the Approval Editor opens the Online Timecard, from which you can add, edit 
and delete transactions normally. (See Approval Editor). 

Click the Daily Operations menu, Approval Editor, or by clicking on the 

screen will open.

Timecard and Transaction Maintenance

Approval Editor 
The Approval Editor is an extremely useful tool that displays employee transactions that need 
approval or editing by a supervisor. These items display in the Approval Editor by default: 

• System-Generated Absences

• Missing Punches

. The Approval Editor 
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All Employees 

Division

Time

Show Count Totals

Select this option to show both Active and Inactive employees. 

Select this option to display a specific Division. 

Displays the time at which the item needing approval occurred. 

Code 

Reason 

Displays the Attendance Code for any infractions. (i.e., IL for In Late, OG for 
Out Graced, etc.). 

Displays the reason in color why the transaction is displayed in the Approval 
Editor 

Displays the number of infractions next to the label. 

Active Employees Select this option to show only Active employees. 

Inactive Employees Select this option to show only Inactive employees.

Group Select this option to display a specific Group.

The Approval Editor contains the following information: 

Setting Defintion

Absences 

Name Displays the employee's name. 

Missing 

All

Select this option to show only Absent Exceptions needing approval. 

Select this option to show only Missing Punch Exceptions needing approval. 

Select this option to show all Absences, Missing Punches and all other 
Exceptions. 

Number Displays the employee's number. 

DOW Displays the day of the week on which the item needing approval occurred. 

Date Displays the date on which the item needing approval occurred. 
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To edit a transaction from the Approval Editor, double-click the transaction you wish to change.  
The Online Timecard will open to display the pay period during which the transaction took place. 

Add, edit or delete the transaction as needed. For more information on these tasks, see Adding and 
Editing Transactions and Deleting a Transaction. 
The Schedules Tab and Transaction tab will also be available to view and edit.  See Employee 
Schedule Tab and the Employee Transactions Tab. 

200



Status Board 
The Status Board screen is a useful tool that displays the last punch recorded for each employee 
within a certain time range (for example, in the last 18 hours). This is an excellent way to find out 
the current whereabouts of your employees. The data displayed in the screen is for information 
purposes only and cannot be edited. 

NOTE: If an employee has not punched within the time range specified no data will appear next to 
his or her name.  

Click the Daily Operations menu, Status Board. The Status Board screen will open.  
You may select a specific type of status to view or select All to display each status available.

Timecard and Transaction Maintenance
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Print Button

Division

Data

All

Select a Division to only view employees assigned to that Division

Displays the code for any data that the employee was prompted to enter. 
For example, PRD1 for per diem, TIP1 For tips, etc.  

Hours Back 

Select this option to display all employees, regardless of whether they have 
punched within the Hours Back time range. 

Punches Select this option to display only employees who have punched within the 
Hours Back time range. 

No Punches Select this option to display only employees who have not punched within 
the Hours Back time range. 

Group Select a Group to only view employees assigned to that Group. 

Enter the number of hours in the past you wish TA100 Pro to look for the laEnter the number of hours in the past you wish TA100 Pro to look for the last 
punch. The default is 18 hours, indicating that the Status Board screen will 
show all transactions that have occurred in the last 18 hours. 

Print the Status Board report. 

Click Close to exit the Status Board window.

The Status Board screen contains the following information: 

Setting Defintion

Number

Date and Time Displays the date and time of the last punch recorded. 

Name 

Out, Working 
and Lunch   

Displays the number of the employee. 

Clock Displays the clock at which the punch occurred. 

Key Displays the function key on the clock pressed. 

Prompt Displays the prompt associated with the function key pressed. 

Displays the name of the employee. 

Explains the status of the employee.  Shows by displaying a colored square 
in the appropriate status box. 
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The Task Organizer  screen contains the following links: 

• Daily

• Monthly

• Annual

• Payroll

• System Setup

Timecard and Transaction Maintenance

Task Organizer 

The Task Organizer is an extremely useful tool that allows the user to walk through the necessary 
steps that should be performed for a specific period of time, such as Daily, Monthly, Annual, 
Payroll and System Setup.   

Click the Edit menu, Task Organizer. The Task Organizer screen will open.
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This  section  describes commands and  tasks  that  can be performed  for many employees at 
once. These  tasks  include  Global Message Assignment,  Transactions and  Details.  

The method of selecting employees is the same in nearly all of the Global Operation (as well as the 
Report Parameter) dialog boxes. For ease of use, the technique is described here and referenced in 
the instructions below. 
There are four ways to select employees: Individually, Globally, by Group, and by Division. 

Global Commands 

Selecting Employees in Global Operation Dialog Boxes 
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Global Commands 

Select Employees Individually 

Select the Employee you wish to choose.
Click the Add button. The employee will appear in the Selected list on the right. 

Select Employees Globally 
Click the Add All button. All employees will appear in the Selected list on the right.

Select Employees by Group 
Click the Group button. The Group Selection dialog box will open.

Use the drop-down to select in the From box to select the first Group you wish to choose.  

Use the drop-down to select in the To box to select the first Group you wish to choose. (TIP: To 
choose a single group, select the same Group in both boxes). 

Click OK to accept the changes and return to the dialog box. All employees in the selected Groups 
will appear in the Selected list on the right.
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Global Commands 

Select Employees by Division 

Click the Division button. The Division Selection dialog box will open.

Use the drop-down to select in the From box to select the first Division you wish to choose.  
Use the drop-down to select in the To box to select the first Division you wish to choose.

TIP: To choose a single Division, select the same Division in both boxes). 

Click OK to accept the changes and return to the dialog box. All employees in the selected Division will 
appear in the Selected list on the right. 

Global Message Assignment 
Global Message Assignment allows you to create a customized message that will display when 
employees punch at the clock. This is an easy way to send the same message to multiple employees at 
once. For example, you might send a message that says "Welcome" or display the employee's name 
after punching. 

Click the Daily Operations menu, Global, Message Assignment. The Global Message Assignment dialog 
box will open.
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Select the employee(s) to whom you wish to send the message using the techniques described 
above (see Selecting Employees in Global Operation Dialog Boxes). 

Click the Details button. The Global Message Assignment Details dialog box will open. 

Global Commands 

Select the clock(s) to which the message should be sent by click Add to select a single clock, or Add 
All to select all clocks. 

Check Default message to Employee name or enter the Message you wish to send. The Message can 
be up to 20 characters long (this is the maximum number of characters that can display on the LCD 
panel of the clock). 

Click OK to commit the changes and return to the Global Message Assignment dialog box. 

Click OK to send the message. The message will display to employees after it is uploaded to the clock. 

Click Close to exit the dialog box. 
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Select the employee(s) you wish to assign using the techniques described above (see Selecting 
Employees in Global Operation Dialog Boxes). 

Click the Punch button. The Global Add Transaction Details dialog box will open. 

Fill in the settings as described in the Adding and Editing Transactions section.
Click the OK button to commit the changes and return to the Global Add Transaction dialog box. 
Click OK again to complete the entry. 
Click Close to exit the dialog box. 

Global Commands 
Global  Add Transaction 
Global Add Transaction allows you to add a transaction of any type for multiple employees. This can 
be used to clock all employees out at a certain time, enter vacation or sick time for multiple 
employees, etc. 

Click the Daily Operations menu, Global, Transactions. The Global Add Transaction dialog box will 
open.
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Select the employee(s) you wish to assign using the techniques described above (see 
Selecting Employees in Global Operation Dialog Boxes). 

Click the Details button. The Employee Details dialog box will open. 

Select all areas that apply and that you want to assign for selected employees.   
Click the Close button to commit the changes and return to the Global Detail Assignment dialog box. 
Click OK again to complete the entry. 
Click Close to exit the dialog box. 

Global Commands 
Global Details 
Global Details allows you to assign employee details. This can be used to assign Divisions, Groups, 
Holiday Groups, Accrual Rule, and activate PC Clock.  

Click the Daily Operations menu, Global, Details. The Global Add Details dialog box will open.
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TA100 Pro has more than 300 available reports. In  the interest of brevity,  this section will focus 
on the concepts and techniques  associated  with running reports and listings rather than on 
the specifics of running every one of the reports.  

Listings are a type of report that "lists" the items and settings in your TA100 Pro database. 
Listings are good to print for reference information. Examples are listings of Departments, 
Policies, Rounding rules, Clocks, etc. 

Reports 

Important Information on Printing Reports 
TA100 Pro prints reports to the printer that is currently defined for the program under File, Print. By 
default, this is the same as the Windows default printer. If you wish to choose a different printer, 
you must make the change prior to running the report, as the Report Print command sends the 
report directly to the printer without prompting you to choose a printer. 

The following instructions describe how to change your TA100 Pro printer. 
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Reports 

Configure Printer 

Click the File menu, Print. The Print Setup dialog box will open.

• Period: Timecards, Who’s Scheduled, Coverage, and other Period oriented reports.

• Weekly: Weekly Hours, Attendance, Approaching Overtime, Weekly oriented reports.

• Daily: Who’s in, Who’s not in, Daily Hours, and other Daily oriented reports.

• Payroll Exports: Runs the Payroll Export.

• Listings: Lists and setup definitions for your TA100 Pro configuration.

Using the Name drop-down box, select the pre-defined printer to which you wish to print. 

Click OK to commit the changes and exit the dialog box. The TA100 Pro printer will be changed and 
reports will now print to it. 

Running a Report 
The basics of running reports are the same from report to report. Some reports may prompt for 
additional information that is particular to that specific report, but most have standard settings. 

The Reports are organized into categories to make them easier to find. The categories are: 

Most reports can be run by Range (allowing you to select a range of items or employees) or 
Individual (allowing you to selecting individual employees or groups of employees). Both methods 
are described below. 
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Click the Reports button to display the report categories. 
Select the category in which you wish to search. The Select Report list for that category will appear. 
NOTE:  The Location feature allows you to move a report from one report category to another. 

Select the report you wish to run. 
Select the Ranges option. 
Click the Run button. The Report Parameter Selection dialog box will open. 

Reports 

Running a Report by Range 
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Fill in the settings as appropriate: 

Reports 

Setting Defintion

Pay Period

Select

Period

Pay Periods Back

Policy

Start

Select this option to run the report for a pay period. You will need to fill in 
the rest of the pay period options that become available when the option is 
selected. 
Policy: Select the policy that contains the pay period definition you wish to 
use. 

Enter the number of pay periods in the past for which to run the report 
Verify the dates shown in the Start and Stop fields.  
TIP: Entering 0 will run the report for the current pay period. 

Click this button to select the Policy that contains the pay period definition 
you wish to use. 

Displays the number of the selected Policy 

Displays the pay period frequency (weekly, biweekly, etc.). 

Special Select this option to enter the date range manually. 

The purpose of this field changes depending upon which Date Range option 
has been chosen. 
If Special is chosen, enter the first date you wish to display on the report. 
If Pay Period is chosen, this field will display the first date of the selected 
pay period. 
If Yesterday or Today are chosen, this field will display Yesterday or Today's 
date. 
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Reports 

Setting Defintion

Divisions

Departments

Stop

Employees 

Select the Groups for which you wish to print the report. If you have chosen 
Range, select the starting and ending Groups. TA100 Pro will print employees 
in all Groups between the selected items (inclusive). 

Select the Divisions for which you wish to print the report. If you have 
chosen Range, select the starting and ending Division. TA100 Pro will print 
employees in all Divisions between the selected items 
(inclusive). 

Reprocess

Groups

Select the employees for whom you wish to print the report. If you have 
chosen Range, select the starting and ending employees. TA100 Pro will 
print all employees between the selected individuals (inclusive). 

The purpose of this field changes depending upon which Date Range 
option has been chosen. 
If Special is chosen, enter the last date you wish to display on the report. 
If Pay Period is chosen, this field will display the last date of the selected 
pay period. 
If Yesterday or Today are chosen, this field will display Yesterday or 
Today's date.

Yesterday Select this option to choose yesterday's date.

Check this box to reprocess punch information prior to running the report.  
NOTE: This significantly slows down the running of the report and is 
unnecessary if you already have AutoProcessing turned on. 

Select the Departments for which you wish to print the report. If you have 
chosen Range, select the starting and ending Departments. TA100 Pro will 
print employees in all Departments between the selected items 
(inclusive). 

Employees Select which type of employees you wish to be included on the report. 
Active: The report will print only Active employees. 
Inactive: The report will print only Inactive employees. 
Both: The report will print both Active and Inactive employees. 

Check All to indicate that you wish all items in a collection to be printed. 

Today Select this option to choose today's date. 

Forecasting Check this box to include hours forecasted from schedule (not worked yet) 
on the reports. 

All

Range Check Range to indicate that you wish to choose a range of items. 

Fill in the settings as appropriate: 
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When all settings are complete, click OK to proceed to the Additional Reporting Parameters dialog 
box. 

The Additional Parameters dialog allows you to further filter and group report data. Fill in the 
settings as appropriate: 

Reports 

Full Time/Part 
Time/Both 

Status

Hourly/Salary 

Permanent/
Temporary/Both

Setting Defintion

Select the setting by which you want employee records to sort. The options 
are Number (Employee ID Number) or Name. 

These settings allow you filter which employees' data will be printed. 

Check Full Time to print only employees whose Status is Full Time. 
Check Part Time to print only employees whose Status is Part Time. 
Check Both to print both Full Time and Part Time employees

Check Permanent to print only employees whose Status is Permanent. 
Check Temporary to print only employees whose Status is Temporary. 
Check Both to print both Permanent and Temporary employees. 

Sort By 

Check Hourly to print only employees whose Status is Hourly. 
Check Salary to print only employees whose Status is Salary. 
Check Both to print both Hourly and Salary employees. 

Select the setting by which you want employee records to group (organize). 
The options are None, Department, Division and Group. 

Group By 
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Reports 

Setting Defintion

Output To Select the media to which you wish to output the report. The options are: 
Screen: The report will preview on screen. You are then able to print from 
the preview. 
Printer: The report will be sent directly to the printer. 
File: The report will be sent to a FoxPro report file. 
Email: The report will be sent via email. If you choose this option, you will be 
given an additional screen to enter the email recipients. (See Emailing a 
Report). 
Email (Employee): Each employee included will be emailed only the portion 
of the report with their hours.  It is sent to the email address defined on the 
Employee Details tab. 

When all settings are complete, click the OK button to run the report. 

NOTE: Some reports may prompt for additional information particular to the specific report at this 
point. You may also be prompted for Email recipient information, if you choose to send the report via 
email. 

The report will output to your choice (Screen, Printer, File or Email.) 

After receiving the report, click the Close button until you have exited all the dialog boxes. 

Running a Report by Individual 

Click the Reports button  to display the report categories. 
Select the category in which you wish to search. The Select Report list for that category will appear. 

NOTE:  The Location feature allows you to move a report from one report category to another. 
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Highlight the report you wish to run. 
Select the Individuals option. 
Click the Run button. The Report Parameter Selection dialog box will open. 

Reports 
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Reports 

Fill in the settings as appropriate: 

Setting Defintion

Pay Period

Pay Periods Back

Select

Period

Policy

Start

Select this option to run the report for a pay period. You will need to fill in 
the rest of the pay period options that become available when the option is 
selected. 
Policy: Select the policy that contains the pay period definition you wish to 
use. 

Enter the number of pay periods in the past for which to run the report 
Verify the dates shown in the Start and Stop fields.  
TIP: Entering 0 will run the report for the current pay period. 

Click this button to select the Policy that contains the pay period definition 
you wish to use. 

Displays the number of the selected Policy 

Displays the pay period frequency (weekly, biweekly, etc.). 

Special Select this option to enter the date range manually. 

Stop

The purpose of this field changes depending upon which Date Range option 
has been chosen. 
If Special is chosen, enter the first date you wish to display on the report. If 
Pay Period is chosen, this field will display the first date of the selected pay 
period. 
If Yesterday or Today are chosen, this field will display Yesterday or Today's 
date. 

The purpose of this field changes depending upon which Date Range option 
has been chosen. 
If Special is chosen, enter the last date you wish to display on the report. 
If Pay Period is chosen, this field will display the last date of the selected 
pay period. 
If Yesterday or Today are chosen, this field will display Yesterday or 
Today's date.

Yesterday Select this option to choose yesterday's date.

Today Select this option to choose today's date. 
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Reports 

Reprocess Check this box to reprocess punch information prior to running the report.  
NOTE: This significantly slows down the running of the report and is 
unnecessary if you already have AutoProcessing turned on. 

Employees Select which type of employees you wish to be included on the report. 
Active: The report will print only Active employees. 
Inactive: The report will print only Inactive employees. 
Both: The report will print both Active and Inactive employees. 

Forecasting Check this box to include hours forecasted from schedule (not worked yet) 
on the reports. 

Setting Defintion

Select the employee(s) for whom you wish to run the report.  
There are four ways to select employees: Individually, Globally, by Group, and by Division. 

Double-click the Employee you wish to choose. The Employee will be added to the Selected list on 
the right.

Select Employees Globally 

Click the Add All button. All employees will appear in the Selected list on the right.

Select Employees by Group 

Click the Group button. The Group Selection dialog box will open.

Select Employees In Reports
Select Employees Individually 
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Use the drop-down to select in the From box to select the first Group you wish to choose.

Use the drop-down to select in the To box to select the first Group you wish to choose. (TIP: To 
choose a single group, select the same Group in both boxes).

Click OK to accept the changes and return to the dialog box. All employees in the selected Groups 
will appear in the Selected list on the right. 
Click the Division button. The Division Selection dialog box will open.

Reports 

Select Employees by Division 

Click the Division button. The Division Selection dialog box will open.

Use the drop-down to select in the From box to select the first Division you wish to choose.

Use the drop-down to select in the To box to select the first Division you wish to choose. (TIP: To 
choose a single Division, select the same Division in both boxes).

Click OK to accept the changes and return to the dialog box. All employees in the selected Divisions 
will appear in the Selected list on the right.
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When all settings are complete, click OK to proceed to the Additional Reporting Parameters dialog 
box. 

The Additional Parameters dialog box allows you to further filter and group report data. Fill in the 
settings as appropriate: 

Reports 

Full Time/Part 
Time/Both 

Status

Hourly/Salary 

Permanent/
Temporary/Both

Setting Defintion

Group By 

Select the setting by which you want employee records to sort. The options 
are Number (Employee ID Number) or Name. 

Select the setting by which you want employee records to group (organize). 
The options are None, Department, Division and Group. 

These settings allow you filter which employees' data will be printed. 

Check Full Time to print only employees whose Status is Full Time. 
Check Part Time to print only employees whose Status is Part Time. 
Check Both to print both Full Time and Part Time employees

Check Permanent to print only employees whose Status is Permanent. 
Check Temporary to print only employees whose Status is Temporary. 
Check Both to print both Permanent and Temporary employees. 

Sort By 

Check Hourly to print only employees whose Status is Hourly. 
Check Salary to print only employees whose Status is Salary. 
Check Both to print both Hourly and Salary employees. 
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When all settings are complete, click the OK button to run the report. 

NOTE: At this point some reports may prompt for additional information particular to that specific 
report. You may also be prompted for Email recipient information, if you choose to send a report via 
email. 

The report will output to your choice (Screen, Printer, File or Email.) 

After receiving the report, click the Close button until you have exited all the dialog boxes. 

Reports 

Output To Select the media to which you wish to output the report. The options are: 
Screen: The report will preview on screen. You are then able to print from 
the preview. 
Printer: The report will be sent directly to the printer. 
File: The report will be sent to a FoxPro report file. 
Email: The report will be sent via email. If you choose this option, you will be 
given an additional screen to enter the email recipients. (See Emailing a 
Report). 
Email (Employee): Each employee included will be emailed only the portion 
of the report with their hours.  It is sent to the email address defined on the 
Employee Details tab

Setting Defintion
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Reports 

On Screen Report Preview 
If you chose to output the report to Screen, a Report Preview window will open. This window will 
display the report as it will be printed and allows you to print directly from this window. 

Run the report of your choice, selecting Output to Screen. See Running a Report, The Report 
Designer window for the selected report will open to preview your report.
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Reports 

The Report Preview window contains several tool buttons. Reading from left to right, these are: 

Previous Page

First Page

Zoom 

Next Page

Setting Defintion

Click this button to print the report to the printer currently selected 
under File, Print. (See Important Information on Printing Reports). 

Click this button to navigate to the first page of a multi-page report. 

Print

Use this box to change the zoom percentage of the report to show more or 
less of the report on screen. 

Click this button to navigate to the previous page in a multi-page report. 

Go To Page Click this button to enter the page to which you wish to go. 

Click this button to navigate to the next page in a multi-page report. 

Last Page Click this button to navigate to the last page of a multi-page report.

Close Preview Click this button to exit the Report Preview 

Click the Close Preview button to exit the Report Preview screen. 
Click the Close button until you have exited all the dialog boxes.
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Reports 

Emailing A Report 
TA100 Pro allows you to email reports in Adobe Acrobat format using the email program currently 
configured on your computer. TA100 Pro will attach the report to an email and place it in the outgoing 
email queue of your email program.  Your email program will then be responsible for sending the 
email. The title of the email will be the same as the report you have chosen, and the text of the 
message will include the date and time at which the report was run. 

When you output a report to email, you will be asked to fill in the email addresses of the recipients.  

Run the report of your choice, selecting Output  to Email. (See Running   a  Report) The Email Recipients 
dialog box will open.
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When all recipients are added, click the OK button to send the email. You will see a "Processing email" 
message, but the email will not appear on screen. 

After the email is processed, click the Close button until you have exited all the dialog boxes. 

You can view the sent email from the sent mail folder of your email program (for example, MS 
Outlook's Sent Items folder. The email will appear something like this: 

Reports 
Fill in the settings as appropriate: 

Add Button 

Recipient List

Delete Button 

Edit Button 

Setting Defintion

Remove Button 

Displays a list of the recipients to whom you've sent reports to in the past. 

BCC Button

Click this button to delete an existing recipient's information. 

Click this button to add a new recipient. You will be prompted to enter the 
person's name and email address. 

Click this button to edit an existing recipient's information. You will be 
prompted to enter the person's name and email address. 

Click this button to remove a recipient added in error. 

CC Button 

To Button Click this button to add the selected recipient to the To: field of your email. 

Click this button to add the selected recipient to the CC: (Carbon Copy) field 
of your email. 

Click this button to add the selected recipient to the BCC: (Blind Carbon 
Copy) field of your email. 
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This  section covers  the concepts and  tasks  associated with setting up clocks.  For each clock, 
the following parameters must be defined: 

• Communication Type (RS232, RS485, or Ethernet)

• PC Comm Port used for communication

• Baud Rate

• Default Levels

• Bell Schedule (if applicable)

Terminal Configuration
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Terminal Configuration

Types of Connections 
Synel Americas clocks are capable of communicating in one of three different ways: 

• The Direct or RS-232 serial port solution is designed for a single, short-range terminal. The
terminal should not be placed beyond 50 feet of shielded wire from a PC. Each terminal requires
its own serial connection to a PC using an RS-232 serial port.

• The LAN or RS-485 solution is designed for a direct connection, long-range, single or multi-
terminal system. RS-485 allows up to 32 terminals to be networked to one PC serial port,
creating a Local Area Network (LAN). Each terminal is connected to a LAN distribution box.
These boxes connect to the Polling PC with two conductor-shielded cable. The total length of
the serial connection can be as much as 5000 feet (almost 1 mile). Each terminal is identified
using a unique ID.

NOTE: The computer that polls the clocks will need a modem in order to call the clock. Synel 
Americas recommends U.S. Robotics modems, as they are capable of communicating with the clock 
at the 1200 and 2400-baud rates required. 

• The Ethernet connection is designed for Local or Wide Area Networks using the TCP/IP protocol.
The terminal is connected to the network through a hub, just like any other computer on the
network.

As part of the configuration of the clock, you will choose the type of connection for each clock. The 
configuration dialog box will prompt you for information specific to the type of connection you have 
chosen. 

TA777/A  &   TA785  Series 
Configuration of the TA777 /A  Series (including  TA777  /A  and   TA785   Series) time clocks is virtually 
identical. For this reason, they are combined into one section.  

Since multiple clocks can be defined in the TA100 Pro, a copy feature is available to copy an existing 
clock’s parameters when adding a new clock. This eliminates the need to re-enter an entirely new 
clock configuration. 
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The General tab defines the communication and general operation settings and contains the 
following information: 

Terminal Configuration

Configure a TA777/A /TA785 Series Clock 
Click the Communications menu, Configure, TA777/A or TA785. The Configure Clock dialog box 
will open. The dialog box contains several tabs, all of which are described below.

Description

Code

Setting Defintion

This is a required field.  Enter a unique code (up to 4 characters) to identify 
the clock. Once defined, this code cannot be changed. 

Active Click the Active check box to indicate that the clock is currently in use. 
Uncheck this box if the clock is not being used at this time. 

Enter a description of the clock. This description will be seen in the system 
and on reports. This field can be used to describe the clock type and it’s 
location in your facility (i.e. TA715 In BUILDING TWO). The clock description 
can be up to 30 characters long. 
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Terminal Configuration

Setting Defintion

Phone Number 

Baud Rate

Readers None or 
Finger 

IP Address 

Lan

THIS WILL ONLY SHOW FOR THE TA780 SERIES
 Only select finger if the clock will accept fingerprints. 

Port Select the communications port on your computer that will be used 
to communicate with the clock. The factory default is COM 1.

LAN ID

Baud Rate 

Serial Baud 

IP Port 

Ethernet

This is the Direct connection (RS232) in the Communication Path field. 
• RS232 Baud = 19200 for all clocks

Path Select the type of connection this clock will use. The options are: 
Direct (RS232), LAN (RS485) and Ethernet (External)
For more information on these connections, see Types of Connections, page 
198.

These settings become available when LAN has been chosen as the 
communication type in the Communication Path field. 

The default is 19200 baud. Make sure the baud rate selected here matches 
the baud rate defined at the clock.  All clocks use 19200 for LAN.   

Enter the clock’s unique identification number in this field. This number 
provides a way for the system to distinguish between individual clocks. Any 
one-character (alphabetic or numeric) ID may be used. Make sure the LAN 
ID defined here matches the LAN ID defined at the clock.  

These settings define how an Ethernet clock will communicate with 
TA100Pro. 

Enter the IP address assigned to the timeclock.  DO NOT enter leading zeros. 

Displays the port the timeclock will talk to the computer on.  The default is 
3734.  If changed, must also be changed in the clock or communication 
failure will occur.  

Select the modem’s communication speed. Make sure the baud rate 
selected here matches the baud rate defined at the clock. 

Enter the phone number the PC modem must dial to communicate with this 
clock. The number must be entered in the following format: 
Outside Line Access Code, Wait Symbol, Area Code, Phone Number
If no outside line is required (such as 9), simply enter the phone number. 
Omit the area code if not applicable. On most modems, the wait symbol is a 
comma (,) typically representing a one second pause. Multiple wait symbols 
can be used if necessary. 

230



Terminal Configuration
Setting Defintion

 Default Time 

Start/Stop 
Answer

Swipe 

Check the applicable check box(es) to indicate the method by which an 
employee badge number is entered into the clock. 

The employee's badge number can be entered by swiping a badge. 

Division

Number of Retries

Ring Delay

Time Difference 
Between 
Computer and 
Clock 

Input

Supervisor

Default Date

These fields control the time of day the clock’s internal modem will answer 
an incoming call. Enter the modem’s start and stop answer time in military 
format (HH:MM).  
For example, to set the modem to answer only between 7:00 A.M. and 6:00 
P.M., enter 07:00 and 18:00 in the fields provided. The default is 00:00
(midnight) and 23:59 (one minute before midnight). In other words, the
modem will answer any time it is called during the day.

Enter the number of rings that the clock should wait before picking up the 
line.  
For example, setting the Ring Delay to 4 means that after the clock detects a 
ringing phone; it will wait 4 rings before answering. 0 means DO NOT 
ANSWER. 

Enter the number of times the computer should attempt to connect to the 
clock if communication either fails or is interrupted during polling

Enter the time difference (in hours) between the computer and time clock. 
Since the computer can set the clock’s time, this field compensates for time 
zone differences between the computer’s location and the clock’s location. 
When the clock’s time is set, the system either adds or subtracts this time 
difference from the computer’s clock.  
A setting of 0 indicates that the clock and computer are in the same time 
zone. 

Select the company division where the clock is located. Every transaction 
entered on this clock is tagged with this division code. 

These options define supervisor settings for the clock. 

Check this box to automatically use the clock’s current date for transactions 
added using a supervisor’s badge. When this check box is clear, the clock 
prompts the supervisor for the date of any new transactions. 

Check this box to automatically use the clock’s current time for transactions 
added using a supervisor’s badge. When this check box is clear, the clock 
prompts the supervisor for the time of any new transactions. 

These settings determine how data can put entered into the clock. 

 Initial Source 

Key The employee's badge number can be entered by pressing keys on the clock 
keypad. 
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The Configure tab defines the message and timeout settings and contains the following information: 

Terminal Configuration

Employee Badge 
Source By 
Supervisor 

Bar Code

Setting Defintion

Bar Code 

Swipe

Key

The employee's badge number can be entered by scanning a bar code.  
Must also select the type of Bar Code badge. 

Check the applicable check box(es) to indicate the method by which a 
supervisor (in supervisor mode) can enter employee badge number into the 
clock. 

The employee's badge number can be entered by swiping a badge. 

The employee's badge number can be entered by pressing keys on the 
clock keypad. 

The employee's badge number can be entered by scanning a bar code.  
Must also select the type of Bar Code badge

For Data Input

Time-Outs 

Setting Defintion

These settings determine how long prompts and messages will appear on 
the clock's screen. 

Enter the length of time (from 0.1 to 99.9 seconds) the clock will wait for a 
response to a prompt before returning to an idle state.  
Time is entered in seconds and tenths of a second. For example, 10.0 means 
that the clock will wait 10 seconds for a response after prompting for input. 
The default is 60.0 seconds. 
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Terminal Configuration
Setting Defintion

To Enter function 

 Invalid Level 

Messages

Supervisor 
Questions 

Displayed 
Messages  

Error Messages

Invalid Badge 

Enter Function

Invalid Source

This field allows you to replace the standard INVALID BADGE message with 
a custom message (up to 16 characters in length).  
An INVALID BADGE message displays when a badge or card other than the 
specified badge length is used. 

Enter the length of time (from 0.1 to 99.9 seconds) the clock will wait for a 
response to enter a function before returning to an idle state.  
Time is entered in seconds and tenths of a second. For example, 5.5 means 
that the clock will wait 5½ seconds for a response after prompting for input. 
The default is 20.0 seconds. 

Enter the length of time (from 0.1 to 99.9 seconds) the clock will display any 
message before returning to an idle state.  
Time is entered in seconds and tenths of a second. For example, 1.5 means 
that the clock will display messages for 1½ seconds. The default is 2.0 
seconds. 

Enter the length of time (from 0.1 to 99.9 seconds) the clock will wait for a 
response to a supervisor question before returning to an idle state.  
Time is entered in seconds and tenths of a second. For example, 30.0 means 
that the clock will wait 30 seconds for a supervisor’s response to a question 
such as “Employee Badge #”. The default is 90.0 seconds. 

Enter the length of time (from 0.1 to 99.9 seconds) the clock will wait for a 
response to a supervisor question before returning to an idle state.  
Time is entered in seconds and tenths of a second. For example, 1.0 means 
that the clock will display error messages for one second. The default is 1.5 
seconds. 

These settings define the text prompts for certain operations at the clock. 

This field allows you to replace the default ENTER FUNCTION message with 
a custom message (up to 16 characters in length).  
This message is displayed after swiping a badge or entering a badge 
number at the clock. 

This field allows you to replace the standard INVALID SOURCE message 
with a custom message (up to 16 characters in length). 
This message will display when an input source is used that the terminal has 
been programmed to ignore. For example, the employee uses a magnetic 
strip badge to punch In when only keypad entry is recognized. 

This field allows you to replace the default INVALID LEVEL message with a 
custom message.  
This message is displayed when Validation is used, and an invalid level 
number is entered. It cannot be more than 16 characters. 
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NOTE:  This tab will only apply to  TA785 Clocks using the fingerprint option. The Assignments tab 
lists the employees that can use this clock.  This is only necessary if you are using fingerprints with 
TA785 clocks.

Terminal Configuration

Setting Defintion

Idle Message 

Download Bell 
Schedule 

Proximity Offset to 
Remove Facility Code 

Turn Off 
Function Keys 

Use Swipe & Go 

Display Idle Time in 
Military Format  

234

Skip 
Recording 

Enter the message text that displays on the time clock when in an idle state. 
If this field is left blank, no message will be displayed. 
It can accept a one-line message that is up to 16 characters.  

Select this feature to activate swipe and go in the clock. 
NOTE: The Swipe & Go feature is enabled in the Main Company 
configuration screen. See Main Company.  

Select this feature if the clock will only be used as Swipe & Go.  This feature 
disables all function key access at the clock. 

Check this box to skip recording the Diagnostic aCheck this box to skip recording the Diagnostic and Programming 
information that display on the Diag Info and Prog Info tabs. 
These two files are created and written to each time a clock is 
communicated with and programmed using TA100 Pro. This information is 
used for troubleshooting communication problems. These files slow the 
polling process down, although not noticeably, and can be turned off by 
checking the box. 
NOTE: Turning off these files will make it difficult to troubleshoot certain 
communication problems. 

Click this check box to display the clock’s idle time in military format (i.e. a 
24-hour format). Clear this box to display the clock’s idle time in standard 
format (i.e. a 12-hour clock). In both cases, the time is displayed using the 
HH:MM:SS format.

Enter the number of characters defining the Facility code the proximity 
badge should not read.

Check this box to download a pre-defined Bell Schedule to this clock.  TCheck this box to download a pre-defined Bell Schedule to this clock.  This 
option is only available with the Bell Schedule module.



The tab contains the following information: 

Terminal Configuration

Setting Defintion

Employee Listing 

Add

Fingerprint Mode 

Add All

Remove All 

Group 

Displays a list of the employees that can use this clock.  Includes: employee 
code, employee name, employee badge number, special enrollment and if 
they have a fingerprint template saved.  

Verify + Identify – Allows the employee to enter their badge number and the 
clock will only check the template for the badge number specified (Verify) 
or just place their finger on the reader and the clock will attempt to identify 
who the employee is by checking against all templates in the clock 
(Identify). 
Identify – The clock will attempt to identify who the employee is by checking 
against all templates in the clock.  This is a 1 to many validation. 

Click this button to select employees based on Division. Employees selected 
are assigned the default Authority and Verification automatically. 

Click this button to select employees based on Group. Employees selected 
are assigned the default Authority and Verification automatically. 

Click this button to remove all employees currently assigned to the clock.

Click this button to assign all employees to the clock. Employees selected 
are assigned the default Authority and Verification automatically. 

Click this button to select employees individually. 
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Terminal Configuration

SY-900  Series 
Configuration of the SY-900  Series, time clocks is virtually identical. For this reason, they are 
combined into one section.  
Since multiple clocks can be defined in the TA100 Pro, a copy feature is available to copy an 
existing clock’s parameters when adding a new clock. This eliminates the need to re-enter an 
entirely new clock configuration. 

Configure a SY-910  Series Clock 
Click the Communications menu, Configure, SY-910. The Configure Clock dialog box will open. 
The dialog box contains several tabs, all of which are described below.
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Terminal Configuration

The General tab defines the communication and general operation settings and contains the 
following information: 

Setting Defintion

Code

Description 

Active

This is a required field.  Enter a unique code (up to 4 characters) to identify 
the clock. Once defined, this code cannot be changed.

Enter a description of the clock. This description will be seen in the system 
and on reports. This field can be used to describe the clock type and it’s 
location in your facility (i.e. SY910 In BUILDING TWO). The clock description 
can be up to 30 characters long. 

Click the Active check box to indicate that the clock is currently in use. 
Uncheck this box if the clock is not being used at this time. 

Communication 

Time Difference 
Between Computer 
and Clock 

Division 

Number of Retries

Password Enter a password to be used at the clock. 

Enter the time difference (in hours) between the computer and time clock. 
Since the computer can set the clock’s time, this field compensates for time 
zone differences between the computer’s location and the clock’s location. 
When the clock’s time is set, the system either adds or subtracts this time 
difference from the computer’s clock. 
A setting of 0 indicates that the clock and computer are in the same time 
zone. 

Select the company division where the clock is located. Every transaction 
entered on this clock is tagged with this division code. 

IP Port 

 IP Address  

These settings define how an Ethernet clock will communicate with TA100 
Pro. 

Enter the IP address assigned to the Etherlink converter.  DO NOT enter 
leading zeros. 

Displays the port the timeclock will talk to the computer on.  The default is 
3734.  If changed, must also be changed in the clock or communication 
failure will occur. 

Enter the number of times the computer should attempt to connect to the 
clock if communication either fails or is interrupted during polling.
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The Assignments tab lists the employees that can use this clock.  This is required for using a 
biometric clock. 

Terminal Configuration

The tab contains the following information: 

Setting Defintion

Employee 
Listing 

Division 

Auto Assign New 
Templates to this 
and Other Clocks

Displays a list of the employees that can use this clock.  Includes: employee 
code, employee name, employee badge number, special enrollment and if 
they have a template saved.  

Click this button to select employees based on Division. Employees selected 
are assigned the default Authority and Verification automatically. 
NOTE: If you use this method to choose employees, you may want to Edit 
the employee in order to choose another Authority and Verification. 

Click this button to select employees based on Group. Employees selected 
are assigned the default Authority and Verification automatically. 
NOTE: If you use this method to choose employees, you may want to Edit the 
employee in order to choose another Authority and Verification. 

Check this box to auto assign new templates to this and other clocks 
automatically. 

Group
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Terminal Configuration

The tab contains the following information: 

Setting Defintion

Send Only Templates 
that are Not Already 
in the Clock 

Remove All 

Add Click this button to select employees individually. You will be prompted to 
select the following: 

Authority: The Authority Level defines which clock menus employee can 
view or use at the clock. The following options are available:  Employee, 
Supervisor or Configuration.   

Verification:  The Verification Level defines the false read threshold. 

Check this box to send only templates that are not already in the clock. 

Click this button to remove all employees currently assigned to the clock. 

Add All Click this button to assign all employees to the clock. Employees selected 
are assigned the default Authority and Verification automatically. 
NOTE: If you use this method to choose employees, you may want to Edit the 
employee in order to choose another Authority and Verification. 

Configuring  PC  Clock
Configuration of the PC Clock is done under the TA600 Series time clock.  The PC Clock can use 
Messaging. 

Since multiple clocks can be defined in the TA100 Pro, a copy feature is available to copy an existing 
clock’s parameters when adding a new clock. This eliminates the need to re-enter an entirely new 
clock configuration. 
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The General tab defines the communication and general operation settings and contains the 
following information: 

Terminal Configuration
Configure a PC Clock 

Click the Communications menu, Configure, TA600. The Configure Clock dialog box will open. The 
dialog box contains several tabs, all of which are described below.

Description 

Code 

Setting Defintion

Active 

This is a required field.  Enter PC for this code. 

In this field enter PC Clock for the description. 

Click the Active check box to indicate that the clock is currently in use. 
Uncheck this box if the clock is not being used at this time. 

Initial Source Check the applicable check box(es) to indicate the method by which 
an employee badge number is entered into the clock. 

Swipe The employee's badge number can be entered by swiping a badge. 

Key

Bar Code 

The employee's badge number can be entered by pressing keys on the clock 
keypad. 

The employee's badge number can be entered by scanning a bar code.
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Terminal Configuration

The Configure tab defines the message and timeout settings and contains the following information: 

Setting Defintion

Time-Outs 

For Data Input 

These settings determine how long prompts and messages will appear on 
the clock's screen. 

Enter the length of time (from 0.1 to 99.9 seconds) the clock will wait for a 
response to a prompt before returning to an idle state.  
Time is entered in seconds and tenths of a second. For example, 10.0 means 
that the clock will wait 10 seconds for a response after prompting for input. 
The default is 60.0 seconds 

To Enter 
Function

Enter the length of time (from 0.1 to 99.9 seconds) the clock will wait for a 
response to enter a function before returning to an idle state.  
Time is entered in seconds and tenths of a second. For example, 5.5 means 
that the clock will wait 5½ seconds for a response after prompting for input. 
The default is 20.0 seconds. 
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Terminal Configuration

Supervisor 
Questions   

Displayed 
Messages 

Enter the length of time (from 0.1 to 99.9 seconds) the clock will display any 
memessage before returning to an idle state.
Time is entered in seconds and tenths of a second. For example, 1.5 means 
that the clock will display messages for 1½ seconds. The default is 2.0 
seconds.  

Enter the length of time (from 0.1 to 99.9 seconds) the clock will wait for a 
reresponse to a supervisor question before returning to an idle state.
Time is entered in seconds and tenths of a second. For example, 30.0 means 
that the clock will wait 30 seconds for a supervisor’s response to 
a question such as “Employee Badge #”. The default is 90.0 seconds 

Setting Defintion

 Enter Function 

Error Messages

Messages 

Enter the length of time (from 0.1 to 99.9 seconds) the clock will display any 
error message before returning to an idle state.  
Time is entered in seconds and tenths of a second. For example, 1.0 means 
that the clock will display error messages for one second. The default is 1.5 
seconds. 

These settings define the text prompts for certain operations at the clock. 

This field allows you to replace the default ENTER FUNCTION message withThis field allows you to replace the default ENTER FUNCTION message with  
a custom message (up to 16 characters in length).  
This message is displayed after swiping a badge or entering a badge 
number at the clock.
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Configure a SYnergy  Series  Clock 
Click the Communications menu, Configure, SYNERGY. 
The Configure Clock dialog box will open. The dialog box contains several tabs, all of which are 
described below.

The General tab defines the communication and general operation settings and contains the 
following information: 

Terminal Configuration

Setting Defintion

Code

Readers None or 
Finger 

Active 

Description

This is a required field. Enter a unique code (up to 4 characters) to identify 
the clock. Once defined, this code cannot be changed.

Enter a description of the clock. This description will be seen in the 
system and on reports. This field can be used to describe the clock type 
and it’s location in your facility (i.e. SYnergy In BUILDING TWO). The clock 
description can be up to 30 characters long. 

Click the Active check box to indicate that the clock is currently in use. 
Uncheck this box if the clock is not being used at this time. 

Select Finger if the employees will be using fingerprints to punch. 
Select None if the employees will be using badges or the keypad to punch.
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Terminal Configuration

Setting Defintion

Communication

Bar Code

Employee Badge 
Source By 
Supervisor 

Initial Source 

Time Difference 
Between Clock  
and Computer 

Enter the time difference (in hours) between the computer and time clock. 
Since the computer can set the clock’s time, this field compensates for time 
zone differences between the computer’s location and the clock’s location. 
When the clock’s time is set, the system either adds or subtracts this time 
difference from the computer’s clock. 
A setting of 0 indicates that the clock and computer are in the same time 
zone. 

Division 

IP Address

Check the applicable check box(es) to indicate the method by which an 
employee badge number is entered into the clock.

SFTP Port

These settings define how an Ethernet clock will communicate with 
TA100Pro. 

Enter the IP address assigned to the clock DO NOT enter leading zero

Displays the secure FTP port the timeclock will talk to the computer on. 
The default is 3735. If changed, must also be changed in the clock or a 
communication failure will occur.

Select the company division where the clock is located. Every transaction 
entered on this clock is tagged with this division code. 

These settings determine how data can put entered into the clock. Input 

Swipe The employee's badge number can be entered by swiping a badge. 

Key The employee's badge number can be entered by pressing keys on the clock 
keypad. 

The employee's badge number can be entered by scanning a bar code. Must 
also select the type of Bar Code badge. 

Check the applicable check box(es) to indicate the method by which a 
supervisor (in supervisor mode) can enter employee badge number into the 
clock. 

Swipe The employee's badge number can be entered by swiping a badge.

The employee's badge number can be entered by pressing keys on the clock 
keypad. 

Key
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The Configure tab defines the message, function key and other settings. It contains the following 
information: 

Terminal Configuration

Setting Defintion

Messages

Invalid Source 

Enter Badge 

Invalid Badge 

These settings define the text prompts for certain operations at the clock. 

This field allows you to replace the default ENTER BADGE  message with a 
custom message (up to 16 characters in length). 
This message is displayed after swiping a badge or entering a badge number 
at the clock. 

This field allows you to replace the standard INVALID SOURCE message with 
a custom message (up to 16 characters in length). 
This message will display when an input source is used that the terminal has 
been programmed to ignore. 
For example, the employee uses a magnetic strip badge to punch In when 
only keypad entry is recognized. 

This field allows you to replace the standard INVALID BADGE message with 
a custom message (up to 16 characters in length). 
An INVALID BADGE message displays when a badge or card other than the 
specified badge length is used. 
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Terminal Configuration

Setting Defintion

Invalid Level 

Proximity Offset to 
Remove Facility Code

Use Swipe & Go 

Display Idle Time in 
Military Format 

Turn Off 
Function Keys 

This field allows you to replace the default INVALID LEVEL message with a 
custom message. 
This message is displayed when Validation is used, and an invalid level 
number is entered. It cannot be more than 16 characters. 

Select this feature to activate swipe and go in the clock. 
NOTE: The Swipe & Go feature is enabled in the Main Company configuration 
screen. See Main Company. 

Select this feature if the clock will only be used as Swipe & Go. This feature 
disables all function key access at the clock. 

Click this check box to display the clock’s idle time in military format (i.e. a 
24-hour format). Clear this box to display the clock’s idle time in standard
format (i.e. a 12-hour clock). In both cases, the time is displayed using the
HH:MM:SS format.

Enter the number of characters defining the Facility code the proximity 
badge should not read. 
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The tab contains the following information: 

Terminal Configuration

Setting Defintion

Employee 
Listing 

Add

Displays a list of the employees that can use this clock. Includes: employee 
code, employee name, employee badge number, special enrollment and if 
they have a fingerprint template saved. 

Division Click this button to select employees based on Division. Employees selected 
are assigned the default Authority and Verification automatically. 

Remove All Click this button to remove all employees currently assigned to the clock. 

Click this button to delete employees individually. 

Group Click this button to select employees based on Group. Employees selected 
are assigned the default Authority and Verification automatically. 

Add All Click this button to assign all employees to the clock. Employees selected 
are assigned the default Authority and Verification automatically. 

Click this button to add employees individually. 

Remove
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The screen contains the following information: 

Terminal Configuration

248

Setting Defintion

Assignment 
Details    

Badge

Supervisor to  Enroll 
Templates 

Special Enroll 

Displays a list of how many templates have been enrolled for the employee 
and allows all templates to be deleted.

Allows user to select the badge that will be sent down to the clock if an 
employee was assigned multiple badges  

When enabled this setting will allow the employee to bypass the fingerprint 
and only enter the badge number  when punching. 
Click this button to select employees based on 

When enabled this setting will allow the employee to enroll other employees 
at the clock. 



Terminal Configuration
Hand Reader Clocks 
The Hand Reader biometric terminals are powerful computers capable of Hand Geometry 
recognition. These devices collect clock data for TA100 Pro. 

NOTE:  Hand Reader Clocks are not Third Party Terminals; therefore they do not require a separate 
module. 

Configure a Hand Reader Clock 
Click the Communications menu, Configure, Hand Reader. The Configure Clocks dialog box will open. 
The Configure dialog box contains several tabs, all of which are described below.

The General tab configures communication settings and contains the following information: 
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Terminal Configuration
Setting Defintion

Code 

Time Difference 
Between Clock and 
Computer

ID

IP Port 

RS485 or Serial 

Comm Port

Model

Active

IP Address 

Select the communications port on your computer that will be used to 
communicate with the clock. The factory default is COM 1.

Description 

Idle Prompt 

This is a required field. Enter a unique code (up to 4 characters) to identify 
the clock. Once defined, this code cannot be changed. 

Enter a unique ID number to identify the clock. This number will also be 
programmed into the clock. 

Enter a description of the clock. This description will be seen in the system 
and on reports. This field can be used to describe the clock type and it’s 
location in your facility (i.e. HP3000 In BUILDING TWO). The clock description 
can be up to 30 characters long 

Click the Active check box to indicate that the clock is currently in use. 
Uncheck this box if the clock is not being used at this time. 

Select the model of your Hand Reader unit. The options: HP1000/50E, 
HP2000, HP3000 and HP4000

Enter the message text that displays on the time clock when in an idle state. 
If this field is left blank, no message will be displayed. 

Select this option to choose an RS485 or RS232 connection.

Select this option to choose an Ethernet solution. Ethernet 

Select the applicable communication speed. Make sure the baud rate 
selected here matches the baud rate defined at the clock. 
Rs485, Serial and Ethernet: 9600 baud

Baud Rate

Retries Enter the number of times the computer should attempt to connect to the 
clock if communication either fails or is interrupted during polling. 

Enter the IP address assigned to the Etherlink converter. 

Displays the port used for Ethernet. The default is 3001 and should not be 
changed. Altering this number will result in communication failure.  

Enter the time difference (in hours) between the computer and time clock. 
Since the computer can set the clock’s time, this field compensates for time 
zone differences between the computer’s location and the clock’s location. 
When the clock’s time is set, the system either adds or subtracts this time 
difference from the computer’s clock.  
A setting of 0 indicates that the clock and computer are in the same time 
zone. 

Division Select the company division where the clock is located. Every transaction 
entered on this clock is tagged with this division code.  
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The Assignments tab lists the employees that can use this clock. This is necessary because the Hand 
Reader clocks take measurements of an employee's hand. Each time the employee punches, the 
reader compares the employee’s hand to the existing template. Employee information and hand 
templates are stored in the Hand Reader clock. For this reason, employees must be assigned to a 
clock so their name and template will be downloaded to the correct clock. 

Terminal Configuration

The tab contains the following information: 

Setting Defintion

Employee Listing 

Division 

Displays a list of the employees that can use this clock.  Includes: employee 
ID, employee name, employee badge number, assigned time zone, personal 
reject threshold, authority level, and if they have a hand template saved.  

Click this button to select employees based on Division. Employees selected 
are assigned the default Time Zone, Reject Threshold, and Authority 
automatically. 
NOTE: If you use this method to choose employees, you may want to Edit the 
employee in order to choose another Time Zone, Reject Threshold, and 
Authority Level. 
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Terminal Configuration

Setting Defintion

Remove All 

Add All 

Add 

Group Click this button to select employees based on Group. Employees selected 
are assigned the default Time Zone, Reject Threshold, and Authority 
automatically. 
NOTE: If you use this method to choose employees, you may want to Edit the 
employee in order to choose another Time Zone, Reject Threshold, and 
Authority Level.

Click this button to remove all employees currently assigned to the clock. 

Click this button to assign all employees to the clock. Employees selected 
are assigned the default Time Zone, Reject Threshold, and Authority 
automatically. 
NOTE: If you use this method to choose employees, you may want to Edit the 
employee in order to choose another Time Zone, Reject Threshold, and 
Authority. 

Click this button to select employees individually. You will be prompted to 
select the following: 
Time Zone: Select the Time Zone (defined on the previous tab) that applies to 
this employee. 
Reject Override: The reject threshold indicates how closely the hand has to 
match the original scanned hand template. The lower the number, the more 
exact the match needs to be. 
0 is default and indicates that the default clock threshold (set on the 
Miscellaneous tab) will be used. 
Authority Level: The Authority Level defines which clock menus employee 
can view or use at the clock. 0 is the lowest (employee) and default, 5 is the 
highest and allows complete at-the-clock setup (supervisor). 
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Terminal Configuration
Add a Clock 
Click the Communications menu, Configure, and select the type of clock you wish to add. The 
Configure Clock dialog box will open.

Click the Add button. If this is the first clock of this type that you are adding, the General tab will 
become available.

Fill in the settings as described in the Configure section for the type of clock you are adding.  
Synergy, 900 series, 700s, Hand Reader, PC Clock
If there is already a clock of this type defined, the Default Clock Add dialog box will open. 
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Terminal Configuration

Highlight the clock whose settings you would like to copy or click No to start from scratch. 
Enter a unique code for this clock, up to four characters. 

Enter a Description of the clock (i.e., Warehouse, Back Office, California, etc.) 

Click the Yes button to continue. You will be returned to the General tab. 

Fill in the settings as described in the Configure section for the appropriate clock. 

When all settings are complete, click OK to commit the changes.

Edit a Clock 
Click the Communications menu, Configure and select the type of clock you wish to edit. The 
Configure Clock dialog box will open.
Highlight the Clock you wish to edit using the drop-down list at the top of the screen. 
Click the Edit button. The General screen will become available for you to edit the selected category. 
Edit the settings as described in the Configure Clock section for the clock you are editing. 
When all settings are complete, click OK to commit the changes. 
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Terminal Configuration
Delete a Clock 
Click the Communications menu, Configure and select the type of clock you wish to edit. The 
Configure Clock dialog box will open. 
Highlight the Clock you wish to edit using the drop-down list at the top of the screen. 
Click the Delete button. You will be prompted: 

Click OK to confirm the deletion. 
Click Close to exit the Configure Clock dialog box. 

Set Date and Time 
The Set Date and Time function synchronizes the date and time of the terminals with the computer 
that is running the software. You can set the date and time on one or more clocks. However, all clocks 
must be defined in Clock Maintenance before the date and time is set. 

Before using this function, the host computer must be set to the correct date and time. Otherwise, all 
clock transactions will have an incorrect date and time stamp (although admittedly they'll all be 
synchronized). 

NOTE: It is recommended that you do not perform this function during periods of high clock activity 
(such as the start of day when employees are clocking In).  

Click the Communications menu, Set Date and Time. The Set Date and Time Clock Selection dialog 
box will open.
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If necessary, edit the date and time to be accurate and click OK. 
Click the Set Time button to commit the changes. 
When TA100 Pro has finished sending the Date and Time to clock, click Close to exit the dialog box. 

Terminal Configuration

Select the clock(s) for which you wish to set the date and time by using the Add button to add the 
selected clock individually, or Add All to add all clocks. 

Click the Date/Time button to display the Windows Date/Time Properties dialog box. 
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This section describes the concepts and techniques associated with polling clocks and setting 
up  Auto  Processes. 

Polling is the process of communicating data to   and from   the clock,  including transferring 
employee time transactions and other data from  the  clocks  to  the host  computer (PC)  for 
processing. Clocks can   be  manually  polled  or automatically  polled  on   a   pre-defined schedule. 

Auto Processing  allows certain common  tasks  to be   run automatically.  Polling,  Reports, custom 
files, and  Reindexing can set to Auto Process. 

Polling  
Polling Time  Clocks 
Polling is the process of communicating data back and forth between the clock and TA100 Pro. 
Polling can be done manually, which means a supervisor or administrator must launch the TA100 Pro 
software and request that the clock be polled. Polling may also be set as an auto process, which 
means that the TA100 Pro is responsible for communicating with the clock on a pre-defined 
schedule. 

This section describes how to poll the clock manually. 

Click the Communications menu, Poll. The Poll Clock Selection dialog box will open.

Select the clock(s) you wish to poll by using the Add button to add the selected clock individually, or 
the Add All button to add all clocks. 

Terminal Polling & Auto Processing 
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Terminal Polling & Auto Processing 
Click the Polling Options tab to select it. Fill in the settings as appropriate: 

Setting Defintion

Poll Transactions 

Clear Clock 
Transactions 

Set Clock Date 
and Time 

Check this option to transfer punches from the clock to TA100 Pro. 

Program Clock 

Check this option to clear the transactions from the clock after transferring 
them to TA100 Pro. Hand Readers always clear transactions whether the 
box is checked or not
TIP: This does not need to be done every time.  You may leave the 
transactions in the clock until payroll is processed successfully, however if 
you have a lot of employees you will want to clear frequently so the clock 
does not get full. 

Check this option to send the computer's current date and time to the clock. 
TIP: You may not want to do this every time, as the clock's internal clock 
tends to be much more accurate that the computer's. 

Check this option to send programming and configuration information (such 
as the settings in the Configure Clock dialog box) to the clock. Clock 
function keys and function messages are sent to the clock during 
programming. This option should only be used when basic clock setup has 
been changed since the initial programming.  
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Terminal Polling & Auto Processing 
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Process Punches 
After Polling 

Readers

Check this option to send employee templates.Load Messages 

These settings only apply to only apply to biometric clocks. The options are: 
Send Hand Templates: Select this option to send employee hand templates 
to the clock. This can be used to upload a template to a new clock, or to 
restore templates to a clock that has been cleared. 
Clear Templates: Check this option to clear the templates from the clock. 
USE THIS OPTION VERY CAREFULLY, as it will delete all existing templates 
in the clock and employees will not be able to punch until the templates are 
restored. 
Download New Hand Templates: Check this option to download new hand 
templates from the clock for input into the TA100 Pro database

Check this option to automatically put the punches into the online timecards 
of the employees. 

Load Bell 
Schedules 

Click the Poll button to start the polling process. 

Check this option to send pre-defined Bell Schedule assigned to the clock.  
Bell schedules are only checked at midnight, so a bell will not ring on the 
same day the bell schedule was downloaded. The Bell Module must be 
installed to use this option. 

Setting Defintion



Configure an Auto Process 
The Auto Process feature allows you to schedule the following tasks to run automatically at pre-
determined times: 

• Poll one or more time clocks
• Launch executable programs
• Generate reports

Terminal Polling & Auto Processing 

No user interaction is required when using the Auto Process feature. In fact, you can poll time 
clocks, run reports, download payroll data, and back up the TA100 Pro data without ever touching 
the computer. The Auto Process feature is ideal for processes that need to be performed after 
working hours or during less busy times of the day. 

Each automatic procedure can consist of one or more auto process cycles. Each cycle can run a 
program, poll the time clocks, or generate a report and is assigned a time and day(s of the week to 
run. To create an AutoProcess that runs several times a day, you will add several cycles: one for 
each time you wish the process to run. 

Run as Service  

The Auto Process can be configured to run as a service it must be installed locally as it will not run 
over a network.  The server must run the service. 

In Windows Explorer find the TA100 Pro folder.  Locate and double-click Install Auto Process.  A 
black command prompt window will flash.

In Windows Explorer find the TA100 Pro folder.  Locate and double-click Auto Process this will 
install the automated User responsible for the Auto Process.  A white Auto poll dialogue window 
will appear, but will give the message “nothing to poll.”
NOTE:  To confirm the success of this action open TA100 PRO click the File menu, Security, User 
Maintenance.  There will be a new user:  Auto Process Service.

Open TA100 PRO, click the Communications menu, Auto Process.  In the Configure Auto Processing 
dialog window select 1000 Auto Process Service, click Edit and configure your specific auto 
process features (see Add an Auto Process).
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Add an Auto Process 

Click the Communications menu, Auto Process. The Configure Auto Process dialog box will open. 

Click the Add button and the Auto Process Maintenance dialog box will open.

Terminal Polling & Auto Processing 
Locate your system Services window and Start the Synel Americas Auto Process or…
In Windows Explorer find the TA100 PRO folder.  
Locate and double-click Auto Process Service Setup this will allow you to start the automated 
service.
Click the Start button.  If you want the service to start when the operating system is starting, check 
the appropriate box.
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Terminal Polling & Auto Processing 

Enter the Number and Name for this Auto Process. 

Click the Add button. The Auto Process Schedule Details dialog box will open. 

Setting Defintion

Description 

Run a File 

Poll Clocks 

Enter a description for this AutoProcess Schedule. Examples: Poll California 
Clock, Run Payroll Reports, etc. 

Select this option to schedule an Event that will launch any sort of 
executable program. An example of this might be a Batch file that "zips" up 
your data files and copies them to a safe location on your network. With this 
option selected, you must enter the path to the desired file. 

Select this option to schedule an event that will poll the transactions from 
any or all of your time clocks. This Event can also perform any of the other 
normal time clock polling options.  
You must be sure to "tag" all the time clocks you want to poll by either 
double-clicking on them or selecting the "tag all" button. You must also select 
at least one polling option by clicking the "Poll Options" button. 
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Terminal Polling & Auto Processing 

Setting Defintion

Time

Reindex 

Day of the Week 

Enter the time at which you want the process to occur. 

Run Reports 

Items List 

Select this option to schedule an Event that will automatically run any of 
several reports such as "Missing Punches" or "Hours".  
You may notice that the list of available reports is greatly abridged and that 
none of the Payroll Exports are available. Time Card data should be 
thoroughly reviewed before running any Payroll Export. Each report to be run 
must be "tagged" by double-clicking it and choosing the desired settings in 
the Report Parameter Window. Once set, these parameters can be changed 
at any time by clicking the Report Options button. 

Select this option to schedule an event that will Reindex all the system 
databases.  
This Event must be scheduled at a time when it is most likely that all users 
will be logged out. If another user is logged into the system, this Event will 
be skipped. 

The items that display in this list depend upon the type of AutoProcess 
chosen. For example, if Poll Clocks is selected, this list will display all the 
clocks configured in the program. 
To select a single item, double-click the item to "tag" it. 
Click the Tag All button to select all items. 

Select the days of the week you want the process to occur. 

Tag All/Untag All Click the Tag All button to select all the items in the list. 
Click Untag All to deselect all the items in the list. 

Poll Clocks Auto Process 
If Poll Clocks is selected, select the clock(s you wish to poll with this process by double-clicking each 
clock to "tag" it.

If Poll  Clocks is selected, click the Polling Options button to configure the settings for polling. The 
Polling Options dialog box will open. 
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Backup Definition should be “Select this option to make a backup of the database 
and save it to a specified location.  
Note: It is recommended to make a backup at least once a week.



Check the options that are appropriate: 

Terminal Polling & Auto Processing 

Setting Defintion

Poll Transactions

Clear Clock 
Transactions 

Set Clock Date 
and Time 

Check this option to transfer punches from the clock to TA100 Pro. 

Check this option to clear the transactions from the clock after transferring 
them to TA100 Pro. 
TIP: This does not need to be done every time.  You may leave the 
transactions in the clock until payroll is processed successfully, however if 
you have a lot of employees you will want to clear more frequently so the 
clock memory does not fill up. 

Check this option to send the computer's current date and time to the clock. 
TIP: You may not want to do this every time, as the clock's internal clock 
tends to be much more accurate that the computer's. 

Program Clock Check this option to send programming and configuration information (such 
as the settings in the Configure Clock dialog box) to the clock. Clock function 
keys and function messages are sent to the clock during programming. 
This option should only be used when basic clock setup has been changed 
since the initial programming.  
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Click OK to commit the changes and return to the Auto Process Maintenance screen. 
Click OK to commit the changes and return to the Configure Auto Process Screen. 
Click Start to activate the Auto Process schedule. 

NOTE: You may minimize the TA100 Pro window when running auto process inside the software.  
When running as a service you may exit TA100 Pro.

NOTE:  For network installs, you will need to check that the network is not doing any backups or 
running any utilities during the auto processing schedule. 

Terminal Polling & Auto Processing 

Setting Defintion

Load Bell Schedules  

Load Messages 

Check this option to send pre-defined Bell Schedule assigned to the clock.  
Bell schedules are only checked at midnight, so a bell will not ring on the 
same day the bell schedule was downloaded. The Bell Module must be 
installed to use this option. 
NOTE:  This is not recommended with the TA520 or TA530, as the clock 
needs to roll past midnight for the bell schedule to take effect.  

Check this option to send employee messages to the clock. 

Readers These settings only apply to biometric clocks. The options are: 
Send Templates: Select this option to send employee templates to the clock. 
This can be used to upload a template to a new clock, or to restore 
templates to a clock that has been cleared. 
Clear Templates: Check this option to clear the templates from the clock. 
USE THIS OPTION VERY CAREFULLY, as it will delete all existing templates 
in the clock and employees will not be able to punch until the templates are 
restored. 
Retrieve Templates: Check this option to download new templates from the 
clock for input into the TA100 Pro database. 

265

Process Punches 
After Polling 

Check this option to automatically put the punches into the online timecards 
of the employees. 



Select the Auto Process you wish to change. 
Click the Edit button. 
Edit the settings as described in the Add an Auto Process section. 

Terminal Polling & Auto Processing 

Run a File Auto Process 
If Ru n   a     File is selected, you will be prompted to choose the file (program, etc.) to run.
When all settings are complete, click OK. The Auto Process will begin on the next occurrence of 
the date and time specified in the Auto Process Schedule Details. 

Click OK to commit the changes and return to the Configure Auto Process Screen. 
Click Start to activate the Auto Process schedule 

Edit an Auto Process 
Click the Communications menu, Auto Process. The Configure Auto Process dialog box will open.
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Click OK to confirm the selection. 
Click Close to exit the dialog box. 

Terminal Polling & Auto Processing 

Click OK to confirm the deletion. 
Click Close to exit the dialog box. 

Replicate an Auto Process 

Click the Communications menu, Auto Process. The Auto Process Maintenance dialog box will open.
Select the Auto Process you wish to replicate. 
You will be prompted:  You may select 1, 2, 5, 10, 15, 20, 30, 60, 120, 240, 480 or 720 minutes.

Delete an Auto Process 
Click the Communications menu, Auto Process. The Auto Process Maintenance dialog box will open. 
Select the Auto Process you wish to delete. 
Click the Delete button. You will be prompted: 
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This  section  describes  the  system  utilities  built   into  TA100 Pro.  It   includes  importing  and 
exporting, reindexing,   system    archiving,   system  backups   and  more. 

Importing 
It is possible to import data from other programs. Employee data, time transactions, and 
departments can be imported from previous versions of the software as well as from other third 
party systems, spreadsheets, and payroll programs. 

Advanced Import 

Employee data and attendance reports from third party accounting systems, spreadsheets, and 
payroll programs can be imported into TA100 Pro. The original files may be in any number of formats 
including ASCII comma delimited, Excel, or Lotus 1-2-3. When imported, the data is appended to the 
specified system database file. The file types TA100 Pro Import supports are: 

• Framework II (FW2)

• Microsoft Multiplan 4.01 (MOD)

• Paradox 3.5/4.0 (DB)

• Rapidfile (RPD)

• Lotus 123 versions 1 through 3 (WKS, WK1, WK3)

• Symphony version 1 through 1.2 (WRK, WR1)

• Microsoft Excel (XLS)

• Comma Delimited

• Tab Delimited

• Space Delimited

• System Data Format (SDF)

• Symbolic Link Format (SYLK)

• Data Interchange Format (DIF)

• FoxPro

Utilities 
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Click the File menu, Import, Advanced. The Configure Import dialog box will open.

Select the type of file to be imported. 

Click the Import File button to select the file that contains the information to be imported. The Open 
dialog box will open. 

Navigate to and select the file you wish to import. The file must be of one of the types listed at 
the beginning of the Import section.  

Click the Select button to commit the change. 

Click the Append To button to select the table onto which this data will be appended. The Open 
dialog box will open. 

Utilities 
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• Microsoft Multiplan 4.01 (MOD)

• Lotus 123 versions 1 through 2 (WKS, WK1)

• Symphony version 1 through 1.2 (WRK, WR1)

• Microsoft Excel (XLS)

• Comma Delimited

• Tab Delimited

• Space Delimited

• System Data Format (SDF)

• Symbolic Link Format (SYLK)

• Data Interchange Format (DIF)

• Database (FoxPlus)

Utilities 

Select the TA100 Pro database file to which you wish to append, and click the USE button to 
continue. 
Click OK to begin the import process. 

Exporting Data 
The Export function allows you to extract data from TA100 Pro for use in other programs. When exported, 
the database files can be used with many commercial spreadsheet programs and report writers to generate 
custom reports. The supported applications are: 
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Click the Export File button. The Open dialog box will appear. 

Select the file you wish to export and click the USE button to continue. 
Select the type of file you wish to export to. See above for a list of the available file types. 
Click the Save As button to define the file name of the exported data. The Save As dialog box will 
open. 

Utilities 
Click the File menu, Export. The Configure Export dialog box will open.

271



Utilities 

In the File Name box, enter  the name you wish to use for the exported data file. The extension will fill 
in automatically based on the type of file chosen in the previous dialog box. 

Click Save to continue. 
Click OK to begin the export. 
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System Utilities 
TA100 Pro provides utilities to keep your system running smoothly. Among other things, these utilities 
can repair databases, and perform backups (archive and restore archive have been removed).  

Because these utilities affect data, and ultimately your payroll, contact your local representative if 
you have questions or concerns about the operation of a specific utility. 

The following utilities are found under the Utilities menu under File and are described in this section: 

• Reindex Databases

• Repair Databases

• Update Databases

• Initialize Databases

• Change Employee Number

• Change Employee Number Width

• Set Reprocess Date

• Fix Unassigned Badges

• Repost R-Files

• Purge R-Files

• Post Historical Data

• Back Up System Files

• Restore System Files

Utilities 
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Repair Database 
The Repair Databases utility compares the contents of the database to the database’s index and 
attempts to rebuild the index to compensate for any inconsistencies. This utility cannot replace or 
recover data that has been lost or corrupted. 

It is recommended that you repair your TA100 Pro databases prior to Reindexing in order to ensure 
that the data is optimized. 

Click the File menu, Utilities, Update Databases. The Repair Selection dialog box will open.

Select the database you wish to repair by clicking Add to select an individual database or Add All to 
add all. It is recommended that you repair all files. 

Click OK to begin the repairing process. A progress bar will show the percentage of completion 

Reindex Database 

The Reindex Databases utility removes deleted records and sorts the data base in either numeric or 
alphabetic order depending on the contents. Since this utility has the greatest impact on the speed 
and reliability of TA100 Pro, it is recommended that you develop a weekly schedule for reindexing 
system database files. Also, it is a good idea to Repair the database prior to Reindexing. Repairing 
fixes inconsistencies and potential problems in the data. See Repair Databases. 

TIP: Reindex can be set as an AutoProcess. See Configure an AutoProcess.

Utilities 
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Select the database you wish to reindex by clicking Add to select an individual database or Add All 
to add all. It is recommended that you reindex all files. 

Click OK to begin the reindexing process. 

Update Databases 

The Update Databases utility is used when upgrading TA100 Pro to a newer version of the 
software. It makes all the required modifications to your current database so that it operates with 
any new file structures. 

Click the File menu, Utilities, Repair Databases. The Update and Compare prompt will appear.

Click OK to begin the updating process. 

Utilities 
Click the File menu, Utilities, Reindex Databases. The Reindex Selection dialog box will open.
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Utilities 
Initialize Databases 

The Initialize Databases utility completely removes the contents of database files. This utility is 
useful when databases become corrupted beyond recovery 

NOTE: This utility completely deletes ALL data in the selected databases. Only the SYSOP is able to 
initialize data. 

Click the File menu, Utilities, Initialize Databases. The Initialize Selection dialog box will open.

Select the database you wish to Initialize by clicking Add to select an individual database or Add All 
to add all. 

Click OK to begin the process. ALL DATA IN THE SELECTED TABLES WILL BE DESTROYED. 

Change Employee Number 
Once an employee has been added to the system, you can no longer change his or her employee 
number through the Configure Employees Detail screen. This utility allows you to change employee 
numbers, one employee at a time. 

Click the File menu, Utilities, Change Employee Number. The Change Employee Number dialog box 
will open.
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Utilities 

Select the employee whose number you wish to change using the drop-down list in the Old field. 
Enter the new employee number in the New field. 
Click OK to change the employee's number. 

Change Employee Number Width 
The number of digits (width) in the Employee Number is initially defined in the Configure Main 
Company dialog box. However, once employees have been added you can no longer change the 
setting through the Main Company screen. This avoids accidental data loss.  

This utility allows you to change the number of digits for Employee Numbers safely. Typically, the 
width should only be changed to a higher (longer) number in order to avoid losing data. When digit 
length is increased, the digits are added on to the left of the current number. When digits are 
taken away, they are taken from the right. 

Click the File menu, Utilities, Change Employee Number Width. The Change Employee Number 
Width dialog box will open.

Enter the number of digits for the new employee number. 
Click OK to commit the change. 
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Set Reprocess Date 
The Set Reprocess Date utility allows you to globally reset the reprocess date for employees. 

Processing occurs when TA100 Pro takes the punches from a clock and applies them to the correct 
employee, taking into account pre-setup information such as Company Policy, Shift rules, etc. 
Reprocessing is what happens when a user has made changes to the polled punches, and/or 
configuration information, and now needs to have TA100 Pro recalculate the data. If TA100 Pro had 
to recalculate data every time a user opened an employee timecard, the usefulness of the program 
would be offset by the amount of time needed for the calculations. Time is saved by allowing a user 
to make all necessary changes before reprocessing the data, which is the driving reason behind 
having automated timekeeping software.  

This utility does not actually reprocess the punches. It allows a user to decide how far back, and for 
whom, the system will process punches. After changing this setting, you will need to manually 
reprocess, at which time the system will reprocess back to the date entered here for the employees 
selected. 

Click the File menu, Utilities, Set Reprocess Date. The Reprocess Punches dialog box will open.

Utilities 

Enter the Reprocess date. 

Select the employees for whom you wish to reprocess by using the Add button to select an 
individual employee or Add All to select all. 

Click OK to complete the change. 

Reprocess punches. This can be accomplished by clicking the Reprocess  button in the Online 
Timecard. See Online Timecard.  Or by running a report with the Reprocess button selected. 
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Fix Unassigned Badges 
Employees are able to start punching at the clocks before their data is entered into TA100 Pro. The 
badge used by the employee is considered to be unassigned if the employee's punches are polled 
prior to the employee being added to the software. You can repost the employee's punches after 
adding the employee to the software using this utility. 

Click the File menu, Utilities, Fix Unassigned Badges. The Unassigned Badge Maintenance dialog 
box will open.

This screen will show the employees whose badges were unassigned at the time of polling. 

Select the employee you wish to repost. Make sure that this employee is added to the program at 
this time and has the correct badge number.  You may also click Print to view a list of all 
unassigned badges. 

Click the Repost button. TA100 Pro will match the badge in the transaction to a badge assigned to 
the employee. 

The Special Repost option will compare the listed badges to current employee numbers (rather 
than comparing to a badge number). It assigns any transaction to the employee whose employee 
number matches the unassigned badge number. This option should only be chosen after a regular 
reposting. 

Click Close to exit the dialog box. 

Utilities 
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Select the file you wish to repost by double-clicking it to "tag" it. Or select all files by clicking the 
Tag All button. 

Click OK to repost the files. 

Purge R-Files 

R-Files are the files that store punch data downloaded from the clocks. There is one R-File for each
day, which contains all the punches from that day. This data is imported into TA100 Pro, but the
original file is kept so that it can be referenced or re-imported if necessary. These files are kept
indefinitely, taking up space on your hard drive. You may wish to purge (delete) these files
periodically in order to free up disk space.

This should not be done before a particular R-File has been successfully imported to TA100 Pro, as 
doing so will result in a loss of the punches contained in the R-File. 

Utilities 

Repost from R-Files 
R-Files are the files that store punch data downloaded from the clocks. There is one R-File for each
day, which contains all the punches from that day. This data is imported into TA100 Pro, but the
original file is kept so that it can be referenced or re-imported if necessary. Reposting an R-File
allows you to re-import the punch data stored in one of these files.
Click the File menu, Utilities, Repost from R-Files. The Repost R-Files dialog box will open.
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Click the File menu, Utilities, Purge R-Files. The Purge R-Files dialog box will open.

Utilities 
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Select the file you wish to purge to purge  by double-clicking "tag" it.  Or select all files Or select all 
files  by clicking the Tag All  button.  
Click OK to purge the files.  

Post Historical Data

Posting Historical Data allows you to move historical information to another location, where it can still 
be accessed for reports, but where it is not slowing down the performance of the program.   

TA100 Pro keeps track of a large amount of information. As the number of employees goes up, the 
amount of data that pertains to those employees goes up. After awhile, the amount of data that needs 
to be processed will noticeably slow down the computer. TA100 Pro allows a user to decide when 
past transactions will no longer be needed for editing, and ‘saves’ the processed punches to another 
file. The transactions in this new file cannot be edited in any way.  

Posted transactions will appear in reports, but will not appear in online timecards or transactions 
screens. If the transactions do need to be edited, they will need to be unposted. 



Click the File menu, Utilities, Post Historical Data. The Post Historical Data dialog box will open.

Utilities 

Enter the date up to which you wish to post data. As posted data can no longer be edited on screen, 
make sure that the date entered is far enough in the past to suit your needs. 
If you wish to Unpost previously posted data (in order to edit it, for example), check the Unpost data 
box. 
Click OK to complete the action 

System Backup 
System Backup takes a copy of the database files as of the date of the backup. These backup files 
can be restored if necessary. If for some reason the computer/network crashes, the data can be 
loaded into a new or existing installation of TA100 Pro with no downtime. Backing up TA100 Pro 
should be done on a regular basis. 

Click the File menu, Utilities, System Backup. The System Backup Maintenance dialog box will open.
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Select File 

Setting Defintion

Click this button to choose the backup from which to restore.

Fill in the settings as appropriate: 

Click OK to begin the restoration process.

Fill in the settings as appropriate: 

Click OK to begin the backup. 

System Restore 

System Restore restores your TA100 Pro database files from backup. When Restoring a Backup, all 
changes made after the backup was performed will be lost. If a clock has been polled after the 
backup was performed, the transactions from that polling will have to be reposted. 

Click the File menu, Utilities, System Restore. The System Restore Maintenance dialog box will open.

Backup File Name 

Setting Defintion

Enter the name you wish to use to refer to this backup file. A good practice is 
use the date of the backup as the file name. 

Destination Enter the destination drive letter and directory for the backup file. 
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Calculator 

Click the Help menu, Calculator. The Calculator will open.

Utilities 
Additional Utilities 
TA100 Pro provides some "nice-to-have" utilities in addition to the System Utilities, including: 
• Calculator

• Calendar

• Conversion Table

• System Info

• Macros

These utilities are found under the Help menu. 

You may enter numbers and functions by typing or by clicking the appropriate buttons on the keypad. 
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Utilities 

About 
The About screen displays the serial number information and all extra modules the client has 
purchased.  This is also where you can activate the Hand Reader. 

NOTE:  This only applies to Hand Readers that do not match the Synel Americas internal code 
and were not purchased directly from Synel Americas. 

285

Click the Help menu, About. The About will open.
Click on Hand Reader Activation button as shown below.

System Configuration 

The System Configuration screen displays the technical setup of your computer. 

Click the Help menu, System Configuration. The System Configuration window will open.
Press Esc to exit the dialog box. 



Utilities 

Conversion Table 
The Conversion Table displays conversions from 12 Hour to 24 Hours and minutes to hundredths of 
an hour. 

Click the Help menu, Conversion Table. The Conversion Table will open.

Macros 
Macros allow you to record keyboard steps in TA100 Pro and play them back by pressing a key. For 
example, you could record a macro to Poll time clocks. 

Click the Help menu, Macros. The Record Macro dialog box will open.
Press the key or key combination that will run this macro. 
Enter a name for the macro (no spaces.) 

Click OK to begin recording. 
Perform the steps you wish to record. Type the keystrokes you normally press to perform an operation 
on the keyboard. Remember, only keyboard operations can be recorded. 

Press Shift + F10 to stop recording. The Stop Recording Macro dialog box will open. 
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Click one of the following: 

Utilities 

Continue 

OK 

Setting Defintion

Insert Pause

Key to Resume

Seconds 

Discard 

Click OK to stop recording the macro. 

Click continue to continue recording the macro after a pause. 

Insert Literal Click Insert LClick Insert Literal to record the literal meaning of the next keystroke. For 
example, if CTRL+P is used to execute a macro, but you want to record 
CTRL+P as a keystroke, click Insert Literal before typing the keystroke. This 
prevents a macro from being recorded. 

Click this button to insert a pause into the macro, then select the Key to 
Resume or Seconds option below.  

Select this option to pause the macro until SHIFT+F10 is pressed to continue. 

Click Seconds to pause the macro for a period of time (in seconds). Enter the 
number of seconds in the adjacent field. 

Click Discard to cancel recording and discard the macro. 
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